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How to Register

Gravity was formerly sold as a commercial product, but the current version is completely free.    There 
is no need to register the product with MicroPlanet.    For more information on Free Gravity, see the 
Free Gravity FAQ.





Welcome To Gravity

Welcome to Gravity, a powerful 32-bit multi-threaded USENET newsreader designed expressly for the 
Windows 95, Windows 98, and Windows NT environments. Make sure you check out the following 
features:

· The Gravity Tutorial—be sure to take it

· Automatic background image decoding with the Image Factory, and a full featured image viewer – 
the Image Gallery

· Tremendous display flexibility—Gravity provides numerous ways to view your articles

· A powerful rule system for organizing, ranking, and focusing on the news important to you

· A scoring system for assigning relevance values to articles.

· Simple rules to get you started, including Bozo Bin, Ignore the Spam and Important Words

· A full-featured spell checker that works with multiple languages

· Zoom mode for maximizing your screen real estate

· URL Hotlinks that let you jump to web pages, retrieve files, use gopher, and so on

· Read and compose articles on-line, off-line, or a combination of the two

· Quick display filtering—you also can define your own display filters

· Cross-post management—you won’t read the same articles over and over

· Extensive use of Windows 95 pop-up menus and common controls

· Support for MIME encoding and decoding

· Powerful background search capabilities, including regular expression searches

· Support for multiple signatures

· Password protection

· Quick type searching for newsgroups of interest

· Support for newsgroup nicknames

· Easy forwarding of articles to your friends and colleagues

· Floating and dockable toolbars

· Support for the Secure Password Authentication protocol (used by The Microsoft Network)

· And much, much more

Click  to choose another Getting Started topic.



Just What Does A Newsreader Do, Exactly?

A newsreader allows you to interact with millions of other people who use the worldwide bulletin board 
system called USENET. USENET is comprised of thousands of discussion groups called newsgroups. 
Each newsgroup consists of articles that are “posted” (composed and submitted) to the USENET 
system. Thus, the newsreader’s primary purpose is to let you follow discussions in the newsgroups 
and participate in them by submitting your own articles.

Two software programs make this happen. A news server runs on an Internet host computer. The 
newsreader (end-user) program communicates with the news server.

News servers are distributed throughout the world, and they talk to each other with a protocol called 
NNTP (Network News Transport Protocol). This protocol mainly consists of discussions like “I have 
new article such and such” and “here it comes.” These interactions between servers generally take 
place at scheduled intervals and are called newsfeeds. When users submit an article to their local 
server, that article is in turn propagated to other servers the local server knows about. After a time (and 
this is highly variable), the article generally is available to the world populace.

The newsreader or client program lets you interact with a news server to read discussion groups, post 
new articles, and so forth. A rudimentary newsreader allows you to read threaded newsgroups (a 
thread is one or more articles that comprise a “conversation” within a newsgroup), post new articles, 
submit replies to articles that you read (called follow-up articles), reply directly to the author via e-mail, 
and keep track of what you’ve read in the newsgroups.



Getting the Most Out of Gravity

Here are the features that make Gravity really cool:

· This help file contains a 12-lesson tutorial. To get the most out of Gravity, work through the 
lessons. See the Gravity Tutorial.

· Gravity lets you store article information in a way that’s best for you. See Overview of Storage 
Options for an explanation of the different storage modes within Gravity.

· Experiment with different window layouts to find one you like. You can control which panes 
correspond to which windows by dragging and dropping the panes in the Window Layout tab of the 
Options dialog (or by using the up and down arrows). See Controlling Window Layout    for 
instructions. After you find your favorite layout, you can still size the panes by dragging their edges 
with the mouse.

· When you are reading articles, use the space bar to move through the articles. See Navigating 
With the Spacebar for instructions.

· Use the type-searching feature when subscribing to groups. Then you can find subjects you are 
interested in, like gardening. See Subscribing to a Newsgroup for instructions.

· Adjust the background colors and fonts to your liking; everybody has their own style when it comes 
to these. See Setting Fonts and Backgrounds - Thread, and Newsgroup Panes.

· Configure how you want your articles to be presented to you. You can control which article fields 
are shown, their font, color, background and order. See Overview of Article Layout and Formatting.

· Check out the pop-up menus Gravity uses everywhere. Pop-up menus appear when you click your 
right mouse button on an object such as a newsgroup. This is a Windows 95 convention that 
makes it easier for you to accomplish your tasks.

· Try out the URL hotlinks, which allow you to click on highlighted Uniform Resource Locators to 
quickly visit World Wide Web sites, download files via File Transfer Protocol, and so on. See 
Overview of Working With URLs.

· Using the built-in scoring system to prioritize the articles you want to read.    See Overview of 
Scoring for details on the scoring system.

· Build a couple of quick rules to help you manage the content of a group you find interesting. Check 
out the quick, pre-formed rules for performing common actions. See Overview of Rules.

· Use the Image Factory Gallery to decode some articles in the background. Use the Image Gallery 
to view the images and quickly clean up your hard disk. See Overview of the Image Factory for 
details on managing the decoding process.    See Overview of the Image Gallery .

· Give your newsgroups friendly nicknames like “The Dead” instead of rec.music.gdead, and 
“Win32 Programming” instead of comp.os.ms-windows.programmer.win32. See Setting 
Newsgroup Properties.



Observing Net Etiquette

USENET news is sort of like a world democracy. In order for it to work, everyone needs to show some 
consideration and restraint for other users and the system in general. The repeated calls for censorship 
on the Internet are due in part to the constant violation of these common courtesies. 

The following recommendations for appropriate USENET behavior, developed over the years by many 
participants, help ensure you are a good USENET citizen.

Be Clear

· Use descriptive "Subject:" lines. 

· Write as you would in a letter: use upper- and lowercase characters (using all uppercase is 
interpreted as “yelling”), complete sentences, and a ragged right margin (don't right-justify). Leave 
white space between paragraphs.

· Pay attention to spelling, sentence structure and word choice (your posting may be widely 
quoted!).

· If you're following up, summarize your understanding of the previous posting, or quote enough of 
the original to be understandable. If you're quoting outside sources, give references. 

· Define acronyms and obscure terms. 

· Be aware of irony, humor and satire. Don't jump to conclusions about other people’s posts, but try 
to mark yours appropriately: the ":-) " (smiley) or its modern variation “<g>” is one tool for this. 

· Remember that subtlety is difficult to communicate, and you may be misinterpreted.

Be Concise

· Reply to other posters via e-mail, unless you know you have something to contribute that others 
will appreciate. Read other people’s follow-up articles before you mail or post a response. 

· Try to keep articles short and focused. Don't quote large portions of referenced material. If you're 
summarizing a discussion, make a summary. 

· Think about your audience—post only to the appropriate groups. If you must use more than one, 
cross-post (specify all groups on the same "Newsgroups:" line—separated by commas, no 
spaces). 

· If your article is not of worldwide interest, edit the "Distribution:" line.

Be Kind

· Be diplomatic. A great many colleagues and/or future employers read the net; post (and mail) only 
what you're willing to admit to years from now. 

· Ask for clarification, or suggest corrections gently—via e-mail. Remember that people make 
mistakes, and so do you. 

· If you're truly angry, take a break before responding and get some perspective.

Be Sensible

· Get to know a group before posting. Read the group's Frequently Asked Questions (FAQ) list (if 
any), as well as a few days worth of articles. 

· Do some research before you ask for help. Then describe what you've already done to solve your 
problem. Don't ask for help in a group you aren't willing to read (at least temporarily). 



· Don't attempt to share late-breaking news announcements—USENET isn't that fast. 

· Double-check all header lines on your postings. 

· If you can't reach someone by e-mail, contact your network administrator for help. You can also 
contact your correspondent by phone. Don't post because your e-mail bounced. 

· Be aware of security issues: e-mail is not private, postings can be forged and programs found on a 
network can be dangerous.

Be Aware of Others

· Realize that for many of the millions of USENET readers—in dozens of countries—English is not a 
native language. 

· Avoid special characters like tabs and control characters. On someone else's screen they may look 
completely different. 

· Don't use article numbers to refer to postings. They differ at each site (the "previous" article varies 
from site to site as well).

· Refer to the article’s Message-ID, which is unique. 

Be a Good net.citizen

· Don't post copyrighted material.

· Post test postings in test groups.

· Keep your signature to four lines or less.

· If you make a serious mistake in posting, cancel your article right away.

· Remember that many groups have special rules—about marking spoilers, rotating questionable 
material, and so on. Read the "netiquette" information in news.announce.newusers.



Connecting and Disconnecting From The News Server

Gravity allows you to connect to the news server whenever you want.    You must be connected to 
retrieve article headers and bodies, and to post new items.    You can connect to the server any of the 
following ways:

· From the Server menu, choose the Connect command.    If you are already connected, this item is 
checked.

· Click the Connect button on the main toolbar.    When you are connected the connect button will 
appear depressed on the toolbar.

· You can have Gravity connect automatically at startup.    See the Connect at Startup option on the 
Connect tab of the Server/Properties dialog for more information.

See Also:

The Gravity Tutorial has more information about getting connected.    See Lesson One - Getting 
Connected.



Configuring Gravity for On-line or Off-line Operation

In its default configuration, Gravity only stores article headers as they are retrieved.    You can also 
instruct Gravity to store bodies automatically for each group you subscribe to.    It is also possible to 
store bodies on a group-by-group basis.

Retrieve and Store Article Bodies

When you use this option, Gravity always retrieves the bodies for all headers in a group. This lets you 
read the group off-line without tagging and retrieving individual articles. The drawback to this mode is 
that it requires a lot of disk space if there are numerous articles or if they are large (such as binary 
images).

Store All Bodies Retrieved for Reading

Use this setting to control whether Gravity stores an article in the database if you have retrieved it for 
reading. When this option is enabled, reading an article also stores it in the database. You can later re-
read the article without re-connecting to your news server. Keep in mind that this may significantly 
increase the amount of disk space used and that you may need to adjust the purge settings.

See Also:

Lesson Seven - Techniques for Off-line Reading 



Article Status Indicators

Article Status

 The article is unread and the article body is not in the database. 
 The article has been read and the article body is not in the database.
 The article is unread and the article body is in the database.    You can read this article off-line.
 The article has been read and the article body is in the database.
 The news server has expired this article. It is no longer available.

Decoding Status

 The article will be decoded.
 The article has been decoded successfully.
 Decoding failed.

Other

A rule has marked this as an important article.
This article has been tagged.    See Tagging and Retrieving articles.
The article is part of a thread that is being watched.
The article is part of a thread that is being ignored.
The article is protected and cannot be purged or deleted.



Purging Articles from the Database

From the View menu, choose Options, and then choose the Purging tab to set the purging options. To 
override these settings in any particular newsgroup, choose Properties from the Newsgroup menu, and 
then choose the Purging tab.

Articles that have Expired from the News Server

When you retrieve headers for a newsgroup, Gravity purges articles in the database that have expired 
from the news server. If you have already downloaded the body for an article, and you don’t care if the 
news server has expired it, Gravity leaves those articles alone.

NOTE: You can turn off the automatic verification of expired headers to increase header retrieval speed by 
selecting Server/Properties/Operation and disabling “Verify local headers when retrieving new headers.”    You can 
also force expiration to happen by selecting the Newsgroup/Verify Local Headers command.

Purging Articles by their Date

You can configure the properties of a newsgroup to purge Read and Unread messages. By default, 
Gravity purges Read messages older than 7 days. Unread messages are purged after 14 days. 

NOTE:    The elapsed time is calculated from the date in the article itself; not from the time you read an article.

When Does Purging Happen?

Gravity purges the database when you retrieve headers for a newsgroup or when you exit Gravity. You 
can configure both of these by entering a number of days, for instance “Purge when retrieving headers 
every 2 days”.

How Do I Make My Database Smaller?

Purging articles removes them from the database and allows Gravity to reuse the file space. To 
actually make the database smaller, you must compact it. Use the “Compact when exiting news every 
7 days” option, or select Purge and Compact Database from the File menu. This purges and compacts 
every newsgroup.



New In This Release            

New in version 2.5

The only difference between Version 2.5 and Version 2.3 of Gravity is that 2.5 is completely free.    As 
such it lacks the registration input and checking code, documentation about how to register Gravity, 
and changes to the help file and the license.    For more information on Free Gravity, please read the 
Free Gravity FAQ.

New in version 2.3

The initial motivation for version 2.3 is because of widespread crashes caused by the memory 
management routines in the Microsoft Visual C++ runtime library.    Along with fixing that problem, the 
following functionality changes have been included:

· Resume support added for multi-part decoding.    Gravity now caches pieces of a multi-part 
decode in a local cache (<grav_dir>\parts) and can resume with the next part when a transfer 
is interrupted (e.g. start on part 17 rather than at the beginning).

· Decode jobs are automatically re-tried.    Decode jobs that fail for any reason other than 
missing parts are automatically added back to the front of the decode queue and re-tried once 
connection has been established.  Clicking Stop or Disconnect will not cause a decode job 
to be removed from the queue.  To remove queued decode jobs, you must go to the Image 
Factory (ctrl-i) to remove them.

· Thread pane no longer limited to 32K headers under Win9X .    Formerly the thread pane 
was based on the listbox control in windows.  In version 2.3 the thread pane is based on the 
listview (SysListView32) common control and can display more than 32K items under Windows 
95 and 98.  The Windows NT listbox never had this limitation.

· Thread pane now has a horizontal scrollbar.    The thread pane now will display a horizontal 
scroll bar if the defined columns are wider than the display.

· New keyboard shortcut.    A new keyboard shortcut (CTRL+SHIFT+A) has been added that 
will toggle between the All Articles view filter and the default filter for the current newsgroup.  
For example, if you are using the Unread Articles view filter and use CTRL+SHIFT+A, then the 
filter will switch to All Articles.  If you hit the keystroke combination again, it will revert back to 
Unread Articles (assuming that is the default).

· Gravity no longer converts decoded file names to lower case.    Formerly Gravity would 
convert all decoded file names to lower case.  The final release of 2.3 no longer does so.

· Gravity would hang following up to articles under Windows 2000.      Due to changes 
made to the RichEdit common control under Windows 2000, Gravity would sometimes hang 
when opening a reply or follow-up window.  Version 2.3 should no longer hang.

· Article coloring under Windows 2000.    Due to changes in the RichEdit common control 
under Windows 2000, Gravity would sometimes incorrectly color sections of articles.  Version 
2.3 should correct the problem.

· Decoding part identification change.    Gravity uses a pattern to detect the part numbers in 
the subject for multi-part binary files.  Formerly when a subject contained "file 1 of 2  
mypic1.jpg" Gravity would identify the post as a multi-part post and would not decode the item 
because of the assumed missing part.  In version 2.3, Gravity no longer looks for "X of X" as 
part numbers, so subjects like the one above should decode fine.

· Gravity now correctly removes rule information for purged headers.    In version 2.1 and 
2.2 Gravity would not clean up some rule related information from the newsgroup database 



files, even if that information pertained to headers that had already been purged.  Version 2.3 
correctly removes the outdated information. 

· Wrap behavior of "Save To Draft".    The wrapping behavior of "Save To Draft" in version 2.3 
has reverted to the way it worked prior to version 2.2.

· Group command tracing (pertains to renumbered group messages).    A number of users 
have reported that they get re-numbered newsgroup messages, seemingly when the 
newsgroup has not been re-numbered.  In order to try to track this down, we have added a 
new option under File/Trace Files that will cause Gravity to log all GROUP commands issued 
to the current server.  If you have been receiving these messages, you should enable the 
GROUP command tracing and after you receive another re-numbering message send 
MicroPlanet the log.  Since adding the GROUP logging we have encountered re-numbered 
groups, and they were in fact re-numbered by the server, but we want to get as much feedback 
as possible before proceeding with a course of action.

· Search window changes.    The Gravity search window now shows a progress bar as it is 
processing each group rather than the "whizzing subjects" it formerly displayed.

· Optional "mode reader".    Some news servers that have recently come to our attention close 
the connection when a newsreader issues the standard "mode reader" command.  You can 
disable the "mode reader" command under Server/Properties/Connect.

· Re-numbered newsgroups.    We have made some changes to the handling of the GROUP 
command in the hope that we can eliminate the re-numbered group messages that some 
people experience.  If you are one of the people who has been affected, please let us know if 
this helps.  Additionally, the GROUP logging function (File/Trace File/Log Output...) has been 
changed to include the IP address of the server.

· "Move selection down" and "Move selection down (into thread)".      The new "Move 
selection down (into thread)" maps to the old behavior and a new behavior has been added to 
move selection down without diving into the thread.

· Newsgroup pane tooltips.    The tooltips in the newsgroup pane now pop up quicker (1/2 
second) when you hover the mouse over a newsgroup name.

New in version 2.2

VCR

The VCR allows you to select groups from any of your defined news servers and cycle through and 
retrieve the headers, bodies, process rules, and so forth.    You can start the process right away, or you 
can schedule it to occur at a later time (such as at midnight).    Gravity can optionally exit when all of 
the jobs have completed.

The VCR remembers its settings from previous runs, but you can also save VCR settings to a file and 
re-use them later.    Gravity has a new command line switch (/vcrfile: ) that allows you to start Gravity 
with the VCR running.

Navigation

A whole new navigation menu was added and some article navigation commands were migrated from 
the Article menu.    The new navigation commands are:

· Skip to next unread article

· Skip to next unread in thread

· Skip to next unread local



· Back (move to previously viewed article)

· Forward (move to article that was viewed after this one)

There is a new Navigation tab in Global Options that allows you to control how certain navigation 
commands work when you are offline or online.

News Server Nicknames

Each server now has both a server nickname and a server address.    If no server address is specified, 
Gravity attempts to connect to the server nickname.    Server nicknames allow you to define the same 
news server multiple times by giving it multiple nicknames.    The server nickname maps directly to a 
Windows file system directory, so each server must have a distinct nickname.

Retrieval

· New settings to allow Gravity to re-establish dropped connections and retry failed connection 
attempts have been added under Server/Properties/Connect.

· The Retrieve tagged for selected groups command allows you to retrieve tagged articles for the 
groups selected within the newsgroup pane.

· A new server property (Server/Properties/Operation/Server creates messages out of order) 
can be used with news servers that are part of server farms.    Enabling the option causes Gravity 
to keep requesting articles that appear to be missing.

· A new server property (Server/Properties/Operation/Limit headers) can be used to specify that 
Gravity should not retrieve more than a specified number of headers from any group during header 
retrieval.    This limit can be overridden on a per-newsgroup basis.

· The Retrieve Limited Number of Headers… command has been added to the newsgroup menu. 
This command allows you to specify a number of headers to retrieve or to specify that all should be 
retrieved.

· A new newsgroup retrieval property has been added to the General tab to allow you to disable 
automatic retrieval of the group when headers are retrieved for the entire server.

· Decode jobs now display the subject and part number on the status bar (rather than the 
newsgroup and raw article number).

Toolbar Buttons

The following new toolbar buttons have been added:

· Retrieve Tagged Articles

· Skip to the next unread article

· Skip to next unread in thread

· Skip to next unread local

· Back to the previously viewed article

· Forward to the article that was viewed after the current one

Threading

You can now choose between threading headers based on only the message-id or both the message-
id and subject.    This setting is contained on the Global Options/Display tab.



Storage

· The option to NOT store headers for newsgroups has been removed.    The reasons for removing it 
include: 1) the underlying code for dealing with the absence of headers was very complex, 2) in 2.1 
a number of major problems surfaced after the final release even though there were thousands of 
downloads in the public beta, which convinced us that very few people used that mode, and 3) 
while there was a minor benefit in terms of reduced hard disk consumption, many commands 
would result in re-downloading the information, which is confusing and wasteful.    Hence we 
decided to eliminate it to simplify the code and put effort into other areas.

· Major changes were made to the way Gravity stores and accesses data.    These changes were 
made to reduce the likelihood of corruption and to make recovering from corrupted files easier.    
The Global Settings file has been broken into a set of individual files (ArtIDs.dat, Bozo.dat, 
Filters.dat, Ignore.dat, Options.dat, Rules.dat, Score Colors.dat, Scores.dat, Watch.dat).    
Additionally, the Server Settings file has been split into a number of files (Crosspost.dat, 
Decode.dat, Outbox.dat, Print.dat, ServerIDs.dat, Tags.dat).    All of the global and server level .dat 
files employ a backup strategy.    When a file is written, it is first renamed to a .bak extension and 
then the new file is written.    After the new file is successfully written, the backup (.bak) file is 
removed.    If Gravity attempts to open a file and finds a file with a .bak extension present, then it 
knows that a previous save attempt failed and automatically reverts to the backed up version.    
Finally, in addition to the individual server files identified above, all information about subscribed 
groups is contained in individual group files, which have a “. g” extension.    Previously Gravity 
stored some vital group information in the Server Settings file, and if the stream within that file that 
contained the subscribed group list got corrupted then the entire server was lost.    In 2.2, the most 
that will be lost if a group becomes corrupted is the single group.

Rules

Rules now have optional expiration that allows a rule to be disabled if it does not fire within a 
prescribed number of days.

Scoring

Score entries now have optional expiration so that unused entries can be removed if they are not 
encountered.    This automatic maintenance helps to reduce the overhead of score processing.

Bozo Bin

· In previous versions of Gravity, the Bozo Bin was implemented as a rule with large regular 
expressions.    As the Bozo Bin grew, the performance diminished and the likelihood of the huge 
regular expression getting corrupted increased.    In 2.2, the Bozo Bin is simply a list rather than a 
rule. 

· The bozo bin also supports expiration.    If a bozo is not encountered within the specified number of 
days it is removed from the list.

· There is a new command (Tools/Apply bozo bin to the current group) that allows the bozo bin 
to be manually applied to the currently open newsgroup.

Outbox

The Outbox now has automatic expiration settings that you can enable to automatically clean up the 
Outbox.

Image Gallery

There are two new options for the Image Gallery:

· Shrink image to fit window



· Enlarge image to fit window

Misc

· A new keyboard shortcut (Ctrl+Shift+L) has been added for marking items as unprotected.

· You can now create trace files from within Gravity using the new Trace File command on the file 
menu.    After enabling tracing, you must disconnect from the server and re-connect for the tracing 
to take affect.

· The Gravity status bar now shows the part number and subject for decode jobs.

· The Search/DejaNews command now points to the main DejaNews web page (www.deja.com).

· Three server properties were moved to the new Group tab.    These properties are 1) Get list of 
new groups upon connecting, 2) Display new groups after retrieval, and 3) Update server 
count.

· Gravity can be instructed to let a news server create the message-id for posted articles by 
disabling Server/Properties/Posting/When posting, Gravity should generate the message-id 
for the server.

· When defining a display filter, you can specify that the filter will include the entire thread if any 
article matches the filter.    Use this option, for example, if you want to show the entire thread for 
threads that contain any unread articles.

· A new option has been added to Global Options/Display to allow threading by message-id and 
subject or purely by message-id (pure threading).

· A new option has been added to Global Options/Preferences that controls what happens when you 
try to open large articles.    A new keyboard shortcut (Ctrl+Enter) has been added to force the 
display of the selected article regardless of the large article setting.

· Under Global Options/Preferences an option was added to cause Gravity to put focus in the article 
pane when an article is opened.

· Keyboard shortcuts (+ and -) have been added for expanding and collapsing individual threads.

· Keyboard shortcuts (1, 2, 3) were added for switching between the newsgroup, thread, and article 
panes.

· A warning has been added for deleting an article.

· URL highlighting and launching has been improved.

· When switching between servers, the warning dialog indicating that the search window must be 
closed now has a button that will close the Search window for the user.

· If a decode job fails because of a lost connection then it is added back to the waiting job queue.

· You can now retry decode jobs from within the Image Factory with the new Retry button.

· Collapsed threads that contain new articles are now indicated visually with a "Swiss Army Knife-
like" symbol.

· In the Image Factory, Alt-P can now be used to move items to the top.

· Under Global Options/Decoding the low disk space warning can be turned off.

· The formatting of items saved as a draft has been improved.

· The Pin and Link buttons on the Filter bar should have transparent backgrounds under most 
environments now.



· The icon for the Image Factory was changed to resemble a factory (formerly it was identical to the 
Image Gallery icon).

New in version 2.11

Changes In Gravity 2.11

Version 2.11 is being released to provide fixes for a few of the most common issues with Gravity 2.1. 
This release is not meant to be a major release or include new functionality and is free to all registered 
users of 2.X. The next Gravity release (2.2), which is being developed now, will include new functionality.

· Gravity 2.11 no longer requires the installation of mfc42.dll, msvcrt.dll, msvcp50.dll, and _grvlib.dll. 
This has a number of benefits related to compatibility and support. In particular, 2.11 is not 
dependent upon whatever dlls other products install in the Windows system directory.

· Some users were experiencing crashes in kernel32.dll due to improperly encoded graphics files. 
2.11 handles these files without problems.

· The Image Factory position was not being properly restored if Gravity was closed when the factory 
was in a minimized state. Version 2.11 properly saves the state of the Image Factory upon 
shutdown.

· In version 2.1, if you included the References header in the article pane layout, it would not display. 
Version 2.11 correctly displays the References header.

· The DejaNews button on the toolbar now points to the main site URL for DejaNews 
(www.dejanews.com). Earlier versions pointed to a page that no longer exists.

New in version 2.1:

Scoring

· A new scoring system has been added for assigning relevance values to article headers.    
Essentially, you indicate keywords that add or lower the score for each article header.    These 
scores can in turn be manipulated by rules.    When you add a score entry, you have the options to 
specify whether the phrase is a wildcard, regular expression or a plain text phrase.    You can 
indicate whether the phrase can appear in the From header, Subject header, or both.    Finally, you 
can indicate whether the phrase has to appear as a whole word, or whether it can appear as a part 
of a word.

· Add a score for the current group by hitting the ‘S’ key.

· In addition to specifying scores for individual groups, you can specify scores for wildcard 
expressions such as “alt.binaries.*”

· A new column has been added to the thread pane – Score.    You can sort by score.

· Threads can be sorted by their score.    In other words, you can sort the most important threads to 
the top and the least important to the bottom of the list.    The thread score value is based on the 
article with the highest score within the thread.

· A new command has been added to allow immediate re-scoring of the current group.

· Score ranges can have associated background colors.    Generally, you will want to use “Define 
Custom Colors” in the color selection dialog to achieve good results.

Rules



· There is a new rule condition that allows the rule to examine the score.

· There is a new rule action to adjust the score of an article.

· You can specify that a rule applies to newsgroups that match a wildcard expression (alt.binaries.* 
for example)

· You can control the order that rules are evaluated by moving them up and down within the main 
rules dialog.

· When you create an Rule with the Alert action, the action indicates the group of the matching 
article.

· There is now a “Replace rules with same name” option for Importing rules.

· Rule conditions can be copied from another rule by using the “Insert From…” button on the rule 
condition page.

Image Gallery

The operation of the Image Gallery has been substantially overhauled and it is much easier to organize 
your decoded images.    In particular, the Gallery can be used to view directories that contain files that 
were not decoded by Gravity.    The Image Gallery automatically synchronizes its view with the files in 
the viewed directory, and in general implements Explorer-like drag and drop semantics.    The new 
features include:

· The directory bar now functions as a most recently used list of directories that you have viewed.    
Each time you open a directory for viewing, it appears at the top of the list.

· A new toolbar button has been added to allow easy filing using a most recently moved-to directory 
list.    This list is similar to the Move To toolbar button in Microsoft Outlook.

· In the thumbnail view, positioning the mouse over an image that Gravity decoded will cause a tool 
tip (bubble help) to pop up with the subject of the article.

· In the Image Gallery, when the display adjusts its size or position to accommodate an image, the 
mouse cursor is automatically repositioned so that it is over the button that was clicked (e.g. Next).

· An option has been added to the Image Gallery that allows the user to turn off automatic viewing 
even when the user hits the ‘v’ key.

· The Image Gallery now supports drag and drop.    When you use the Move To button, Gravity will 
keep track of the image’s From, Subject, and so forth.    If you drag the file out of Gravity and into 
Explorer or the desktop, then Gravity removes the file from its internal description database.

· The Image Gallery now has Waiting and Done indicators in the status bar which correspond to 
what is in the Image Factory.

· The Image Gallery has a progress bar in the status bar that shows the download progress of the 
current image being fetched for display.

· The Image Gallery has a Protect command that marks an Image as read only (this read only status 
is not implemented using the file system read only attribute).

· The Image Gallery now provides a command for launching the Image Factory (Ctrl-I).

· The Image Gallery now has popup menus.

View Filtering

· Filter definitions now allow the specification of the sort order.



· Each newsgroup can have its own default view filter.

· A button has been added to the filter bar for setting the current filter to the default for the group you 
are viewing.

Image Factory

· Articles with multiple attachments generate multiple Result window items.

· The Delete From Disk command removes the deleted item’s thumbnail if one exists.

· A Priority View (Ctrl+Shift+V) command has been added to allow you to automatically insert an 
article into the top of the queued jobs in the Image Factory.    If you invoke the command on an 
article that is already queued up, that article is moved to the top of the queue.

Retrieval

· A new server property setting has been added “Verify local headers when retrieving new header,” 
which can be disabled to speed the retrieval of headers.    If your purging options are set 
aggressively and headers are removed prior to when they would be removed at the server, then 
this is a good option.

· A Verify Local Headers command has been added to the Newsgroup menu to allow manual 
checking for expired articles.

· A new server property, “Retrieve headers for group automatically after subscribe,” has been 
added.

· Secure Password Authentication (SPA) is now supported for connecting to servers such as 
netnews.msn.com.

· Dialup Networking passwords are now encrypted when stored in the registry.

· A /socket command line option has been added that causes Gravity to log the communication 
between itself and the news server.    The files are named GRAVXXXX.TRC and are created in the 
Gravity program directory.

Thread Pane

· Articles with the same subject and articles that have a common ancestor (based on references) 
now appear as one tree within the thread display.

· When sorted by thread, the threads themselves can be sorted by score.

· The background color can be set for score ranges.

Article Pane

· A new command “Mute Quoted Text”, has been added to allow quoted text to be toggled on and 
off within the article display.    This is particularly helpful if you are following a thread and have 
already read the quoted material.

· Paging down within the article pane maintains a couple of lines of text from the previous page.

Software Update Checking

· Gravity now has an option to automatically check the MicroPlanet web site for newer versions of 
Gravity than the one you are running.    You can configure the number of days between checks on 
the Global Options/Updates tab.

Miscellaneous



· Gravity now strips signatures when replying or following up to articles that have signatures in the 
standard format (dash dash space return).

· The list of servers on the Server menu is kept sorted.

· Numerous usability requests were implemented.



Shortcut Keys

Edit Commands

Cut Selected Text Ctrl+X
Copy Selected Text to the Clipboard Ctrl+C
Paste Clipboard Text into an Article Ctrl+V
Select All Ctrl-A

Searching

Find Text within the Current Article Ctrl+F
Search for Text across Multiple Articles Ctrl+Shift+F

Navigation

Go to the Next Article (Down) D
View Next Unread in Thread E
Skip to Next Unread in Thread Shift+E
Go to the Previous Article (Up) U
Next Local Article B
Skip To Next Unread Local Shift+B
Next Unread Article N
Skip to Next Unread Article Shift+N
Move to the Previous Thread Ctrl+P
Move to the Next Thread Ctrl+N
Page Down or Next Article Space
Move to Next Pane Tab or F6
Move to Previous Pane Shift+Tab or 

Shift+F6
Refresh Current Group F5
Back to Previously Viewed Article Alt+Left Arrow
Switch to the Newsgroup pane 1
Switch to the Thread pane 2
Switch to the Article pane 3
Zoom Z
Escape to Next Outer Zoomed View Esc
Forward to Next Viewed Article Alt+Right Arrow

Article Actions

Delete Selected Articles Del
Mark All Articles as Read (Catch-up) Ctrl+Shift+C
Mark the Selected Articles as Read K
Kill the Current Thread Ctrl+K



Mark as Protected Ctrl+L
Unprotect Selected Articles Ctrl+Shift+L
Mark as Important Ctrl+R
Mark as Unread Ctrl+U
Mark as Normal Ctrl+O
Watch Thread W
Ignore Thread I
Save Selected Articles to a File Ctrl+S
Tag Selected Articles for Retrieval T

Posting and Replying

Post a New Article P
Reply by e-mail R
Follow Up to the Current Article F
Check Spelling F7
Send Post or e-mail Ctrl+Enter

Server Commands

Add/Remove Server Ctrl+Shift+S
Edit Server Properties Ctrl+Shift+P
Fetch Tagged Articles Ctrl+Shift+R
Retrieve Headers for All Groups Ctrl+Shift+H
Retrieve Headers for Selected Groups Ctrl+H
Start the VCR Shift+V
Stop Retrieving Ctrl+Break
Update Server Counts Ctrl+Shift+U

Decoding and Viewing

Manually Decode the Selected Articles Ctrl+M
Decode Selected Articles Ctrl+D
View Binary V
Priority View Ctrl+Shift+V
Image Gallery Ctrl+G
Image Factory Ctrl+I

Rules and Scoring

Add Score Entry S
Main Scoring Dialog Ctrl+Shift+G
Run a Rule Manually Ctrl+Shift+M
Re-Score Current Group Ctrl+Shift+I

Thread Pane



Toggle Collapsing of Thread Display Ctrl+T
Collapse Selected Thread -
Expand Selected Thread +
Refresh Displayed Group F5
Toggle between All Articles and default filter Ctrl+Shift+A

Article Pane

Toggle Display of Full Headers H
Toggle Muting of Quoted Text Q
Force article to display Ctrl+Enter

Miscellaneous

Help F1
Global Options Ctrl+Shift+O
Subscribe to a New Newsgroup Ctrl+B





The File Menu

 Purge and Compact Database
Examine each group, remove items that match the purge criteria that you set, and compact the 
database file containing the group. The name is usually the newsgroup name (e.g. comp.lang.c++). 

Keep All Sampled Newsgroups
Causes Gravity to convert all sampled newsgroups to subscribed newsgroups.    Otherwise, sampled 
newsgroups are removed at the end of the session or when changing to another server.

Import NEWSRC File
Import a standard NEWSRC file (which contains information about what has been read in newsgroups) 
into Gravity.

Export NEWSRC File
Export the subscribed groups to a standard NEWSRC file.

 Save As (Ctrl+S)
Save one or more articles to a file (archive). If only one article is selected, Gravity prompts to save that 
article. If more than one article is selected, Gravity appends the articles together and save them to the 
file.

Trace File
Trace files record the interaction between Gravity and the news server.    You must be disconnected 
from the server prior to starting a trace.    To start the trace, click the Start button.    Gravity will create 
one or more files with a .trc extension in the Gravity program folder.    These files can be examined 
using a text editor or can be attached to a message and sent to MicroPlanet support.    If you are 
having a specific problem (for example your posts are not appearing on the news server) you should 
perform the following steps:

1. Disconnect from the news server
2. Start tracing (File/Trace Files/Start)
3. Perform the command or commands that you are having trouble with
4. Stop tracing
5. Examine the trace logs
6. If the problem is not obvious, attach the logs to a support message and send them to 

support@microplanet.com

Page Setup
Select a printer for output and configure the settings for the printer.

 Print 
Print the selected articles.

Exit
Exit from Gravity. By default, you are asked if you really want to exit. You can turn off the prompt by 
clicking the “Don’t show this warning next time” checkbox in the warning dialog.



The Edit Menu

 Copy (Ctrl+C)
Copy selected text to the Clipboard. 

Select All (Ctrl+A)
Select all the text in the current article or thread pane.



The Search Menu

 Find (Ctrl+F)
Find words or phrases within the article pane. 

 Search (Ctrl+Shft+f) 
Perform powerful searches for information. You can perform regular expression searches (that is, you 
can specify patterns) for the articles in the current newsgroup or all newsgroups and you can specify 
which fields to examine and whether to search bodies. Additionally, you can limit the search to the 
information on your local drive. See Overview of Searching for more information on how to use 
Gravity’s powerful searching capabilities.

 Search DejaNews
Launch a web browser and connect to the DejaNews web server to search the DejaNews archive.



The Server Menu

 Connect 
Connect to the news server you have defined in the Setup tab of the Options dialog box. If you are 
already connected, click the Connect button to disconnect. If you have defined a Dial Up connection in 
the Global Options property sheet, Gravity establishes a network connection before it tries to connect 
to the news server.

 Update Server Counts (Ctrl+Shift+U)
Ask the news server for the number of current Unread articles for each newsgroup you are subscribed 
to. You should also examine the settings for controlling when this happens automatically. See 
Changing your Automatic Retrieval and Group Settings (Operation Tab) .

 Retrieve Headers (Ctrl+Shift+H) 
Retrieve the headers for all subscribed newsgroups where you’ve set the “Save article headers” 
option. Newsgroups configured not to retrieve headers retrieve them when you choose the Open 
command, press enter while the newsgroup is selected, or double-click the newsgroup.

Retrieve Tagged Articles (Ctrl+Shift+R)
Retrieve and store the headers and bodies for all the articles tagged using the Tag/Untag or Retrieval 
command (T).

Retrieve Tagged for Selected Groups
Retrieves the tagged articles for all of the groups that are selected in the newsgroup pane.

 Stop Retrieving (Ctrl-Break) 
Cancel all jobs queued up for download from the news server. Use this button, for example, to get the 
list of all newsgroups, retrieve the headers for a group, or download tagged bodies.

Properties
View or edit the properties and settings for the currently open news server.

 Add/Remove
Add a new news server to connect to, or remove an existing one.



The Navigate Menu

Note: Some of the following commands are affected by settings under Global Options/Navigation.

 Skip to Next Unread Article
Moves to the next unread article, but does not open that article.

 Skip to Next Unread in Thread
Moves to the next unread article in the thread, but does not open that article.

 Skip to Next Unread Local
Moves to the next unread local article, but does not open it.

 View Next Unread Article
Moves to the next unread article and displays it.

 View Next Unread in Thread
Moves to the next unread article in the thread and displays it.

 View Next Unread Local
Moves to the next unread local article and displays it.

Up One Article
Moves up one article in the thread pane, regardless of how it is sorted, and displays it.

Down One Article
Moves down one article in the thread pane and displays it.

More
Advance through a newsgroup. If you are reading an article, press spacebar to page down until the 
end of the article. Then press spacebar to go to the next article in the newsgroup. You can continue 
through the entire newsgroup until you read all the articles.    The behavior of this command is affected 
by the settings under Tools/Global Options/Navigation.

 Back
Works like the Back button in a web browser – it loads the previously viewed article into the display.

 Forward
Works like the Forward button in a web browser – moves to the article that was viewed after the article 
you are currently viewing.



The Newsgroup Menu

 Subscribe (Ctrl+B)
Choose one or more newsgroups to subscribe to, and set initial properties of these groups. 
Subscribing to a newsgroup means you can retrieve the articles at the news server. See Subscribing to 
a Newsgroup for details.

Unsubscribe
Select a newsgroup you no longer want to subscribe to, and then choose Unsubscribe. This removes 
the group from the newsgroup pane. See Unsubscribing from a Newsgroup for details.

 Retrieve Headers
Retrieve any new headers for the selected group from the news server. Note that the Retrieve Headers 
command on the File menu retrieves the headers for all subscribed groups.

Retrieve Limited Number of Headers
Allows you to specify the number of new headers to retrieve from the news server.    This command 
overrides any server or newsgroup based limit you have set.    For example, if you have set a group to 
only get 500 headers at a time, you can still retrieve 1000 through this command. 

Keep Sampled Newsgroup
Convert the newsgroup from sampled status to subscribed.

 Mark as Read/Catch Up (Ctrl+Shft+C) 
Mark any articles you have retrieved from the news server as Read. Note that you can still view the 
articles you’ve read but not purged by adjusting the view filter. This command does not mark headers 
that haven’t been retrieved as Read. That is, the number under the “Server” column of the newsgroup 
pane is unaffected.

 Get New Groups
Retrieve a list of any newsgroups added to the news server since you retrieved the entire list when 
installing Gravity, or since the last time you chose Get New Groups. Note that you can configure 
Gravity to get the new list of groups each time it connects to the news server.

 Re-read All Groups
Retrieve the entire list of newsgroups again. This also replaces your current list of newsgroups with the 
list currently available at the news server.

Sort By
Sort the articles in the thread pane. Normally articles are organized into conversations, or threads. You 
can use the dialog box to sort by any column you have displayed, in ascending or descending order. 
You can accomplish the same thing by clicking the column headers.

Filter Display
Choose a display filter from a list of defined display filters (such as “Unread Articles”). You can also 
use the handier Filter Bar for these tasks.

Define Display Filter
Add, edit, or delete display filters. Set the display filters as must be on, must be off, or ignore. See the 
tutorial on display filters: Lesson Eight - Using Display Filters .

 Lock Filter
Keeps the currently active filter when switching newsgroups, even if the newsgroup has a default filter.

 Properties
Use the newsgroup’s properties sheet to set attributes for the newsgroup and change the display 



characteristics of the newsgroup pane. See Setting Newsgroup Properties    for details.



The Thread Menu

A thread is a group of articles all linked by the same topic, much like a conversation. Threads appear 
on the screen as articles indented in a hierarchy and show the relationship between articles. The 
thread menu lets you work with these groups.

Previous (Ctrl+P)
Move the selection to the previous thread.

Next (Ctrl+N)
Move the selection to the next thread.

 Mark Thread as Read (Ctrl+K)
Remove all articles in the display that belong in the same thread as the currently selected article. Also 
known as Kill Thread.

Mark Thread As Unread
Mark as Unread all articles in the display that belong in the same thread as the currently selected 
article.

Mark Thread As Important
Mark all articles Important in the display that belong in the same thread as the currently selected 
article.

Mark Thread As Normal
Turn off the Important attribute in the display for any articles that belong in the same thread as the 
currently selected article.

Mark Thread As Protected
Protect all articles in the display that belong in the same thread as the currently selected article. When 
an article is protected, it cannot be deleted or purged until it is marked as deletable.

Mark Thread As Deletable
Remove protection from all articles in the display that belong in the same thread as the currently 
selected article. Once the protection is removed, you can purge or delete the article.

 Watch Thread (W)
Watching a thread causes all articles that belong in the thread of the currently selected article to be:
n Retrieved (or tagged if off-line)
n Added to the watch list along with all ancestor message-ids
n Any future descendants of the article are retrieved.
See Lesson Ten - Rule System Overview for a more in depth discussion of the Watch Thread 
command.

 Ignore Thread (I)
Ignoring a thread causes all articles that belong in the thread of the currently selected article to be:
1. Marked as Read (and consequently removed from the display if only Unread articles are being 

displayed)
2. Added to the ignore list along with all ancestor message-ids
3. Any future descendants of the article are marked as read
See Lesson Ten - Rule System Overview for a more in depth discussion of the Ignore Thread 
command.

Expand (+)
Expands the currently selected thread.



Collapse (-)
Collapses the currently selected thread.

Expand All/Collapse All(Ctrl+T)
Expand or collapse all threads in the thread pane.



The Article Menu

 Post (p) 
Create a new USENET article. The destination newsgroup defaults to the current newsgroup. Use Post 
when you have a new topic to discuss—see Posting Articles.
After typing your message in the Posting Article window, choose Send from the File menu. This places 
your article in the Outbox, waiting to be transferred to the news server. 

 Follow Up (f) 
Create a USENET article in response to an existing article, thereby extending the conversation. The 
text of the original article appears, allowing you to refer to parts of it directly. Even though the entire 
text of the original is inserted, eliminate the sections to which you aren’t responding. This saves 
bandwidth and is good Netiquette.
After typing your message in the composition window, choose Send from the File menu. This places 
your article in the Outbox, waiting to be transferred to the news server. 

 Reply (r) 
Respond by e-mail to the author of the article. The thousands of members of the USENET community 
will not see your response.
After typing your message in the composition window, choose Send from the File menu. This places 
your article in the Outbox, waiting to be transferred to the SMTP mail server. 

 Show Full Header (h)
By default, Gravity shows only the most important header lines in the current article. If you want to view 
the header in its entirety, press the ‘h’ key. Pressing ‘h’ again restores the original view. See Changing 
Display Fields.

Mute Quoted Text
This command will collapse and expand the quoted text in the article pane.    You can control how many 
lines of the quoted text are shown when text is muted by setting an option on the Global Options/Article 
Layout page.

 Mark as Read (k)
Mark an article as Read—it will no longer be New. If your view filter is set to show only new articles, 
then the article disappears from the display.

 Mark as Unread (Ctrl+U)
Mark an article as Unread. This is useful if you need to come back to a newsgroup and want to re-read 
a particular article.

Mark as Important (Ctrl+R)
Mark an article as Important. You can use or set rules to work with Important articles. 

 Mark as Protected (Ctrl+L)
Mark an article as protected. You cannot delete or purge a protected article until you mark it as 
deletable. Additionally, if the body is not local when you protect an article, you can tag the article for 
retrieval.

Mark as Deletable (Ctrl+Shift+L)
Remove the protection on an article. You can then delete or purge the article.

 Delete (Del)
Delete an article and its body from your database. This also marks the article as Read. If the article 
was cross-posted to other newsgroups, then it is marked Read in all of them.



 Decode (Ctrl-D) 
Decode and extract attachments in the selected articles. If you are decoding an attachment split across 
several articles, you only need to select one part. See Decoding Files and Images.

 View (v) 
Decode and view the article, or view it if it is already decoded.

Priority View (Ctrl+Shift+V)
The Priority View command will automatically move the selected article(s) to the top of the Image 
Factory Queued Jobs window.    This command is useful if you have queued a large number of decode 
jobs and want to view a specific item as soon as possible.    You can use the command even if the 
article is already in the queue.    Thus, it’s a shortcut for opening the Image Factory window, selecting 
the item in the Job Queue, and clicking “Move To Top.”

Manual Decode (Ctrl-M)
Normally Gravity is very intelligent about decoding attachments and can piece multi-part attachments 
in the right order. If this is unsuccessful, you can still extract the attachment by selecting the articles 
containing the attachment and choosing Manual Decode. You see a dialog box where you can adjust 
the order the parts if necessary. Then press the Decode button.

Unscramble (ROT-13)
Some articles are scrambled with a simple cipher to prevent you from reading them inadvertently. This 
masks possibly offensive humor or maybe just hides the punch line. This command unscrambles the 
article. 

Forward Via Mail
Select one or more articles and send them by e-mail to a friend.

 Save As (Ctrl-S)
Save the selected articles to a file. If any article bodies aren’t in the database, Gravity downloads 
them.

 Tag/Untag for Retrieval (t)
By default, Gravity only downloads the headers for articles. If you want to read off-line, you must 
download the bodies of the articles separately. Tag the articles you want by pressing the T key. Tagged 
articles show a tag symbol in the thread pane . To remove the tag, press T again.    To start retrieving, 
choose Retrieve Tagged Articles from the File menu.

Cancel Article
Cancel an article you have posted in error. You can only cancel articles you have authored. If, instead, 
the article has not been sent, you can simply delete it from the Outbox.



The View Menu

Toolbars
Brings up the Customize Toolbars window, which allows the customization of the toolbars (and the 
addition of new toolbars).

Status Bar
Show or hide the Status Bar at the bottom of the Gravity main window.

Rule Bar
Show or hide the Rule Bar. The Rule Bar is an easy way to pick a defined rule and run it.

Outbox Bar
Show or hide the Outbox Bar. The Outbox Bar displays the number of messages in the outbox that 
have been sent and the number of messages (both e-mail and USENET articles) that are waiting to be 
delivered.

Filter Bar
Show or hide the Filter Bar.    The Filter bar allows you to control various aspects of the Thread Pane, 
including what articles are selected in the display, whether the items are threaded, their sort order, and 
so forth.

 Image Gallery (Ctrl+G)
The Image Gallery is a window that allows you to view and rapidly file decoded images.

 Image Factory (Ctrl-I) 
View the Image Factory window. The Image Factory contains a list of decoded attachments, both the 
ones successfully decoded and those that were not. If the attachments are images you can launch a 
viewer from here or delete the attachment file from your disk.

 Outbox
View the messages waiting to be delivered and those messages that have already been sent. You can 
delete messages or view them from the Outbox window.

Print Jobs
View the articles waiting to be printed. Use the Print Jobs windows to delete or reorder print jobs.

Event Log
View a history of activity in Gravity. If any mail or post errors occur, they will be listed here. You can 
select an item and choose “Details” to get more information on an event.

Rule Statistics
View statistics for each of your rules, including how many times they were evaluated, how many times 
they fired, the number of seconds spent in each, and the total percentage of rule time taken up.

Note: The total percentage may not add up to 100% since some time is spent in general rule 
overhead.

Watch List
List all of the currently watched threads. From within the Watch List you can remove any watched 
threads and set two settings. The first setting controls how long after articles of a thread stop appearing 
before Gravity stops looking for them (i.e. removes them from the Watch List). The second setting 
controls whether Gravity treats articles with the same subject as belonging in the same thread when 
looking for watched articles.

Ignore List
List all of the currently ignored threads. From within the Ignore List you can remove any threads that 



are being ignored and set two settings. The first setting controls how long after articles of a thread stop 
appearing before Gravity stops looking for them (i.e. removes them from the Ignore List). The second 
setting controls whether Gravity treats articles with the same subject as belonging in the same thread 
when looking for articles to ignore.

 Zoom (Z)
n If the Gravity display is in a non-zoomed state, zoom the pane (i.e. enlarges it and obscures the 

other two).
n If one of the panes is currently zoomed, zoom out to see all three panes.
n Zooming can also work as a mode, where you can tab between panes with the tab key in the 

zoomed state. If you use the Escape key in the zoomed state, Gravity displays the next outer 
zoomed pane. For example, if the article pane is zoomed and you press Escape, the zoomed thread 
pane is shown. Press Escape again to see the zoomed newsgroup pane.

Newsgroup Pane (1)
Switch to the newsgroup pane.

Thread Pane (2)
Switch to the thread pane.

Article Pane (3)
Switch to the article pane. 

 Options (Ctrl+Shft+O) 
View the Global Options dialog box. Each tab contains a different group of options or preferences. This 
is the central place to configure Gravity.



The Tools Menu

 Rules 
Compose new rules, edit existing ones, or remove rules you no longer need. See Overview of Rules 
for details.

Apply a Rule Manually
Select a rule to run on a given newsgroup. See Manually Applying Rules for details.

Bozo Bin
See a list of users that have been placed in the Bozo Bin. The Bozo Bin is often referred to as the kill 
file. It weeds out articles by users who have proved to be, shall we say, less than tactful or bright.

Apply bozo bin to current group
Runs the current bozo bin list against the currently open newsgroup and marks all items from Bozo 
members as read.

Important Words
Edit a set of words flags articles as Important. You can then filter the display to quickly show articles 
that are Important. See Using Standard Rules for details.

Scoring (Ctrl+Shift+G)
The main Scoring dialog allows you to manage your score lists – values that get assigned to articles 
that contain certain words or phrases.    The scoring system is one of the most powerful features of 
Gravity.

Score Colors
The Score Colors dialog allows you to assign colors to threads that fall into score ranges.    Score 
colors (along with sorting by thread score) allow you to visually identify interesting articles/threads 
quickly.

Re-Score Current Group (Ctrl+Shift+I)
The Re-Score command allows you to re-calculate the scores for the current group based on the score 
lists contained in the main Scoring dialog.

Add Score Entry (S)
The Add Score Entry command is the fastest way to add a score for the current group.

VCR
The VCR allows you to select groups from any of your defined news servers and cycle through and 
retrieve the headers, bodies, process rules, and so forth. You can start the process right away, or you 
can schedule it to occur at a later time (such as at midnight). Gravity can optionally exit when all of the 
jobs have completed. 

The VCR remembers its settings from previous runs, but you can also save VCR settings to a file and 
re-use them later. Gravity has a new command line switch (/vcrfile: ) that allows you to start Gravity 
with the VCR running.



The Help Menu

Gravity Help Topics
View the help table of contents.

Tutorial
Use the twelve-lesson Gravity Tutorial, which walks you through many of the important aspects of 
operating Gravity.

Using Help
See a description of how to use the help facility built into Windows.

Getting the Most Out of Gravity
Read tips to help you become a Gravity power user.

About Gravity
See the Gravity splash screen, which shows the current version of the program you are running, 
whether or not it has been registered, and if you are using a 30 day evaluation copy of the product, 
when the evaluation will expire. It also allows you to enter your registration key if you have not already 
done so.    Finally, if you are already registered, you can view your registration information using the 
Info button.



The Newsgroup Pop-up Menu

 Retrieve Headers
Retrieve any new headers for the selected group from the news server. Note that the Retrieve Headers 
command on the File menu retrieves the headers for all subscribed groups.

Retrieve Limited Number of Headers
Retrieve a specified number of headers from the newsgroup.    This command overrides any limit set 
for the server or newsgroup.

Retrieve Tagged for Selected Groups
Retrieves all tagged articles for the groups that are selected in the newsgroup pane.

Open
Open the selected newsgroup and display any headers matching the current display filter in the thread 
pane. Additionally, if the local unread count is zero and there are unread articles at the server, Gravity 
fetches the unread headers.

Verify Local Headers
This command gets the absolute list of articles available for the group from the news server and then 
checks for expired headers that Gravity has already retrieved and removes any that are no longer 
available at the server.

 Post (P) 
Post a new article to the selected newsgroup. See Posting News Articles for details.

 Mark as Read (Ctrl+Shft+C) (Catch Up) 
Mark any articles you have retrieved from the news server as Read. You can still view articles you’ve 
read but not purged by adjusting the view filter. This command does not mark headers that haven’t 
been retrieved as Read. That is, the number under the “Server” column of the newsgroup pane is 
unaffected.

Keep Sampled Newsgroup
Switches the status of the selected group(s) from sampled to subscribed (i.e. the groups are not 
removed at the end of the session).

Unsubscribe
Select a newsgroup you no longer want to subscribe to, and then choose Unsubscribe. This removes 
the group from the newsgroup pane. See Unsubscribing from a Newsgroup    for details.

Manually Apply a Rule
Select a rule to run on a selected newsgroup. See Manually Applying Rules for details.

 Properties
Use the property sheet for the newsgroup to set attributes (storage mode, purging options, and so 
forth) for the newsgroup and change the display characteristics of the newsgroup pane. See Setting 
Newsgroup Properties for details.



The Thread Pop-up Menu

 Post (p) 
Post a new article to the selected newsgroup. See Posting News Articles for details.

 Follow Up (f) 
Create a response to the current article that will be posted to any groups the original article appeared 
in. See Following Up - Sending your Reply to the Whole Newsgroup for details.

 Reply (r) 
Send a reply via e-mail to the current article. See Replying to an Article by e-mail for details.

 Tag/Untag (T)
Tag an article for retrieval. To retrieve all of the tagged articles use the Retrieve Tagged Articles 
(Ctrl+Shift+R) command.

 Mark as Read (k)
Mark an article as Read—it is no longer New. If your view filter is set to show only new articles, then 
the article does not appear in the display.

 Mark as Unread (Ctrl+U)
Mark an article as Unread. This is useful if you need to come back to a newsgroup and want to re-read 
a particular article.

Mark as Important (Ctrl+R)
Mark an article as Important. You can use or set rules to work with Important articles.

 Mark as Protected (Ctrl+L)
Mark an article as protected. You cannot delete or purge a protected article until you mark it as 
deletable. Additionally, if the body is not local when you protect an article, you can tag the article for 
retrieval.

Mark as Deletable
Remove the protection on an article. You can then delete or purge the article.

 Mark Thread as Read (Ctrl+K)
Remove all articles in the display that belong in the same thread as the selected article. Also known as 
Kill Thread.

Mark Thread as Unread
Mark as Unread all articles in the display that belong in the same thread as the selected article.

Mark Thread as Important
Mark all articles Important in the display that belong in the same thread as the selected article.

Mark Thread as Normal
Turn off the Important attribute in the display for any articles that belong in the same thread as the 
selected article.

Mark Thread as Protected
Protect all articles in the display that belong in the same thread as the currently selected article. When 
an article is protected, it cannot be deleted or purged until it is marked as deletable.

Mark Thread as Deletable
Remove protection from all articles in the display that belong in the same thread as the currently 
selected article. Once the protection is removed, you can purge or delete the article.

 Delete (Del)
Mark an article as read, and then purge it from the newsgroup. This way, even if you set the view filter 
to Read, you do not see the article in the Thread pane. 

 Decode (Ctrl-D) 



Add the selected articles to the Gravity decode queue, which you can view in the Image Gallery . If 
you select only one part of a multi-part article, Gravity tries to assemble and decode all of the parts for 
you. See Overview of the Image Gallery for details.

 View (v)
Decode and view the article, or view it if it is already decoded.

Forward
Forward the selected articles via e-mail to another user. See Mailing Articles to Friends for details.

 Save As (Ctrl-S)
Save one or more articles to a file (archive). If only one article is selected, Gravity prompts to save that 
article. If more than one article is selected, then Gravity appends the articles together and saves them 
to the file.

 Search (Ctrl+Shft+F) 
Perform powerful searches for information. You can perform regular expression searches (that is, you 
can specify patterns) for the articles in the current newsgroup or all newsgroups and you can specify 
which fields to examine and whether to search bodies. Additionally, you can limit the search to the 
information on your local drive. See Overview of Searching for more information on how to use 
Gravity’s powerful searching capabilities.

 Add Author to Bozo Bin
Add the author of the selected message to the Gravity Bozo Bin. When you retrieve headers from the 
server, Gravity marks messages from this author as Read. Gravity does not display it in the Thread 
pane unless you change the display filter to show Read items.

 Watch Thread (W)
Watching a thread causes all articles that belong in the thread of the selected article to be:
n Retrieved (or tagged if off-line)
n Added to the watch list along with all ancestor message-ids
n Any future descendants of the article are retrieved
See Lesson Ten - Rule System Overview for a more in depth discussion of the Watch Thread 
command.

 Ignore Thread (I)
Ignoring a thread causes all articles that belong in the thread of the selected article to be:
n Marked as read (and consequently removed from the display if only Unread articles are being 

displayed)
n Added to the ignore list along with all ancestor message-ids
n Any future descendants of the article are marked as Read
See Lesson Ten - Rule System Overview for a more in depth discussion of the Ignore Thread 
command.

Properties
Set the display attributes for the thread pane, such as the font, background color, and sort order.



The Article Pop-up Menu

 Post (p) 
Post a new article to the selected newsgroup. See Posting News Articles for details.

 Follow-Up (f) 
Create a response to the current article that will be posted back to any groups the original article 
appeared in. See Following Up - Sending your Reply to the Whole Newsgroup for details.

 Reply (r) 
Send a reply via e-mail to the current article. See Replying to an Article by e-mail for details.

 Edit - Copy (Ctrl-C)
Copy the selected text to the Windows clipboard.

Edit - Select All (Ctrl-A)
Select the entire text of the article.

 Find (Ctrl-F)
Search for text within the article.

Forward
Forward the current article via e-mail to another user. See Mailing Articles to Friends for details.

 Save As (Ctrl-S)
Save this article to a file (archive). You can choose to have Gravity append the article to an already 
existing file.

 Decode (Ctrl-D) 
Add the current article to the Gravity decode queue, which you can view in the Image Gallery . If you 
select only one part of a multi-part article, Gravity tries to assemble and decode all of the parts for you. 
See Overview of the Image Gallery for details.

 View (v) 
Decode and view the article, or view it if it is already decoded.

Rot-13
Some articles are scrambled with a simple cipher to prevent you from reading them inadvertently. This 
is used to mask possibly offensive humor or maybe just to hide the punch line. This command 
unscrambles the article. 

 Add to Bozo Bin
Extract the author of the current viewed article and add the author to the Bozo Bin. The Bozo Bin is 
often referred to as the “kill file,” and weeds out articles by users who have proved to be, shall we say, 
less than tactful or bright.

Add Important Word
Add the selected word or phrase to the Important Words list. For example, if you add the word 
“doghouse,” Gravity marks any future articles that contain “doghouse” in the subject or body as 
important. The article appears with a red exclamation point next to it .

Properties
Choose the fonts, the header fields you want to display, and the background color for viewing articles.



The Posting and Sending Menus

The following menu commands appear in a number of compose dialogs. 

 Insert File 
Insert text from a file into the article or message you are composing.

 Send (Ctrl-Enter) 
Send the article or message you are composing.

 Save Draft
Saves the message to the Outbox in Draft form so that it can be edited and sent at a later time.    The 
draft can be re-edited later by opening the Outbox, selecting the article, and clicking the Back To 
Editing button.

 Cancel (Esc) 
Cancel sending the item you are composing.

Undo (Ctrl-Z)
Back out or replay a single change (inserted or deleted text) you have made to the message you are 
composing.

 Cut (Ctrl-X), 

 Copy (Ctrl-C), 

    Paste (Ctrl-V) 
Remove the selected text and places it in the Windows clipboard.
Copy the selected text to the Windows clipboard.
Paste the contents of the Clipboard into the article or e-mail message you are composing.

 Add Attachment 
Attach one or more files to the article or mail message you are composing. See Posting News Articles 
for details.

 Check Spelling (F7)
Run the Gravity spell checker on the article or e-mail text. As you are checking misspelled words, you 
can ignore, change, or add words to the dictionary. You can also set spell checking configuration 
options.

Remove Attachment
Remove an attachment you added to the article or message you are composing.

Choose Groups
Choose one or more newsgroups where the post or follow up article you are composing will appear.

Scramble
Apply the ROT-13 encryption command to the article you are composing. Select Scramble again to 
unscramble the article.





Introduction to the Gravity Tutorial            

 
You may know how powerful Gravity is, but where do you start?    Rather than burdening you with a lot 
of theory, we think the best way to get you up to speed is to guide you through a number of lessons or 
steps.    As you perform specific tasks, we explain what is going on behind the scenes.    When you 
complete the tutorial, you should have a good understanding of how to use Gravity.

NOTE:    Size the Help window until it takes up about a quarter of the screen. Then choose Keep Help On Top from 
the Options menu to keep the tutorial open as you work through each lesson.

Lesson One - Getting Connected 

Lesson Two - Basic Concepts and Configuration Settings 

Lesson Three - Subscribing to a Newsgroup 

Lesson Four - Retrieving Headers and Reading Articles 

Lesson Five - Adjusting the Display 

Lesson Six - Working with Binary Images 

Lesson Seven - Techniques for Off-line Reading 

Lesson Eight - Using Display Filters 

Lesson Nine - Composing Articles and Replies 

Lesson Ten - Rule System Overview 

Lesson Eleven - Composing Your First Rule 

Lesson Twelve - Applying Rules Manually 



Lesson One - Getting Connected 

{button Next 
Lesson,JI(`GRAVITY.HLP',`Lesson_Two_Basic_Concepts_And_Configuration_Settings'
)}

When you run Gravity for the first time, you see the Setup dialog box.    Click an area on the following 
illustration for an explanation.

 
Gravity checks the Windows registry for reasonable defaults for these fields.    For the Full name and 
Organization, it looks at the information you entered when you installed Windows.    For your news server, 
mail server, and e-mail address, it checks to see if you have already run another newsreader, and if so, 
defaults to the values that you selected when you installed it. 

To Get Connected

1. Enter a nickname for the news server (e.g. “Microsoft”), the server address (e.g. 
“msnews.microsoft.com”), your mail server, and your e-mail address.    Then click the OK button.

Gravity retrieves the list of newsgroups available at your news server.    Depending on the speed 
of your connection, this can take a few minutes. 

2. When you see the Subscribe to Newsgroup dialog, press the Esc (Escape) key to go to the next 
step in the tutorial. 

See Also:

What to do if you have trouble with Setup 



News Server

A news server is a computer with a lot of information on it (typically gigabytes of USENET news data). 
Gravity interacts with a news server so you can read and participate in discussions.    The news server 
address is typically in one of the following forms: news.org.com, news.org.net, nntp.org.com, 
nntp.org.net. 

Variations on Addresses

You can access several different types of news servers.    For example, you can access one your 
company maintains through a direct network connection.    If you work at Corporation X, then the 
address might be news.corporationx.com. 

Your Internet Service Provider (ISP) may also provide a news server.    If your ISP is UUNET, for 
example, your news server address might be news.uu.net. 

Two other types of servers are public servers and commercial servers.    Although anyone can access a 
public server, there are only a few because providing the infrastructure for global access is prohibitive. 
One public server is msnews.microsoft.com, which Microsoft maintains to provide information about 
its products and services.    You can also subscribe to commercial news servers, such as AirNews and 
SuperNews, for a monthly fee.    They often have more content than news servers provided by your 
company or ISP.

If you have questions about your news server address, contact your network administrator or check the 
web page of your Internet Service Provider.

If you do not specify a news server address, then Gravity will try to connect to the server using the 
nickname.



Mail Server

The mail server is an SMTP (Simple Mail Transport Protocol) server.    When you reply to an article via 
e-mail or click an e-mail address in an article to send e-mail, Gravity uses the mail server you specify. 
Mail servers usually have addresses of the form mail.org.com or mail.org.net. 



e-mail Address

Enter the return address to use when you post articles to the news server and when you send e-mail.    
Others use that address to reply directly to you.    You cannot start Gravity without supplying your e-
mail address.



Reply Address For Posts

You can specify a different reply address that is inserted into the `From’ header field when you post 
articles.    This is useful for blocking spam to your real e-mail address.    If you leave this field blank, 
your regular e-mail address will be used when you post articles (from the above e-mail address field).



Full Name

Enter the Full Name if you want to supply supplemental information when you post news articles or 
send e-mail.    Then users view you as Joe User as opposed to 1435@xyz.com.    We suggest you use 
your real name as a courtesy to others on the Internet.



Organization

If you belong to an organization when you post news articles, enter its name. 



No Password Required

Select this radio button if the news server you are connecting to requires no authentication.



Long on using Name

If your news server requires a name and password, check the “Log on using” radio button and fill in 
the account name in this field (as well as the password field).    This name and password corresponds 
with the NNTP AUTHINFO command.



Log on using password

If your news server requires a name and password, you supply the password in this field.



Log on using Secure Password Authentication

If you are connecting to The Microsoft Network or another server that requires the use of SPA, check 
this radio button.    Secure Password Authentication insures that your name and password are 
encrypted prior to being sent to the news server.



NNTP Port

The news server listens for incoming connections on the “NNTP Port.”    You rarely have to change this 
setting.    If your server uses a different port, then you will need to get the number from your network 
administrator.



SMTP Port

The outgoing mail server listens for incoming connections on the “SMTP Port.”    You rarely have to 
change this setting.    If your server uses a different port, then you will need to get the number from 
your network administrator.



What To Do If You Have Trouble with Setup

Refer to the following sections for more information on different problems:

Could not look up hostname

One of two problems is possible.    The first is that you typed the wrong news server name in the News 
server field.    Check the information your ISP gave you to make certain you have it correct.    The 
second possibility is that there is some problem with your network.    To test this, go to a DOS prompt 
and type “ping your_server” where your_server is the name of your news server.    If that server does 
not respond, it means that your news server is not directly reachable and there is a problem in your 
network connection.    Check with your network administrator.

Response From Server: 480 Authentication Required for Command

You probably have not supplied a name and password in the View/Options/Setup/Advanced dialog.

Error authorizing your password with the News Server

You have probably entered a name and password in the View/Options/Setup/Advanced dialog when 
they are not required by your server.

You have no permission to talk

If you tried to connect to a server and see this message, then you are not in the range of IP addresses 
that the news server allows for connection.    You must either log in from another network address or 
find a new server to try.



Lesson Two - Basic Concepts and Configuration Settings
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Before you subscribe to your first newsgroup, review a few terms and the main Gravity screen so that 
you will understand what you are modifying. Then you can make a few configuration changes.

See Also:

Gravity Terms 

Adjusting the Window Layout 

Setting Initial Storage Settings 

Changing Other Settings 



Gravity Terms

Articles

Articles are the whole reason you are trying Gravity—you want to read the articles posted to 
newsgroups and perhaps contribute some of your own.    An article consists of a header and a body.

Headers

A header is a list of summary fields for a particular article—just enough so that you can figure out if you 
want to read the article.    The main header fields include the subject of the article, who the article is 
from, the date it was sent, the number of lines of text in the body, and perhaps a list of articles that it 
refers to.

Bodies

Bodies contain the actual text of an article, and can range from a few lines to many thousands of lines. 
Additionally, when Gravity retrieves an article body, it also retrieves a complete list of the headers 
available for the article.



Adjusting the Window Layout

1. Click the Options button  to see the Global Options dialog box. 

2. Click the Window Layout tab to see your window layout choices. 
3. Choose a layout to arrange the three panes in a comfortable configuration. 

If you have a display with a resolution greater than 640x480, you may want to switch to another 
window layout, such as one with the newsgroup pane in the upper left, the thread pane in the upper right, 
and the newsgroup pane across the bottom.    To do so, choose the leftmost configuration.

4. Click the OK button. 



Setting Initial Storage Settings

1. Click the Options button  to see the Global Options dialog box. 

2. Click the Storage tab. 
The global storage tab controls the initial default storage settings for each group that you 

subscribe to. 
3. Check or clear the Storage Settings check boxes.

Retrieve and store article bodies: Check this box to have Gravity automatically retrieve a body 
for each header that it downloads from the group.    This allows you to read the articles when you are 
completely disconnected from the news server.    However, certain groups (notably binary ones) require a 
lot of disk space when you use this option. 

If you clear both checkboxes, then Gravity retrieves the headers from the server every time you 
open a newsgroup.    This saves disk space but is slow and causes more network traffic. 

You can also override the default settings for each group that you subscribe to.    Thus, you may 
have some groups where you store nothing (perhaps groups that have low traffic and that you 
read infrequently), some that you store only the headers for, and some that you store everything. 

Store all bodies retrieved for reading: Check this box if you want Gravity to store an article in 
the database if you have retrieved it for reading.    Keep in mind that this may significantly increase 
the amount of disk space used and that you may need to adjust the purge settings when using 
this setting.



Changing Other Settings

1. Click the Options button  to see the Global Options dialog box.    These options affect all servers 
that you create.

2. Click the Decoding, Signature, Preferences tab. 
Decoding: Select a directory where you want Gravity to store decoded images.    By default they 

are stored in a directory named “download” beneath the Gravity program directory.
Signature: Use this tab to create and choose from several signatures.    You can create one to 

store in the Gravity database or select an existing file, such as the same signature file you use for e-mail. 
· To create a signature, click the New Signature button and enter a name, such as my sig. 

· If you want to use a file, click the Use a File button or type your signature into the edit box.

· Click the Set as Default button to make Gravity use this signature by default when composing 
new articles and e-mails.

Preferences: Select the Open newsgroup with a single click check box, which allows you to use a 
single click to load the headers for a newsgroup into the thread pane.    When there are no local 
unread headers, a single click lets you fetch any unread headers at the server.    We suggest that 
you do not enable the Display articles with a single click option until you are familiar with the way 
Gravity works.

3. Click the OK button to save your changes.

4. Select the Properties command from the Servers menu.    These settings affect the currently open 
server. 

5. Click the Connect or Operation tab.

Connect: Change the Send keep alive messages every XX minutes interval to 5 minutes so that 
your ISP does not disconnect you when you are idle. 

Operation:.

You may also want to change the setting for when to update the server counts.    By default, 
Gravity asks the server for the lowest and highest article for each group you are subscribed to 
each time you connect.    This keeps you current, you may not always want to update the counts 
when you reconnect.    Change the setting to “once per session” and Gravity only updates the 
counts when you first connect to the server.    We suggest you also instruct Gravity to include 
cross-post data when it is retrieving headers.    When you enable this option, Gravity marks an 
article as read in all groups that it is cross-posted to when you read or delete it.

6. Click the OK button to save your changes.    You can explore the other tabs after you have gained 
a rudimentary understanding of the way these settings work.



Lesson Three - Subscribing to a Newsgroup
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Now you’re ready to subscribe to a newsgroup so you can start reading news. 

1. From the Newsgroup menu, choose the Subscribe command or press Ctrl-B to see the 
Subscribe to Newsgroup dialog box. 

 
2. Notice the fractional groups tally in the upper left corner of the dialog.    This tells you how many 

of the total newsgroups are matched by the current search.

3. Type art in the search window.    Notice that the Groups window only shows newsgroups that 
include the text "art."    The fraction in the upper left is adjusted for each character you type as 
Gravity finds matching newsgroups.

4. When the search string is “art,” press the Backspace key several times.    Gravity finds the 
matching entries each time you press Backspace.    You can put focus in the Groups window 
without using the mouse by pressing Shift-Tab if you are in the Search window.

5. Reset the search now and type news.announce.newusers.    Only that newsgroup appears in 
the Groups window. 



6. Double-click the group or highlight it and click on the Add button to move it to the Selected 
Newsgroups window.

7. If you want preview a newsgroup before subscribing to it, you can sample it using the Sample 
check box.    When you sample a newsgroup, it is automatically removed from the list of 
subscribed newsgroups at the end of the Gravity session or when you switch to a different 
server.

8. You can also change the storage options for the group from the default (Save article headers) 
and control the maximum number of articles to initially retrieve.    You can override the global 
settings for these values. 

9. When you are finished, click the Done button.

10. Gravity records your subscription to each group that appears in the Selected window.    It then 
creates a job for each newsgroup that asks the news server for the lowest and highest article 
numbers in that group.    Gravity uses this information to calculate how many unread items are at 
the server.    If you told Gravity to start with fewer than are available at the server, Gravity marks 
all the older articles as read and the number you asked it to start with should appear in the 
Server column of the newsgroup pane.    By default, Gravity is configured to automatically 
retrieve headers after subscribing to a group.    You will see Gravity create a job to ask the 
server how many articles are available, which will be reflected in the Server column and then 
Gravity will transfer the headers from the server to local storage and the Local column will be 
updated with the total that was successfully transferred.



Lesson Four - Retrieving Headers and Reading Articles

{button Previous Lesson,JI(`GRAVITY.HLP',`Lesson_Three_Subscribing_To_A_Newsgroup')}          
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If you performed the steps in the last lesson you should now be subscribed to the newsgroup 
news.announce.newusers.    In its default configuration, Gravity will automatically retrieve the headers 
for a newsgroup when you first subscribe to it, so just as soon as you close the Subscribe window 
Gravity will begin fetching headers.

After Gravity initially retrieves headers, you can fetch more using any of the following techniques:

· Choose Retrieve Headers from the Server menu to retrieve the headers for all subscribed groups

· Select Retrieve Headers from the Newsgroup menu to get the headers for selected newsgroups.

· Right-click one or more groups and select Retrieve Headers from the pop-up menu.

· If there are no local unread headers in a group, opening it will cause Gravity fetch its headers.    If 
you checked the “Open newsgroup with a single click” option in the Operation tab of the Global 
Options dialog box, a single click will cause the headers to be fetched.

· You can configure Gravity to retrieve headers for all subscribed groups on a server under 
Server/Properties/Operation.    That setting also lets you specify how frequently Gravity will check 
for new headers and retrieve them.

· If you ever want to retrieve headers from the server that are older than the first article you retrieved 
when you subscribed, you can go into Newsgroup/Properties/General and adjust the Highest 
Read Server Article.

When Gravity is fetching headers, it shows one job on the left of the status bar and a progress bar on 
the right.    When it has retrieved all of the headers, the thread pane will show the newly retrieved 
items.

Double-click the first header in the thread pane to read it.    Gravity will fetch the body from the server 
and display it in the article pane.    You should now have data in each of the three panes.    In Lesson 
Five, you will learn how to adjust the display more to your liking.



Lesson Five - Adjusting the Display
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1. To adjust the fonts, right-click the newsgroup pane and select the Properties command from the 
pop-up menu. 

In the Properties dialog box, the “Highest read server article” section includes a low number on 
the left of the slider, which is the lowest article number available at the server.    The high number 
on the right is the number of the highest article read.    If you slide the slider to the left, Gravity 
marks items in the range as unread.

2. Click the Font/Color button.    Select a different color if you like, such as Navy.    Select a font that 
is easy to read and a reasonable size for your display (10 or 11 is usually pretty good).

3. Click the OK button to exit the Font dialog.    Click the OK button again to exit and save the 
newsgroup properties.

Notice how the newsgroup pane changes to reflect the choices you have made.

4. Click the right mouse button in the thread pane (the one that lists the subjects of the available 
articles), then select the Properties command from the pop-up menu.    Click the Font/Color 
button and change the color and font for the threaded items.    Then click the OK button.

5. Click the right mouse button in the article pane and select the Properties command from the pop-
up menu.    You see the Article Layout tab, which lets you pick which headers appear in the article 
pane and lets you control the font and color for each header.

The list of headers is divided into two groups.    The left-hand list includes those not currently used 
in the article display.    The right-hand column lists those currently being used.    Gravity initially 
includes Subject, From, Reply-To, Newsgroups, Followup-To, A Blank Line, and The Body.    
Remove Reply-To, Newsgroups, and Followup-To to simplify the display.    Select them with the 
mouse and click the Remove button to move them back into the list on the left.

6. Click Subject and then click the Font/Color button to change the font.    Make the font 12 point 
and bold (keep the color red if you like). 

7. Click From and make the font 12 point, but not bold. 

8. Click Body and change the font to Courier New 11 point.

NOTE: We recommend using fixed point fonts rather than proportional ones for viewing the body 
for several reasons—the main one being that you will have a better chance of seeing each article 
as the original author intended it. 

9. Click the Font/Color button in the Quoted text section and change to 12 points and blue.

10. If the article is no longer showing in the article pane, double-click an article to see the changes 
you have made.    Notice the new fonts and colors.

NOTE:    In news.announce.newusers there are probably no replies, so you will not see the changes for the quoted 
text until you read other groups.



Lesson Six - Working with Binary Images
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1. Subscribe to a binary group such as alt.binaries.pictures.animals. 

You usually have a good indication which items are images by the number of lines. 

2. Choose one that you think is an image and press the V key to view it.    The image(s) will be 
decoded, and the Image Gallery will open automatically with the image displayed.

NOTE:    You can open the Image Gallery at any time by clicking the Image Gallery toolbar button.

In general, you can choose an article with an image in it, then press the V key to view the image. 
You can also select a bunch of images to decode or view all at once.    If you select a range of 
articles then press the V key, Gravity sends all of the images to the Image Factory.    The Image 
Factory is a tool that lets you control the order of decode jobs and also lets you easily remove 
decoded images after you have viewed them.

If you want to decode items but do not want to view them, press Ctrl-D and Gravity decodes the 
articles and places them in the directory you specified on the Decoding tab of the Global Options 
dialog box.

About binary images

Gravity can fetch, decode, and view binary images.    When you choose Decode (Ctrl-D) or View (V) on 
the main window, Gravity checks to see if all of the headers in all parts of the image are available.    If 
so, Gravity creates an entry in the Image Factory list of queued jobs and marks the article in the status 
column with an hourglass symbol to indicate it is trying to decode the image: . 

The Image Factory fetches each part of an image, assembles the parts, applies the proper decoding, and 
if you asked to view the image, launches the Image Gallery to display the image.    If not all of the parts 
are available, Gravity indicates that the decode process failed with a special status indicator: .

After an image has been successfully decoded, the status indicator changes from the hourglass to the 
image symbol: .

WARNING!    Do not subscribe to a binary newsgroup, no matter how innocuous the title, if you are not prepared to 
be confronted with images that might disgust or offend you. There is absolutely no authority over what people can 
post to these groups.



Lesson Seven - Techniques for Off-line Reading

{button Previous Lesson,JI(`GRAVITY.HLP',`Lesson_Six_Working_With_Binary_Images')}          {button 
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Off-line reading means reading articles when you are not connected to the news server.    To do this, 
you must have the body in the local Gravity database. 

Gravity downloads the headers to your hard disk when you retrieve headers for a newsgroup.    Each 
time you double-click a header to read the article, Gravity asks the news server for the body and 
places it in the article pane.    As you move to the next article, Gravity throws away the current body to 
make room for the next.    This conserves space, but is not ideal for off-line reading. When you read off-
line, you have other considerations—namely that you want to minimize the time you stay connected.

See Also:

Storing Bodies for Retrieved Articles 

Tagging and Retrieving 

Moving from Local Body to Local Body 

Catching Up And Tagging 

Using the Watch Command 

Display Filters and Off-line Reading 



Storing Bodies for Retrieved Articles

If you want to store articles that you have retrieved for reading, select the “Store all bodies retrieved” 
for reading check box in the Storage tab of the Global Options dialog box.    This allows you to read a 
previously read article without going back online to retrieve it.    Keep in mind that this setting may 
significantly increase the amount of disk space used and that you may need to adjust the purge 
settings to remove read articles more frequently. 



Tagging and Retrieving

You can selectively retrieve article bodies using the tag and retrieve technique. 

1. To tag an article for retrieval, press the T (or tag) key. 

You see a small yellow tag in the status column in the thread pane.    Move through your groups 
and tag the articles you want to be retrieved.

2. Once you connect, use the Retrieve Tagged Articles (Ctrl+Shift+R) command to retrieve all of 
your headers. 

You can also choose the Retrieve tagged articles upon connecting option in the Operation tab in 
the Global Options dialog box if you always want to retrieve tagged articles.

Once you have retrieved the articles, a little red right arrow  appears next to the body to indicate that 
the body is now in the database.



Moving from Local Body to Local Body

From the Navigate menu, choose the View Next Unread Local command to go to the next local unread 
body.    This command is useful for quickly reading through items you have retrieved.    You can also 
create a view filter that shows only local articles.    Lesson eight covers view filters.    You should also 
check out the various online and offline settings available under Global Options/Navigation.



Catching Up And Tagging

You can choose not to mark tagged articles as read when catching up.    (Check the appropriate option 
on the Preferences tab).    Use this with the Open the next newsgroup after catching up option.    
That way, you can read articles in two passes.    First, you connect and retrieve all of the headers for all 
of your subscribed groups and disconnect.    You visit each one, tag the articles you want to read and 
catch the group up (which will cause the next group to load).    Next, you connect and retrieve all of 
your tagged headers. 

Alternatively, you could use the Mark all articles as Read when retrieving new headers option (on the 
Preferences tab) to avoid having to catch up each group.    Use this option only with the Do not mark 
tagged items as Read when catching up option.



Using the Watch Command

One handy off-line reading command is the Watch (W) command.    When you press the W key, Gravity 
goes through each article in the thread and puts its message-id and the message-id for all of its 
ancestors in the Watch List. 

Gravity also tags each article in the thread for retrieval, and if you are already on-line, goes ahead and 
fetches the articles.    Use the Watch command to retrieve article bodies you are interested in—if you’re 
interested in one article, you are probably interested in the entire thread.    Also, you can compose 
other rules that retrieve bodies, including special rules to get images of your favorite models and so 
forth.



Display Filters and Off-line Reading

You can use display filters to facilitate certain off-line operations, since one of the attributes you can 
filter on is the Local attribute.    Thus, you can create a filter that shows only unread local articles.    You 
could then use the space bar to quickly read through each group.    See Lesson Eight - Using Display 
Filters  for more information.



Lesson Eight - Using Display Filters 
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Gravity includes the Filter Bar, which greatly enhances the way you can look at the headers within 
newsgroups (formerly you could only look at combinations of new, read and important articles). 

See Also:

Using Gravity's Pre-Defined Filters 

Defining Your Own Filters

Linking a Filter to a Newsgroup 



Using Gravity's Pre-Defined Filters

Gravity comes with a number of pre-defined filters, but you can define your own as well.    To apply the 
display filters, select the one you want from the filter bar (pictured below).    When you select a display 
filter, Gravity examines each header to see if it matches the filter, and if so, displays it.



Defining Your Own Filters

Filters become even more powerful when you define your own. For example, you can define a filter 
that shows all unread articles that have not been decoded. 

1. Click the Filters button on the Filter Bar.    You can also choose Define Display Filter from the 
Newsgroups menu. 

You should see the following dialog:

2. Click the New button to create a new display filter.
You see the following filter definition dialog:

3. In the Name field, type Undecoded, descending line count. 
4. Click twice on the Unread check box and once on the Decoded check box so that the caption 

below reads “Unread articles that are not decoded.”

5. Use the drop down list box to select “Sort Articles by Line Count” and then click on the “Sort 
Descending” radio button.

You can also add Rule Conditions to your filtering by clicking on the Advanced button.    But, for 
this tutorial, we will keep things simple.

5. Click the OK button to save the new filter.    Click the OK button again to exit the Define Display 
Filter dialog box.

Each attribute you can filter can have one of three values: 

· If the checkbox is disabled (grayed), then Gravity ignores this attribute in the filter. Thus, when 
you open the dialog, all items are grayed and the filter matches “All Articles.” 



· If a box is checked, an article must have the indicated attribute to match.

· If a box is cleared, then an article must not have the attribute in order to match. 

Try defining another filter, “Local Unread,” to display all articles stored locally that haven’t been 
read yet.

NOTE:    You can reposition the Filter Bar by dragging it with your mouse.    You can also float it so that it is not 
docked to the top or bottom of the Gravity main window.



Linking A Filter To A Newsgroup

Each newsgroup can have its own display filter.    To link a display filter to a newsgroup, open the group 
and then click on the Link button on the filter bar.    You can also set the linked filter on the newsgroup 
property sheet (Newsgroup/Properties).



Lesson Nine - Composing Articles and Replies
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In this lesson, you post a new article to alt.test (a test newsgroup that should be used whenever you 
want to test posting), and a follow up response to someone else’s post.

Be sure you have subscribed to the alt.test newsgroup and opened it. Then follow the steps below:

1. Press the P key (Post).    You will see a posting window similar to the one below:

Notice that the Newsgroups header field is already filled in with alt.test.
2. Enter a subject and article text. 

In the Subject window, type testing, please ignore, press the Tab key, then type testing the 
body into the body of the article.    If you defined a default signature it appears in the article body.
3. Click the right mouse button in the Attachments window and select the Add Attachment 
command. 

4. Use the Choose Attachment dialog to pick a reasonable sized attachment (such as c:\config.sys). 

NOTE: To control attachment encoding, choose the Global Options command from the View 
menu, then choose the Encoding tab before adding any attachments.    Choose the MIME option if 
you want to use MIME as your encoding type instead of UUENCODING.    Then all attachments 
use the encoding type.    If you use the default settings on the Encoding tab, Gravity starts with an 
introductory article, followed by 64k parts until the complete attachment is posted.    Many people 
like to change these settings so that there is no separate introduction and attachments do not get 
broken apart.

5. Add a second attachment if you like. 

6. Click the Send button or press Ctrl-Enter to send the new post. 

When you send an article, Gravity places the article in the outbox.    Gravity monitors the outbox 
for outgoing items, and if you are connected to the news server, it transmits them.

7. To see the outbox, click the Outbox Bar. 

You see one or more parts of the article.    As soon as you send an article or reply, the icon on the 



left changes to a check mark and you see the time that the article was sent under the Sent 
column.    If you are off-line when you send a message, Gravity sends the item next time you 
connect to the server.

8. Now that you have posted an article, send a follow-up to someone else’s post.    Look for an article 
that is fairly short—less than 20 lines.    Open the article by double-clicking on it.

9. Select a portion of the message with your mouse and press the F (Follow Up) key. 

Gravity quotes the selected part of the article instead of the entire thing.    If you follow up to a lot 
of articles, this saves you lots of time.    Most of the time you only want to reply to specific parts of 
an article and it is good etiquette not to over-quote the article you are replying to.

10. Type a response.

Notice you can now select the CC to Author check box.    This lets you simultaneously send an e-
mail message to the author in case they do not read news frequently.    Aside from that, following 
up is exactly like posting an article.    Remember that the article is going into the newsgroup and is 
a part of the thread you are discussing.    If you want to send a copy to yourself, check the CC to 
self checkbox.

11. To compose an e-mail response directly to an author without a corresponding post to the 
newsgroup, press the R (Reply) key.



Lesson Ten - Rule System Overview
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First and foremost, Gravity was designed to help you cut through the clutter of day-to-day newsgroup 
reading.    That is why the Gravity rule system is such an integral part of its design. This section 
explains what rules are, when they are applied, and more generally, how all of the various rule system 
parts relate.

See Also:

What Are Rules? 
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What Parts of Gravity Make Up the Rule System? How Are They All Related? 



What are Rules?

A rule specifies a condition and an action to apply when the condition is met.    Within Gravity you use 
rules to accomplish tasks for you automatically. 



When are Rule Conditions Applied?

Rules conditions are applied at one of two times. 

· If you enable a rule, then Gravity applies its condition to the headers as they come in. If the rule 
has a condition that applies to the body, Gravity applies it when the body arrives.

· You can also apply a rule manually, either to a newsgroup or to selected articles. Use the Apply a 
Rule Manually dialog or the rule bar to do so.



What Parts of Gravity Make up the Rule System? How are They all Related?

The following table summarizes all of the parts of Gravity that are related to rules and indicates when 
they should be used.

Important 
Words

Important Words are phrases you want Gravity to call to 
your attention.    Although the default action for the 
Important Words rule is to mark the article as Important, 
you can change the action to automatically retrieve the 
article.

Watch Thread 
Command

Use the Watch Thread command (W) to automatically 
retrieve all articles in a thread.    When you are reading 
an article and choose Watch Thread, Gravity looks at 
each article within the thread and adds all of its 
references (ancestor message-ids) to the Watch List.    
It then applies the Watch Rule to each article.    Gravity 
then fetches the articles (or tags them retrieval if off-
line) and automatically retrieves any article in the future 
that belongs to the thread. 

NOTE:    Use the Watch List dialog to control this behavior. 
One setting controls how many days can elapse between the 
time an article in the thread was last seen and when the 
thread is removed from the Watch List.    The other setting 
controls whether articles with identical subjects but not related 
message-ids are treated as belonging to the same thread.

Ignore Thread 
Command

The Ignore Thread (I) command is similar to the Watch 
Thread command.    Use Ignore Thread to automatically 
mark as Read all articles in a thread.    When you are 
reading an article and choose Ignore Thread, Gravity 
looks at each article within the thread and adds all of its 
references (ancestor message-ids) into the Ignore List. 
It then applies the Ignore Rule to each of the articles in 
the thread.    Gravity marks the articles as read and 
removes them from the display and automatically marks 
any article in the future that belongs to the thread 
marked as Read.

NOTE:    Use the Ignore List dialog to control this behavior.    
One setting controls how many days can elapse between the 
time an article in the thread was last seen and when the 
thread is removed from the Ignore List.    The other setting 
controls whether articles with identical subjects but not related 
message-ids are treated as belonging to the same thread.

Rules Dialog Use the Rules dialog box to create rules, enable and 
disable them, or import and export them.    Use the 
Newsgroups tab to specify which groups the rule 
applies to.    Use the Conditions tab to specify the 
conditions that an article must meet.    Use the Actions 
tab to specify the actions to be taken if the article 
matches the rule.

Apply a Rule 
Manually

If you enable a rule, its conditions are applied to 
incoming headers.    If you want to apply rules to a 
group or selected articles, use the Apply a Rule 
Manually command.    When you choose this command, 



Gravity evaluates each article to see if it matches the 
condition, and if so, applies the actions for the rule.

Rule Bar Use the Rule Bar to apply rules manually.    Select the 
rule you want, then click the Run button. 

Watch List The Watch List is a list of threads Gravity is currently 
watching.    The Watch Rule tests articles to see if one 
of its ancestors is in the Watch List, and if so, applies 
the specified actions (“Retrieve body” and “Add to 
Watch list” are the default actions) to the article.

Ignore List The Ignore List is a list of threads Gravity is currently 
watching.    The Ignore Rule tests articles to see if one 
of its ancestors is in the Ignore List, and if so, applies 
the specified actions (“Mark as Read” and “Add to 
Ignore list” are the default actions) to the article.

Rule Statistics 
Dialog

The Rule Statistics dialog monitors which rules are 
running and how much processing time they are taking 
up.    It shows the total number of headers examined in 
this session, the number of times the actions were fired, 
and the total percentage of rule time spent in the rule.

Example Rules Gravity includes a few example rules, including the 
“Ignore the spam!” rule, and the “User-specified word 
in subject” rule.    Use these rules as models for your 
own rules, or modify them, as you like.



Lesson Eleven - Composing Your First Rule
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Lesson Ten reviews Gravity’s rule system. Now you can compose a rule of your own. For example, 
you can create a rule that marks all articles older than five days old as Read. Suppose you return from 
vacation and articles have piled up in certain newsgroups. Rather than trying to wade through all of 
them, run this new rule to reduce your workload.

1. Click the Rules button  or choose the Rules command from the Tools menu.

2. In the Rules dialog box, add a new rule.
Click the Add button, type a name for the rule, such as Recentize, then click the OK button. 

3. Choose or change settings in the Edit Rule dialog box. 
Newsgroups tab: Specify which newsgroups the rule will apply to. If you want to run this rule 

manually, don’t change the default Rule applies to all newsgroups setting.
Conditions tab: Click the Article was posted more than XX days ago option, then enter 5 for the 
number of days.    Click the Add Condition button to see “Posted > 5 days ago” in the condition 
window.

Actions tab: Click the Mark as Read check box to mark any articles posted more than 5 days ago 
as Read.    Click the OK button to see your new Recentize rule in the list of rules.    The Apply to 
Incoming option is set to No.    This means you don’t want to run the rule on incoming headers, 
but only manually on newsgroups or articles you choose.

NOTE:    You can manually run a rule on a newsgroup at any time even if the rule is not enabled or if the 
newsgroup is not listed in the Rules dialog box.    These settings only affect whether the rule should be 
automatically applied to incoming headers.

To define a more complicated rule, see Images Rule.



Images Rule

This rule removes all articles that contain compressed .zip files, .exe files, or articles with less than 100 
lines.    The intention is to end up with only JPEG and GIF images. 

1. From the Tools menu, choose the Rules command.

2. In the Rules dialog box, click the Add button and type Kill Small, Zip, and Exe.

3. In the Newsgroups tab, pick some binary newsgroups you want to apply this rule to.

4. In the Conditions tab, change the conditions.

In the Article Subject does contain phrase edit box, type .zip|.exe where | is the vertical bar. 
Check the Regular Expression box, then click the Add Condition button.    The ‘|’ character is a 
regular expression character that means either the first expression OR the second one.    In other 
words, if the article subject contains either “.zip” or .exe”.

5. Click the OR button on the left-hand side of the condition box.

6. Click the ( button (left parenthesis).

7. Click the Not button.

8. Choose the Article has more than option, type 100, then click the Add Condition button. 

9. Click the ) button (right parenthesis) to complete the expression.

The condition should appear as below:

The condition translates to: “If the subject contains .zip or .exe, or the article has less than 100 
lines.” 

10. To finish the rule then click the Action tab and choose the Mark as Read option again.    Click the 
OK button to save the rule.

This rule is quite handy to cut out junk from binary groups such as alt.binaries.pictures.animals.



Lesson Twelve - Applying Rules Manually
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In this lesson, you run a rule manually, then tweak the rule a little and re-run it. 

1. Open a newsgroup so that the headers are displayed in the article pane.

2. Look for an article or two that look interesting and note a keyword that seems interesting.

3. Click the Rule Bar, select the “User-specified word in subject” rule, and then click the Run button.

This rule demonstrates that rules can have substitution conditions.    When you click the Run 
button, Gravity asks you to type in the parameter the rule is asking for.    In this case, it is a word 
or phrase that you want to look for.

4. Type the word or phrase you noted in step 2.    Gravity runs through all of the headers and marks 
the ones that match as Important.

5. Click on the Filter Bar and choose the Show Important (Unread) filter option.    Now you see only 
the items that you were looking for when you ran the rule manually.

6. Re-select whatever display filter you were using before, such as “Unread Articles.”

Now that you have seen this rule and what it can do, let’s create a new rule based on this one:

1. From the Tools menu, choose the Rules command.

2. In the Rules dialog box, select the “User-specified word in subject” rule.

3. Click the Copy button to copy the rule.

4. Type Retrieve Interesting Articles as the name of the new rule.

5. Click the Edit button to edit your new rule.

6. Choose the Actions tab and select the Retrieve Body option.

7. Click the OK button to save the rule, then click the OK button again to exit the Rules dialog.

8. Select your new rule from the rule bar and run it.

This time Gravity retrieves all of the items that have the word or phrase you supply.    If you are not on-
line they will be tagged for later retrieval.





News Server Nickname

You can give the news server a nickname, for example “Microsoft” as opposed to 
“msnews.microsoft.com.”    In addition to being easier to read, this allows you to break your groups up 
into pseudo servers such as “SuperNews    - Non-Binary Groups” and “Supernews – Binary Groups.”    
This allows you to use different settings and manage the disparate groups as if they were located on 
different servers.

Note: The news server nickname is mapped directly onto a Windows folder (directory), so each 
nickname that you choose must be unique.    If you omit the news server address, Gravity will try to 
connect using the nickname.



Updating the Server Counts

You can update the number of unread articles at the server to see if there are new articles to be 
retrieved.

To Update the Server Counts

Select the Update the Server Counts command from the Server menu.

You can also tell Gravity to update the server counts upon startup.    For more information, see 
Changing Your Automatic Retrieval and Group Settings.



Retrieving Headers For All Subscribed Newsgroups

You can tell Gravity to retrieve headers for all subscribed newsgroups.

To Retrieve Headers

Select the Retrieve Headers command from the Server menu.

You can also tell Gravity to retrieve the headers for all subscribed newsgroups at a prescribed interval. 
For more information, see Changing Your Automatic Retrieval and Group Settings.



Retrieving Tagged Articles For All Subscribed Newsgroups

You can retrieve bodies for tagged headers after connecting to the news server.

To Retrieve Tagged Articles

Select the Retrieve Tagged Articles command from the Server menu.

You can also tell Gravity to retrieve the headers for all subscribed newsgroups at a prescribed interval. 
For more information, see Changing Your Automatic Retrieval and Group Settings.



Removing Servers

You can get rid of a server that you will not use at any time.

To Remove a Server

1. Select the Add/Remove command from the Server menu.

2. Select the server to be deleted.

3. Click on the Remove button.



Advanced Posting Properties

You can set advanced posting properties for a server.

To Set a Per-Server Reply-To Address

1. Select the Properties command from the Server menu.

2. Choose the Posting tab.

3. You can specify a Reply-To address particular to this server by specifying one in the “Reply to” 
field.

Message-ID Generation

1. Select the Properties command from the Server menu.

2. Choose the Posting tab.

3. You can tell Gravity to let the news server create the message-id for posts by un-checking the 
When posting Gravity should generate the message-id for the article option.

Click OK when you are finished adjusting the posting settings.



Server Group Information

The group tab allows you to control when Gravity gets new information about the master list of 
newsgroups on your news server and status information on the groups you are subscribed to.

Get list of new groups upon connecting

When you enable this setting, Gravity will ask the news server for all of the new groups that have been 
added on the server since the last time it checked when it first connects.

Display new groups after retrieval

If you enable this option, Gravity will display the list of new groups that were added since Gravity last 
checked when they are returned from the server.    The groups are presented in the Subscribe dialog 
so that you can subscribe to any that are interesting.

Update server count

· Manually – Only check for new articles in your groups when you ask Gravity to do it.

· Once per session – Only check for new articles in your groups once while Gravity is running 
(upon the first connection to the server).

· Upon connecting – Check for new articles each time a connection is established with the 
server.



Accessing Multiple Servers            

  
 
You can set up Gravity to work with a number of news servers. 

1. From the Server menu, choose the Add/Remove command.

2. To add a server, type in its name, then click on the Add button.

Once a server is added, its name appears in a selectable list in the Servers menu.





Working with Newsgroups            

  
 
A USENET newsgroup is a discussion on a topic between people potentially all over the planet. In 
Gravity, you subscribe to a newsgroup to follow the discussion for a particular topic. You can then read 
articles in the newsgroup and participate in the discussion by submitting follow up articles.

In general, right-click the name of a newsgroup and then choose an option from the pop-up menu, or 
choose an option from the Newsgroup menu.

See Also:

Subscribing to a Newsgroup

Unsubscribing from a Newsgroup

Setting Newsgroup Storage Options 

Selecting Newsgroup Purge Options 

Setting Newsgroup Properties 

Marking All Articles Read



Subscribing to a Newsgroup

1. From the Newsgroup menu, choose the Subscribe command.    You will see the Subscribe to 
Newsgroups dialog box.

2. Scroll through the list looking for a newsgroup that interests you.    Or, type a word such as 
“motorcycle” to narrow the list to those groups that have the letters you have typed.

3. Double-click the newsgroup you want and click the Add button or select the newsgroup and press 
the Enter key.

You can make multiple selections in the Selected Groups window by using the Shift and Ctrl 
(Control) key.    To select a block of newsgroups, click on the top entry of the block and, while 
pressing the Shift key, click on the last entry of the block.    All the newsgroups between the top 
and bottom entries will be highlighted.

The Ctrl key lets you select multiple entries from different parts of the list.

4. Choose whether or not you want to sample the newsgroup by selecting the Sample check box.    
When you sample a newsgroup, it is automatically removed from the list of subscribed newsgroups 
at the end of the Gravity session or when you switch to a different server.

5. Specify a value for the Storage Mode.    For more information, see Setting Newsgroup Specific 
Storage Options.

6. Provide the number of headers that Gravity should Go Back.    If a newsgroup is large, you may not 
want to download all the header, but rather a portion of the headers.    You can specify a number 
for Gravity to retrieve.

7. Click the Done button when you are finished selecting groups. 

Tips

· If you want to delete a newsgroup from the Selected Groups list, select the group and press the 
Delete key.

· You can tell how many available newsgroups match your pattern by examining the numbers above 
the list. For example, 11/15845 would indicate that your search string matched 11 of 15845 
newsgroups in the list.



Unsubscribing from a Newsgroup

1. Select one or more newsgroups that you want to unsubscribe from by selecting them with the 
mouse.

2. Right-click and select the Unsubscribe command or choose the Unsubscribe command from the 
Newsgroup menu.

3. Confirm that you want to remove the group(s).

NOTE:    Once you unsubscribe from a newsgroup, Gravity removes all articles in your local database to save 
space. If you decide to re-subscribe to the group later, Gravity recreates all settings for the group.



Retrieving Article Headers For a Specific Newsgroup

During a Gravity session, you can find out if there are new articles posted to a newsgroup by selecting 
the Update Server Counts command from the Server menu.    If the number of articles listed in the 
Server column of the Newsgroup Pane exceeds zero, then there are article headers to be retrieved.

You can either retrieve all the articles headers for all the newsgroups that you are subscribed to (using 
the Retrieve All Headers command in the Server menu) or retrieve the headers for a specific 
newsgroup.

To Retrieve Headers

1. Highlight the newsgroup that you want.

2. Select the Retrieve Headers command from the Newsgroup menu or click on the Retrieve 
Headers button in the toolbar.



Keeping Sampled Newsgroups

If you want preview a newsgroup before subscribing to it permanently, you can sample it using the 
Sample check box in the Subscribe dialog.    When you sample a newsgroup, it is automatically 
removed from the list of subscribed newsgroups at the end of the Gravity session or when you switch 
to a different server.

To Keep All Sampled Newsgroups

To avoid the automatic removal of all the newsgroups that you are sampling, select the Keep All 
Sampled Newsgroups command in the File menu.

To Keep an Individual Sampled Newsgroup

To avoid the automatic removal of a newsgroup that you are sampling, select the newsgroup in the 
newsgroup pane and then select the Newsgroup/Properties command.    Uncheck the “Sample this 
group” option.



Retrieving New Newsgroups

There are well over 20,000 newsgroups to which you can subscribe.    And new ones are created every 
day.

You can retrieve a list of any newsgroups added to the news server since you retrieved the entire list 
when installing Gravity or last used the Get New Groups command.    Note that you can configure 
Gravity to get the new list of groups each time it connects to the news server.    For more information, 
see Changing Your Automatic Retrieval and Group Settings.

To Retrieve New Newsgroups

Select the Get New Groups command from the Newsgroup menu.    If there are new newsgroups, the 
Subscribe to Newsgroups dialog box will appear with all the new groups listed in the Available Groups 
list.    You can subscribe to any of the newsgroups at this time.    For more information, see Subscribing 
to a Newsgroup.



Retrieving the Entire List of Newsgroups

You can retrieve the entire list of newsgroups again.    When you do so, the current list of newsgroups 
is replaced with the list currently available on the news server.

This feature is helpful if you decide to retrieve an entirely new list once in a while rather than retrieve 
new newsgroups more periodically.

To Retrieve New Newsgroups

Select the Re-read All Groups command from the Newsgroup menu.    After the new newsgroups are 
retrieved, the Subscribe to Newsgroups dialog box will appear.    You can subscribe to a newsgroup 
using the new list at this time.    For more information, see Subscribing to a Newsgroup.



Sorting Articles in a Newsgroup

You can sort the articles in a newsgroup to more effectively get the information that you want.

To Sort Articles in a Newsgroup

Click the column headings in the Thread Pane to sort by a particular column (e.g. click on the Date 
head to sort from the newest to the oldest article).    Click on the head again the reverse the order (from 
oldest to newest).

OR

1. Select the Sort By command in the Newsgroup menu.

2. Choose an item to sort by, either Author, Status, Subject, Line Count, or Date.

3. Choose the order for the list, either ascending (A to Z, 1 to 10) or descending (Z to A, 10 to 1).

4. When you are finished, click on the OK button.

Note: To set the sorting for a newsgroup permanently, you will need to work with Display Filters.    See 
Lesson Eight - Using Display Filters or Overview of Display Filtering for more information.



Setting Newsgroup Specific Storage Options

1. Select the newsgroup you want to modify, then choose the Properties command from the 
Newsgroup menu or right-click the group and select the Properties command from the pop-up 
menu. 

2. If you want to automatically retrieve and store bodies for the newsgroup, make sure that Retrieve 
and store article bodies is checked.

NOTE:    For a complete explanation of these options, see Overview of Storage Options .



Selecting Newsgroup Specific Purge Options

Each newsgroup can have its own purge options.    Use the Purging tab on the Global Options property 
sheet to set default purge settings for all of your groups.    To override the global settings and set ones 
specific for a newsgroup:

To Set the Purge Options

1. Select the newsgroup you want to modify, then choose the Properties command from the 
Newsgroup menu or right-click the newsgroup and select the Properties command from the pop-up 
menu.

2. Click the Purge tab.

3. Check the “Override global purge settings” box. 

4. Gravity lets you specify what to purge from its database.    You can purge read and unread articles, 
and specify how old an article must be before it is purged.    The “age” of an article is measured in 
days since it was retrieved from the news server.

5. Gravity lets you specify when to perform purging operations.    You can “Purge when retrieving 
headers once every X days”, where X is a number of days that you specify. If you specify 0 for the 
number of days, Gravity purges every time you retrieve headers.

6. You can compact the Gravity database files after some information has been purged from those 
files.    Gravity allows you to specify whether to compact its database files, and how often the 
compaction should take place.

7. When you are finished, click on the OK button.



Specifying Newsgroup Overrides

You can choose newsgroup-specific overrides that supercede the settings in the Gravity Options 
screen.    These overrides give you more flexibility when working with multiple newsgroups that you 
want to treat differently (for example, you want responses from your post to go one e-mail address 
versus another).

To Set the Newsgroup Overrides

1. Select the Properties command from the Newsgroup menu.

2. Choose the Overrides tab.

3. If you want to specify a maximum number of headers to retrieve at a time, enable Override 
download limit and type in the number of headers you want retrieved each time.

4. If you want decoded items from a newsgroup saved to specific directory, select the Override 
decode directory check box, then provide a directory in the Decode directory field.

5. If you want e-mail responses from a newsgroup to go to a specific e-mail address, choose the 
Override E-mail address check box, then provide an e-mail address in the E-mail address field.

6. If you want a different full name attached to a post or e-mail message, choose the Override full 
name check box, then provide a name in the Full Name field.

7. If you want specify custom headers for a newsgroup, choose the Override custom headers check 
box, then provide the headers in the Custom headers field.

8. When you are finished, click on the OK button.



Default Newsgroup Filter

You can specify a default display filter for each newsgroup:

To Set a Default Display Filter for a Newsgroup

1. Select the newsgroup in the newsgroup pane.

2. Select Newsgroup/Properties

3. Click on the Filter tab.

4. Select a filter that you want applied when you open the newsgroup.

5. When you are finished, click the OK button.



Setting Newsgroup Properties

There are a number of newsgroup settings that can be customized on a per-group basis.

To Set the Properties for a Newsgroup

1. Select the newsgroup you want to modify, then choose the Properties command from the 
Newsgroup menu or right-click the group and select Properties from the pop-up menu.

2. Select the General tab, if it isn’t already selected.

3. Give the newsgroup a nickname for easy identification.    Type in the nickname in the Group 
nickname field.

4. If you don’t want the headers to be retrieved automatically when headers are retrieved from the 
server, enable Do not automatically retrieve headers for this group.

5. Specify whether or not you want to sample the newsgroup by selecting the Sample this group 
(unsubscribe when exiting) check box.    When you sample a newsgroup, it is automatically 
removed from the list of subscribed newsgroups at the end of the Gravity session or when you 
switch to a different server.

6. If you want all bodies to be retrieved automatically for the newsgroup, make sure the Retrieve and 
store article bodies check box is selected (it will force the Store article headers check box to be 
checked also).

7. By default, Gravity starts reading the last 1000 articles in a newsgroup.    If you have browsed 
these articles and you want to reach back further, you can adjust the Highest read server article.    
The number on the left of the slider represents the lowest article number available on the server, 
and the number on the right represents the highest available at the server that has not been read. 
You can unread items by sliding the slider bar to the left as much as desired. 

8. To configure the fonts used in the newsgroup pane, click the Fonts/Color button.

9. To restore the newsgroup pane fonts to their original configuration, click the Use Default button.

10. To set the background color for the newsgroup pane, click the Background button and select a 
color.

11. To override the default purge settings and control how articles are purged for the selected 
newsgroup, see Newsgroup Purge Options.

12. Specify any additional newsgroup overrides.    For more information, see Specifying Newsgroup 
Overrides.

13. When you are finished, click on the OK button.



Marking All Articles As Read (Catch Up)

If you are not interested in any of the articles in the newsgroup, you can quickly mark all articles in the 
group as read. 

1. Select the newsgroup, then select the Mark As Read (Catch Up) command from the Newsgroup 
menu or right-click the newsgroup and select the Mark as Read (Catch Up) command from the 
pop-up menu.

2. Click the Yes button to confirm you want to mark the articles as read.





Articles Overview            

  
 
In Gravity, you read the articles posted to newsgroups and perhaps contribute some of your own. 
Articles include headers and bodies.

Headers

A header is a list of summary fields for a particular article—just enough so that you can figure out if you 
want to read the article. The main header fields include the subject of the article, who the article is 
from, the date it was sent, the number of lines of text in the body, and perhaps a list of articles that it 
refers to.

Bodies

Bodies contain the actual text of an article, and can range from a few lines to many thousands of lines. 
Additionally, when Gravity retrieves an article body, it also retrieves a complete list of the headers 
available for the article.

See Also:

Tagging and Retrieving Articles (Off-line Operation) 

Decoding Attached Files And Images 

Posting News Articles

Following Up - Sending your Reply to the Whole Newsgroup 

Replying to an Article by e-mail

Navigating with the Spacebar 

Mailing Articles to Friends 

Saving Articles to a File 



Tagging and Retrieving Articles (Off-line Operation)

To tag and retrieve articles from the news server (so that both the header and the body reside locally):

1. Select an article in the thread pane.    You can use the Shift and Ctrl keys to extend selection.

2. Tag articles for later retrieval by pressing the T shortcut key or by selecting Tag Selected for 
Retrieval from the Article menu.    The articles remain tagged until you retrieve or untag them.    
Thus, you can tag articles in several groups and retrieve them all at once.

3. Select Retrieve Tagged Headers from the File menu or press Ctrl+Shft+R to retrieve the tagged 
articles.



Decoding Attached Files and Images

1. Select an article in the thread pane.    You can use the Shift and Ctrl keys to extend selection.    
You only have to select one part of an article to decode it.

2. Click the Decode toolbar button or right-click in the thread pane and select the Decode Selected 
Articles command.

3. To decode the article in the article pane, right-click it and choose the Decode command.

You see a little hourglass next to each item you selected for decoding.    When Gravity decodes each 
item, the hourglass changes into a small icon representing a picture.    If Gravity cannot decode the 
article, an X appears next to the article .    If that happens, open the Image Factory to see why Gravity 
couldn’t decode.

Tips

· After decoding, open the Image Gallery (press Ctrl-G) to view the results.

· Automatically display articles that you decode by changing the setting on the Decoding tab of the 
Global Options property sheet.

· Manage the list of queued decode jobs using the Image Factory (ctrl+i)

· The Image Gallery options also affect what happens when you choose the View command within 
Gravity.    Make sure you examine the settings in the Image Gallery.



Posting News Articles

Posting USENET articles sends your thoughts to the world.

To Post a New Article

1. Click the Post toolbar button or select the Post Article command from the Article menu. You can 
also right-click in the thread or article panes and choose the Post command.

2. You see the Posting window with the selected newsgroup in the Newsgroups field.    You can add 
new newsgroups to cross-post the article to more than one group.

3. Select Check Spelling from the Options menu to check the spelling of the message body text.

4. Click the Attach button to add attachments to the article.

5. Click the Advanced Fields buttons to edit advanced fields.    All of the fields are described below:

Newsgroups Specify which newsgroups your newly composed 
article appear in.

Choose Groups From a list of available newsgroups, select the ones 
you want to post to.

CC by Mail To send the contents of your post to someone via e-
mail, enter their e-mail address in this field.

CC to self If you would like to send a copy of your post to your 
email account check this box.

Subject Describe the subject of the article.    Use this field to 
give your article a descriptive title. 

Signature Choose a signature to include at the end of your 
article.

Attachment Pane The Attachment pane (the one with the Name and Size 
headers) allows you to add one or more attachments 
to your post.    You can set attachment options in the 
Encoding property page of the Global Options property 
sheet.    Right-click in the pane to add attachments.

MIME Check this box if you want to use MIME (Multi-purpose 
Internet Mail Extensions) to encode your attachments. 
The default is to use UUENCODE encoding since 
most newsreaders understand it, but MIME is starting 
to catch on.    You should probably leave this alone 
unless you know exactly why you want to use MIME.

Advanced Fields Specify a number of additional fields within your post. 
The rest of the entries in this table describe them.

Distribution The default distribution is worldwide.    If you want to 
somehow limit the distribution of your article to 
something less than that, you can enter a different 



distribution here.

Expires Indicate when the article is supposed to expire.    This 
is useful when, for example, your message is 
advertising an extra ticket to a Broadway play for a 
certain date. 

From The From field identifies you to the readers of the 
newsgroup and to anyone wanting to reply to your post 
via electronic mail.

Follow up-To You can send follow-up articles to your article to other 
newsgroups by listing them, comma separated, in this 
field.

Keywords Enter a keyword to indicate what the message is 
about.

Organization Gravity fills this in based on what you entered in the 
Setup tab, but you can change it for individual posts if 
you like.    For example, if you normally include your 
company name here, but are posting about a bake 
sale at your church, you may want to put your church 
as your organization for the current post.

Reply-To Enter an e-mail address if you want to direct replies to 
your article to a different address than the one in the 
From field.

Sender The e-mail address that the article was sent from, 
which may not be the e-mail address of the message’s 
author, as when you send an article from a friend’s 
account.

Summary Enter a short summary for the article.

Custom headers This field allows you to add headers that are not 
normally added to outgoing posts.



Following Up - Sending your Reply to the Whole Newsgroup

A follow-up is an article response you send to everyone reading the newsgroup.    The follow-up article 
then becomes a part of the thread that the original article belongs to.

To Create a Follow-Up Response to an Article

1. With an article selected or in the article pane, click the Follow Up toolbar button or select the 
Follow Up command from the Article menu.    You can also right-click in the thread or article pane 
and choose the Follow Up command.

2. You see the Follow Up window with the selected newsgroup in the Newsgroups field.    The subject 
contains “Re: <original subject>”.    You can add new newsgroups to cross-post the article to more 
than one group.

3. Select Check Spelling from the Options menu to check the spelling of message body text.

4. You can also click on buttons to edit advanced fields and add attachments to the article. All of the 
fields are described below:

Newsgroups Specify which newsgroups your newly composed 
article appears in.

Choose Groups From a list of available newsgroups, select the ones 
you want to respond to.

CC by Mail You can send a copy of your response via e-mail to 
someone by entering their e-mail address in this field.

CC to Author Check this box to send a copy of your follow-up to the 
author of the original article via e-mail.

CC to self Check this box if you automatically want to send a 
copy of your reply to your own email address.

Subject Describe the subject of the article.    You should use 
this field to give your article a descriptive title. 

Signature Choose a signature to include at the end of your 
article.

Attachment Pane The Attachment pane (the one with the Name and Size 
headers) allows you to add one or more attachments 
to your post.    You can set attachment options in the 
Encoding property page of the Global Options property 
sheet.    Right-click in the pane to add attachments.

MIME Check this box if you want to use MIME (Multi-purpose 
Internet Mail Extensions) to encode your attachments. 
The default is to use UUENCODE encoding since 
most newsreaders understand it, but MIME is starting 
to catch on.    You should probably leave this alone 
unless you know exactly why you want to use MIME.

Advanced Fields Specify a number of additional fields within your post. 



The rest of the entries in this table describe them.

Distribution The default distribution is worldwide.    If you want to 
somehow limit the distribution of your article to 
something less than that, you can enter a different 
distribution here.

Expires Indicate when the article is supposed to expire.    This 
is useful when, for example, your message is 
advertising an extra ticket to a Broadway play for a 
certain date. 

From The From field identifies you to the readers of the 
newsgroup and to anyone wanting to reply to your post 
via electronic mail.

Follow up-To You can send follow-up articles to your article to other 
newsgroups by listing them, comma separated, in this 
field.

Organization Gravity fills this in based on what you entered in the 
Setup tab, but you can change it for individual posts if 
you like.    For example, if you normally include your 
company name here, but are posting about a bake 
sale at your church, you may want to put your church 
as your organization for the current post.

Reply-To Enter an e-mail address if you want to direct replies to 
your article to a different address than the one in the 
From field.

Keywords Enter keywords to indicate what the message is about.

Sender You might use this field if you are sending a response 
from someone else’s account.

Summary Enter a short summary for the article.

Custom Headers This field allows you to add headers that are not 
normally added to outgoing posts.



Replying to an Article by e-mail

A reply is an e-mail response to the author of an article.    A follow-up, by contrast, is an article you send 
to the entire group that becomes part of the original article’s thread.

To Create a Reply Via an E-mail Response to an Article

1. With an article selected or in the article pane, click the e-mail author toolbar button or select the 
Reply command from the Article menu.    You can also right-click in the thread or article panes and 
choose the Reply command.

2. You see the Reply Window with the e-mail address of the article’s author in the To: field. The 
subject contains Re: <original subject>.    You can also edit the article. 

3. Select Check Spelling from the Options menu to check the spelling of the message body text.

4. Click on the available buttons to edit advanced fields and add attachments to your reply. All of the 
fields are described below:

To Identify the e-mail address of the person you are 
replying to.

Subject Describe the subject of the message.    You should use 
this field to give your message a descriptive title. 

Signature Choose a signature to include at the end of your 
article.

Attachment Pane The Attachment pane (the one with the Name and Size 
headers) allows you to add one or more attachments 
to your post.    You can set attachment options in the 
Encoding property page of the Global Options property 
sheet.    Right-click in the pane to add attachments.

MIME Check this box if you want to use MIME (Multi-purpose 
Internet Mail Extensions) to encode your attachments. 
The default is to use UUENCODE encoding since 
most newsreaders understand it, but MIME is starting 
to catch on.    You should probably leave this alone 
unless you know exactly why you want to use MIME.

Advanced Fields Specify a number of additional fields within your post. 
The rest of the entries in this table describe them.

From The From field identifies you to the readers of the 
newsgroup and to anyone wanting to reply to your post 
via electronic mail.

CC To send a carbon copy of the reply to someone else, 
enter his or her e-mail address in this field.

BCC To send a blind carbon copy of your reply to another 
user, enter the other user’s e-mail address in this field. 
A blind carbon copy causes the user in the To: field not 
to know that a copy was sent to the individuals in the 



BCC field.

Keywords Enter keywords to indicate what the message is about.

Reply-To Enter an e-mail address if you want to direct replies to 
your article to a different address than the one in the 
From field.

Sender Indicates you are sending the message on behalf of 
the person in the From field.



Navigating with the Spacebar

Use the Spacebar to easily navigate articles.

· Press the Spacebar when viewing an article to move down one page.

· Press the Spacebar at the end of an article to see the next article. 

If you’ve loaded a large article and you don’t want to page all the way through it, press the D (Down) 
key to see the next message.    Press the U (Up) key to see the previous message.

Note that the behavior of the spacebar when you reach the end of an article is governed by settings on 
the Global Options Navigation tab.



Forwarding Articles

If you see an article that may be interesting to someone else, you can forward it via electronic mail.

To Forward Articles

1. Check that you want to send the article in the article pane.    If not, select a different article in the 
thread pane.

2. From the Article menu, choose the Forward via Mail command.    You can also right-click in the 
article or thread panes and choose Forward.



Saving Articles to a File

1. Select one or more articles in the thread pane.    You can use the Shift and Ctrl keys to extend 
selection.

2. Choose the Save As command from the Article menu or right-click in the article or thread pane and 
choose the Save As command from the pop-up menu.

You will be prompted for a directory and a file name.    If you choose an existing filename, you can 
append to the end of it, overwrite it, or select another name.





Overview of Spell Checking            

  
 
Gravity can automatically spell check your message.    When you see the words the spell checker does 
not recognize, you can correct the word, ignore the word, or add the word to your personal dictionary.

See Also:

Setting Spell-Checking Options 

Spell-Checking Options Dialog

Check-Spelling Dialog

Editing the Dictionary

Dictionary Types

Adding a New Dictionary



Check Spelling Dialog

Use this dialog to specify whether the spell checker should ignore or replace the word it found.

· Add button: Adds the word to the dictionary selected in the “Add words to” list.    Use the Add 
button if a correctly spelled word you use often is reported as a misspelling, such as your family 
name. 

· Add Words To list: Indicates to which dictionary you want to add words when you select the Add 
button.    The “Add words to” list shows all user dictionaries currently open.    Choose the 
Dictionaries button to use the Dictionaries dialog to open or close other dictionaries. 

· Cancel button: Stops spell checking.

· Change button: Replaces with the word in the “Change To” box.    This replaces only this of the 
reported word. If you to replace want this and all following occurrences of the word, select the 
Change All button.

· Change All button: Replaces this and all following occurrences of the reported word with the word 
in the “Change To” box.    If you want to replace only this occurrence of the word, use the Change 
button. 

· Change To box: Contains a word which replaces a misspelled word when you select the Change 
or Change All buttons.    You can enter a word in the Change To box, or you can select a word 
from the Suggestions list.

· Consider Changing box: Contains a word which may be misspelled or otherwise incorrect and 
presents a replacement word.    You can change the word by selecting the Change button or skip it 
by selecting Ignore.    This box is called to "Not in dictionary" when a misspelled word is detected.

· Dictionaries button: Opens the Dictionaries dialog, where you can open or close user dictionaries 
and edit the contents of user dictionaries.

· Ignore button: Skips this occurrence of a misspelled word.    If it finds the same misspelled word 
later, it will be reported.

· Ignore All button: Skips this and all further occurrences of a misspelled word.    You might use this 
button if the word reported as a misspelling is actually spelled correctly.    If the word is one you use 
frequently, you may wish to ignore it permanently by selecting the Add button.

· Lock check-box: Locks the position of the Check Spelling dialog in place.    Normally the Check 
Spelling dialog positions itself to avoid the text it’s checking.    When you check the Lock box, the 
Check Spelling dialog always appears at the last place you positioned it.

· Not in dictionary box: Indicates it detected a misspelled word.    The word is considered 
misspelled because it could not be located in any open dictionaries or was located in an exclude-
type dictionary.    The name of this box changes to “Consider changing" when a word and a 
suggested replacement are displayed.

· Options button: Opens the Options dialog where you can set spelling-checker options.

· Suggest button: Adds a set of suggested replacements for misspelled words to the Suggestions 
list.    This button is enabled only if the “Always suggest” option is disabled.    Each time you select 
the Suggest button, Gravity searches more intensively for replacements.    When it finds all 
possible suggestions, the Suggest button is disabled.

· Suggestions list: Lists suggested replacements for the word reported as misspelled.    If you have 
enabled the “Always suggest” option, you see this list when a misspelled word is reported.    
Otherwise, you see the list when you select the Suggest button.    Select a word in this list to copy 
it to the “Change To” box, where you can substitute it for the misspelled word by pressing the 
Change button.





Editing the Dictionary

Use the Dictionaries Dialog to open and close user dictionaries and to edit the contents of an open 
user dictionary.    The contents of dictionaries are saved in disk files.    You can open some or all of your 
user dictionary files at any time.    Gravity checks only open dictionaries during spell checking.

· Add File button: Select a user dictionary file to open.    You only need to add a dictionary file once. 
If you need to create a new user dictionary, use the New button.    You can also open user 
dictionary files from other applications.

· Add Word button: Adds the current word in the Words list to the selected dictionary.    If you have 
chosen "auto change" or "conditionally change" for the dictionary type, enter a word and a 
replacement, separated by a colon (e.g., "teh:the").    You can only use the Add Word button when 
you type a new word in the edit area of the Words list.    The words you add may contain virtually 
any character, but only words which contain embedded periods should have trailing periods (e.g., 
U.S.A. is OK, but USA. is not).

· Close button: Closes the Dictionaries dialog.

· Delete Word button: Deletes the current word in the Words list from the selected dictionary.    If you 
have chosen "auto change" or "conditionally change" as the dictionary type, enter the word without 
the colon or replacement word.

· Export button: Saves the contents of the selected dictionary to a text file.    You see a dialog where 
you can select the name of the text file to which words in the dictionary will be exported. The words 
are written to the file one per line.    If you have chosen "auto change" or "conditionally change" for 
the dictionary type, Gravity writes the word and its replacement, separated by a colon (e.g., 
"teh:the").

· Files list: Contains the list of open dictionary files.    When you select a file from the list, its contents 
are displayed in the Words list.

· Import button: Adds the words contained in a text file to the selected dictionary.    You see a dialog 
where you can select the text file to be imported.    Each word in the selected file is loaded into the 
dictionary. If the dictionary type is "auto change" or "conditionally change," words in the file must be 
in word:replacement form (e.g., "teh:the").

· Language: Displays the language (e.g., English or French) of the words in the currently selected 
dictionary.

· New button: Creates a new user dictionary file. You see a dialog where you can specify attributes 
of the new dictionary.    See the New Dictionary dialog for details.

· Remove File button: Closes the currently selected dictionary file.    Closed dictionaries are not 
checked during a spelling check. Although the file is closed, it is not deleted.    To open a closed 
dictionary file, choose the Add File button.

· Type: Displays the type or purpose of the selected user dictionary.    The dictionary type indicates 
what will happen if a word is located in the dictionary during a spelling check.

· Words list: Contains the list of words in the selected user dictionary.    If the dictionary type is "auto 
change" or "conditionally change," then the list contains words and their replacements, separated 
by colons.



Spell Checking Options Dialog

Check the following boxes to set spell-checking options in the Spell Checking Options dialog box:

· Ignore Capitalized Words: Ignore any words beginning with a capital letter.    Check this box if the 
text contains many proper names, for example.

· Ignore All-Caps Words: Ignore any words containing all capital letters.    Check this box if the text 
contains many acronyms, for example.

· Ignore Words with Numbers: Ignore any words containing digits, such as "Win95" and "Q4." 
Check this box if the text contains many code-words or other symbols containing digits, for 
example.

· Ignore Words with Mixed Case: Ignore any words containing an unusual mixture of upper- and 
lower-case letters, such as "MicroHouse" and "CapsLock."    Check this box if the text contains 
many variable names or other symbols which use case changes to distinguish words.

· Report Doubled Words: Report any word appearing twice in a row in the Check-Spelling Dialog.

· Case Sensitive: Distinguish between capitalized and non-capitalized words.    For example, 
"canada" is considered different from "Canada", so "canada" would be reported as a misspelling.    
Clear this option to consider "canada" and "Canada" as identical.

· Always Suggest: Display a list of suggested replacements when a misspelled word is reported.    If 
you clear this option, you can see a list of suggestions by selecting the Suggest button in the 
Check-Spelling dialog.

· Phonetic Suggestions: Suggest spellings on the basis of phonetic and typographical similarity.    
This option tends to improve suggestions for badly misspelled words.    Using this option increases 
the time required to locate suggestions.

· Suggest Split Words: Suggest two separate words as a replacement for a misspelling containing 
two joined words.    For example, "is the" would be suggested as a replacement for "isthe".

· Match Case in Replacements: Use the same letter case as the original word for automatic and 
suggested replacements.    If the original word was capitalized, for example, then the replacement 
or suggested word will also be capitalized.    Clear this option to use the case listed in the dictionary 
for the replacement or suggested word.    You can also use an auto-change dictionary to expand 
acronyms and abbreviations if you clear this option.

· OK button: Close the Options Dialog and save any changes made to the option settings.

· Cancel button: Close the Options Dialog and discard any changes made to the option settings.



Adding a New Dictionary

You can use the New Dictionary Dialog to specify the attributes of a new user dictionary.

· Browse button: Shows the names of other user dictionary files.    You can also enter the name of 
the new dictionary file.

· Cancel button: Closes the New Dictionary Dialog without creating a new dictionary.

· File Name box: Contains the name of the disk file of the new dictionary's contents.    You can enter 
a name here or use the Browse button to select a dictionary file.

· Language list: Specifies the language (e.g., French, English) of the words the new user dictionary 
will contain. If the language you want to use is not listed, select "Other."

· OK button: Closes the New Dictionary Dialog and creates the new dictionary.

· Type list: Specifies the type or purpose of the new user dictionary.    The type defines what 
happens when a word is located in the dictionary during a spelling check.



Dictionary Types

The type of dictionary you use indicates what happens when a word is found in the dictionary during a 
spelling check.

Auto Change: Words found in an Auto Change dictionary are automatically replaced with other words. 
Typically, Auto Change dictionaries hold frequently misspelled words and their correct replacements.    
For example, an Auto Change dictionary might contain the misspelled word "recieve" and its 
replacement "receive."    Each entry in an Auto Change dictionary contains a word and the 
replacement, separated by a colon (e.g., "recieve:receive").

Conditional Change: Words found in a Conditional Change dictionary are candidates for replacement 
and are replaced with other words if you request.    Typically, Conditional Change dictionaries hold 
potentially misspelled words and their usual replacements.    Each entry in a Conditional Change 
dictionary contains a word and the replacement, separated by a colon (e.g., "recieve:receive").

Exclude: Words found in an Exclude dictionary are always considered misspelled, even if they are 
defined in other dictionaries.    Typically, Exclude dictionaries hold words you may use but don't want to 
appear in your writing.    You might also use an Exclude dictionary to contain words you type by 
accident—for example, you might enter "newt" in an Exclude dictionary if you occasionally type "newt" 
when you mean to type "neat."

Ignore: Words found in an Ignore dictionary are considered correctly spelled.    Typically, Ignore 
dictionaries hold words you use but which don't appear in the other dictionaries.    For example, you 
may add your family name or street name to an Ignore dictionary.





Overview of the Gravity Outbox            

  
 
Gravity drops the outgoing article/message into the Gravity Outbox.    A background thread checks for 
new articles in the Outbox periodically and if anything is ready to go out, it contacts the news server or 
e-mail server to transmit the item.    You can view items are waiting to go out and items already sent by 
opening the Gravity Outbox.

To Open the Gravity Outbox

1. From the View menu, select the Outbox command.

You see a check mark and time stamp for the sent items.    If you haven’t sent an item, you see an 
outbox symbol.

2. To retry sending a message, select the item and click the Retry Send button.

3. To remove an item from the Outbox, select the item and click the Delete button. 

If you have sent an item you delete, you remove it from the database.    Otherwise, you cancel the 
sending.

4. If you have posted an article to a news server, you can cancel the post by selecting the article and 
clicking the Cancel Article button. 

Depending on how quickly you do this after it has been transmitted to the news server, no one or 
only the users of the news server may see it.    If you do it too late, then the article may have been 
propagated to other news servers on the Internet.

5. You can revise the contents of an outbox message by selecting the article, then clicking the Back 
to Editing button.    This removes the message from the outbox and lets you revise the contents of 
the message.    For more information, see Posting an Article.

6. You can purge outbox messages by enabling On shutdown, remove sent items after XX days.    
This prevents your outbox from taking up too much disk space and also speeds up the loading of 
the outbox.





Overview of Searching            

  
 
You can search for articles of interest while you are reading articles, viewing images, or performing 
other Gravity tasks.    You can then view the found articles by clicking in the Results window, or you can 
go directly to an article by clicking the Go To Article button.

NOTE:    Searching is case insensitive.

Tip

Search expressions in Gravity can contain regular expressions.    See Working with Regular 
Expressions for an overview of how to use regular expressions.

See Also:

Searching articles in the current newsgroup 

Searching articles across all newsgroups 

Viewing search results 

Jumping directly to an article 

Working with regular expressions 



Searching Articles in the Current Newsgroup

1. From the Search menu, choose the Search command or click the Search button on the toolbar.

2. In the Search For field, type the text you are looking for.

3. Make sure the This Newsgroup option is selected, then click the Search Now button.

You see any articles that match the search in the Search Results window.

NOTE:    Whenever possible, Gravity uses local information to perform an action.    So, if you have selected the 
Store Article Headers storage option for a newsgroup, and you don’t check the Search Body box, Gravity can 
complete the search without contacting the news server.    If you check Search Body and the bodies for the group 
are not local, Gravity retrieves the bodies from the server during the search.    This can be very slow, but you can 
cancel a search at any time, and you can do other things during a slow search.    Basically, you have full control 
over the search process.



Searching for Articles Across All Newsgroups

1. From the Search menu, choose the Search command or click the Search button on the toolbar.

2. In the Search For field, type the text you are looking for (case doesn’t matter).

3. Make sure the All Newsgroups option is selected, then click the Search Now button.

You see any articles that match the search in the Search Results window.



Viewing Search Results

You can see search results in the Results window.    You can view an article at any time by double-
clicking the article.



Jumping Directly to an Article

To go directly to an article you found, select it, then click the Go to Article button.    You will see the 
article, the newsgroup that contains the article, and the context of the article.

NOTE:    To control whether an article is loaded when you jump to it, choose the Options tab of the Search dialog 
and check or clear the “Go To Article should load the article” option.



Searching Deja News

To aid the search for information on the USENET (User’s Network), Gravity can connect to the Deja 
News website.    This site contains powerful tools that let you search for articles containing specific 
words.    In addition, there are other points of interest having to do with the USENET.

To access the Deja News website, click on the  button in the toolbar or select the Seach 
DejaNews command from the Search menu.

Gravity will automatically launch your web browser (e.g. Netscape or Internet Explorer), then open the 
Deja News home page.



Working with Regular Expressions

Regular expressions are patterns.    Gravity allows you to search for strings within articles using these 
powerful patterns. You can also specify regular expressions in your rules to help you sift out junk or 
highlight articles that interest you.    Regular expressions are powerful but complex.    Here are a few 
examples:

Expression Meaning

[0-9]+/[0-9]+ Find strings like 0/10, 1/10.

Rich|money String must have “rich” or “money” (perhaps you want to kill off 
“get rich quick” schemes)

(me too)|(to me) Kill off me too items or items that say send it “to me.”

((mailto:){0,1} *([a-
zA-Z0-9._-]+ *@ *[a-
zA-Z0-9._-]+))

complex expression that will match any of the following:

mailto:xyz@abc.def

mailto: xyz @ abc.def

xyz@abc.def

xyz @ abc.def

The English equivalent for this expression is:

zero or one instance of “mailto:”

zero or more spaces

one or more character, digit, underscore, period, or dash

zero or more spaces

the ‘@’ character

zero or more spaces

one or more character, digit, underscore, period, or dash

See Also:

Regular Expression Reference 



Regular Expression Reference

A regular expression (RE) specifies a set of character strings.    A substring in the searched string 
matches the RE if the substring is one of the character strings allowed by the RE.

Ordinary 
Characters

A one-character RE that matches itself. The range of 
a character is 0-256.

A two-character expression that what would 
otherwise be a meta-character is to be treated as an 
ordinary character.    The backslash is used as the 
first character of this sequence.

Backslash 
\

A backslash (\) followed by a meta-character is an 
RE that makes the meta-character into an ordinary 
character.

Period . A period (.) is a one-character RE that matches any 
character.

Character Classes

[
]

A non-empty string of characters enclosed in square 
brackets ([]) is an RE that matches any one character in 
that string. 

[STV
]

 will match either an S or a T or a V.

The following characters have special meanings within the 
square brackets.

^ If the first character of the string is a 
circumflex (^), the RE matches any character 
except what the RE would otherwise match.    
The ^ has this special meaning only if it 
occurs first in the string. 

- The minus (-) may be used to indicate a 
range of consecutive ASCII characters.    For 
example, [0-9] is equivalent to [0123456789].

The - loses this special meaning in the 
following cases:

if    the - occurs first

        the - occurs after an initial ^

        the - occurs last in the string.

if    the - is the first character after a range.

For example, [0-9-a] would be matched 
by any of the digits from 0 through 9, by 



a dash, or by an a.

if    the - is the terminating character of a 
range. 

For example, [+--a-z] would be matched 
by any of the characters in the range + 
through—or in the range a through z.

] The right square bracket (]) does not 
terminate a string when it is the first character 
within it or after an initial ^. (e.g., []a-f] 
matches either a right square bracket ] or one 
of the letters a through f).

Positional Regular Expressions

The positional regular expression is used to indicate where in a line of text an operation is to occur. It is 
indicated by angle brackets <> enclosing one or more numbers.    Some examples follow:

<0> is an RE that matches the null string at position 0, 
the beginning of the string. 

<0,5,10> is an RE that matches the null string at position 0,    
or the null string at position 5, or the null string at 
position 10.

~ is an End Of Line Specification. If the position is 
preceded by a tilde ~, then the position is measured 
from the end of the string. 

<~0> matches the null string at the end of the string. 

<~4> matches the null string at position 4 counting    from 
the end of the string. 

- is a Range Specification: If two positions are 
separated by a minus (-), a range of positions is 
used. 

 <0-5> matches any of the null strings at positions 0 
through 5,

 <5-~5> matches any null string from position 5 counting 
from the beginning to position 5 counting from the 
end.

In a range specification, the second position 
specified must not occur before the first position 
specified.

<5-~5> will always fail to match in a string of 9 characters or 
less, since 5 positions from the beginning occurs 
after 5 positions from the end.

<~0-~5> always fails. <~5-~0> is correct.

Complex Regular Expressions



The following rules may be used to construct REs from other REs:

* An RE followed by an asterisk (*) is an RE that matches 
zero or more occurrences of the RE.    Note that the * will 
find the longest match.    If you want to find the first match 
then use {1,0} the {} notation is explained below. 

ab(ba
)*cb 

Searches for all occurrences of ab followed 
by zero or more occurrences of ba followed 
by cb. The patterns abbacb, abbabacb, 
abbabababacb, and abcb would all be 
treated as matching this RE.

ab(ba
)* 

Searches for all occurrences of ab followed 
by zero or more occurrences of ba. If more 
than one sequence of ba follows an ab in the 
text, the match will be made to the entire 
sequence.

(ba)* This will always match the beginning of the 
string.

+ An RE followed by a plus (+) is an RE that matches one or 
more occurrences of the RE.    Note that the + will find the 
longest match.    If you want to find the first match then use 
{1,} the {} notation is explained below.

ab(ba
)+

searches for all occurrences of ab followed 
by one or more occurrences of ba.    If more 
than one sequence of ba follows an ab in the 
text, e.g., abbababa, the match will be made 
to the entire sequence.

Replication Counts

{
}

An RE followed by {m}, {m,}, {,n} or {m,n} is an RE that 
matches a range of occurrences of the RE.    The values of 
m and n must be non-negative integers.

{m} indicates exactly m occurrences of the RE. 

{m,n
}

If m is LESS THAN n, then {m,n} indicates at 
least m occurrences of the RE and no more 
than n occurrences.    In cases where the RE 
occurs more than the minimum number of 
times specified by m, the match will be made 
to the SHORTEST sequence.



{0,1} This specifies that the RE will 
occur 0 or 1 times.

ab(ba)
{2,4} 

given the string 
abbababababa then the match 
will be made to abbaba. I.E., 
ab followed by 2 ba's

If m is GREATER THAN or equal to n, then 
{m,n} indicates at least n occurrences of the 
RE and no more than m occurrences.    In 
cases where the RE occurs more than the 
minimum number of times specified by n, the 
match will be made to the LONGEST 
sequence up to and including the maximum 
number specified by m.

{1,0} This specifies that the RE will    
occur 1 or 0 times.

ab(ba)
{4,2} 

given the string abbababababa 
then the match will be made      
to abbabababa. I.E., ab 
followed by 4 ba's 

  {m,} is equivalent to {m,infinity}

{,n} is equivalent to {infinity,n} 

* and + are equivalent to {,0} and {,1} respectively

Alternation

| REs separated by a vertical bar | form an RE that 
will be matched by strings in the text that match any 
of the REs that make up the complex RE. (s|x|z) will 
be matched by either an s, an x, or a z. 

Grouping

() An RE enclosed within parentheses is equivalent in 
terms of what matches it to the same RE without the 
parentheses.

Concatenation

REs may be concatenated together to form a single RE that will be matched by the concatenation of 
the strings that matched the previously separate REs.

Precedence

The suffix operators *, +, {}, and $, have the highest precedence.    Concatenation has next highest 
precedence.    Alternation, |, has the lowest precedence.    The order of operation may be modified by 



grouping with parentheses.





Overview of Display Filtering            

  
 
Gravity is designed to help you process USENET news efficiently by automatically sorting through 
articles and determining what is important to you based on criteria you provide.    You teach Gravity 
what is important and what is irrelevant by constructing rules for it to follow when examining articles.

One way to focus on what is important to you is to filter your display with the Filter Bar.    You can 
construct filters that look for articles that must have, must not have, or ignore the following attributes:

· Unread

· Important

· Local

· Tagged

· Decoded

· Protected

You can also construct filters such as “Unread and Undecoded” to look for items that you have not 
decoded yet.

If you want to go beyond basic filtering on these attributes, you can use advanced filtering to construct 
arbitrarily complex filters.    These filters let you use full-blown rule conditions to create filters.    You can 
define advanced filters by clicking the Advanced button on the filter definition dialog.

See Also:

Controlling the Display using Display Filtering 



Controlling the Display Using Display Filtering

You can quickly select which articles you want displayed using the Filter Bar.

To Select Articles Using the Filter Bar

1. From the list of available filters in the Gravity Filter Bar, choose the one you want to apply, such as 
Unread Articles or All Articles.

2. If you want to apply the same filter to refresh the display, select it again from the Filter Bar.

3. You can quickly define new filters by clicking the Filters button on the Filter Bar.

4. You can re-position the Filter Bar by dragging it to another location or floating it if you wish.

See Also:

Lesson Eight - Using Display Filters 





Printing Selected Articles

1. Gravity prints the article in the Article pane.    If you want to print other articles, select the ones you 
want to print.

You can select one or more articles in the thread pane by holding down the Shift key while clicking 
to make contiguous or range selections.    Hold down the Ctrl key to make non-continuous 
selections. 

2. Select the Print command from the File menu.





Monitoring the Progress of Decoded Articles

You can observe the progress of the articles that are either being decoded or are waiting to be 
decoded. 

1. From the View menu, choose Image Factory or click the Image Factory button on the toolbar.    
You can also press Ctrl-I.

2. Check the status of the articles:

· Articles waiting to be decoded are listed under the “Queued Jobs” heading.

· Articles that have already been decoded are listed under the “Completed Jobs” heading.

· The article that is currently being decoded appears under the “Current Job” heading.



Monitoring the Progress of Background Print Jobs

You can monitor the progress of any print jobs you have started by:

1. To monitor the progress of any print job, selecting the Print Jobs command from the View menu.

2. Check the status of the print job.

· The articles waiting to print out appear in the “Queued Jobs” window.

· The article currently being printed appears in the “Current Job”.

· The articles that have completed printing appear in the “Completed Jobs” window.

The Current Print Jobs dialog also lets you change the order or remove any of the queued items that 
appear in the “Queued Jobs” window.

1. To change the print order of queued articles, select the article you want to move and drag it to the 
new location in the list, or use the up and down arrows to move it.

2. To remove an article from the print queue, select the article and click the Delete button.

NOTE:    The Gravity print job queue is a background thread that submits the jobs to the selected printer.    Once 
Gravity processes an item, you can check on the progress of the item by checking the Windows Print Manager.



Checking the Event Log for Problems

Gravity maintains a log of problems with posting articles or sending mail via SMTP.

To view the Gravity Event Log, choose the Event Log command from the View menu.

The event log keeps a fixed number of entries.    When that number is exceeded, it throws out the 
oldest event and adds a new one.    Examine details about a logged entry by double-clicking the item or 
clicking the Details button.





Overview of Rules            

  
 
Gravity provides a complete rule system to help you automate mundane news reading chores. You can 
build rules to mark articles containing certain keywords as important, throw away articles by authors 
you don’t like, automatically forward articles via e-mail, decode images in the background and handle 
many other chores automatically.

The rules component of Gravity lets you specify automatic actions to take when you download an 
article that satisfies certain criteria. The rule engine is a very integral part of the Gravity design. This 
means that in future releases the back-end rules engine can be extended by adding new conditions 
and actions to provide additional automation and make Gravity an even more powerful information 
processing tool.

Gravity contains a number of standard rules so you don’t have to create your own. See Using 
Standard Rules.

Finally, Gravity allows you to apply rules manually. See Manually Applying Rules for more information 
on this powerful feature.

See Also:

How Rules Work 

Rule Conditions 

Rule Actions 

When Does Gravity Evaluate Rules?



How Rules Work

The rules engine cooperates with the various threads in Gravity to examine articles as they come in 
and to apply the actions of the rules you create.    Sometimes Gravity executes rules in more than one 
phase.    For example, let’s say you use a rule that decodes an article if it has certain keywords.    The 
rules engine cannot ship the article off for decoding until all parts of the article have been received.

You can create as many rules as you wish.    Each rule has conditions and actions.    The conditions are 
evaluated for each new article.    When the conditions of a rule are satisfied by a particular article, the 
rule's actions are applied to the article.    The following two sections describe the condition and action 
components of rules.



Rule Conditions

A rule's condition can be a complex logical expression of simpler conditions.    The simple condition 
types are:

1. The article's subject field contains a certain phrase.

2. The article's author field contains a certain phrase.

3. Any of the article's header fields contain a certain phrase.

4. The article's body contains a certain phrase.

5. The article is in reply to an earlier article that I wrote.

6. The article has more than X number of lines.

7. The article is cross-posted to more than X groups.

8. The article was posted more than X days ago.

9. The article score is more than XX.

10. The article is in the special “watch” list or “ignore” list.

11. The article is marked as “read,” “important,” “tagged for downloading,” etc.

Tips

· When entering phrases to search for, your text can contain regular expressions.    See Working 
with Regular Expressions    for an overview of how to use regular expressions.

· There are three rule-related lessons in the tutorial starting at Lesson Ten - Rule System Overview.

· To evaluate rule performance, you can see statistics for the current session by choosing Rule 
Statistics from the View menu.



Rule Actions

A rule's actions can be one or more of the following:

1. Play a user-selected sound.

2. Display a user-provided message (in a pop-up dialog box).

3. Append the article to a user-selected file.

4. Forward the article to a user-provided e-mail address.

5. Mark the article as read.

6. Mark the article as important.

7. Mark the article as protected (i.e., undeletable).

8. Add XX to the articles score (may be negative).

9. Decode the article (along with related articles in the same post).

10. Tag the article for retrieval.

11. Retrieve the article’s body and store it locally.

12. Discard the article.

13. Add the article’s thread to the Watch List.

14. Add the article’s thread to the Ignore List.

15. Add the article’s author to the Bozo Bin.



When Does Gravity Evaluate Rules?

When Gravity evaluates a rule varies depending on the its conditions and actions.    First, you must 
enable a rule (use the Rules dialog to do so.).    When you receive an article header, the Gravity tries to 
evaluate the rule.    If the rule or related action applies to the article's body, Gravity defers the 
evaluation until it sees the body. 

In general, Gravity evaluates enabled rules when you download each article's header.    Then, when 
you download the article's body, which may be in a different user session altogether, Gravity performs 
any deferred rule condition evaluations or actions.    If you have set the global storage mode to the 
Save article headers only option, then Gravity may not evaluate until the you explicitly download the 
article's body.



Using Standard Rules

Gravity includes the following standard rules you can use or modify. 

Important Words Rule

Use this rule to mark articles as Important if they contain certain words or phrases. 

1. From the Tools menu, select Important Words.

2. Type the new word or phrase in the New Word field, then click the Add Word button or press the 
Enter key.

3. To remove a word from the list, select the word, then click the Delete Word button.

You can also right-click a word while you are reading an article, then select the Add Important Word 
command from the Article pop-up menu to add the word or phrase to the list of Important Words.

Watch Thread Rule

Use the Watch Thread rule to follow a particular discussion thread. 

1. In the thread pane, right-click the thread you want to watch, then select the Watch Thread 
command.

You see the Watch icon in the status column of articles belonging to threads you want to watch.

2. To view and change the list of watched threads, choose the Watch List command from the View 
menu.    You see the Watch List dialog box, where you can set options for watching threads.

NOTE: You can change the actions of the Watch Thread rule.    For example, you may want to add the Mark as 
Important action.

Ignore Thread Rule

Use the Ignore Thread rule to discard a particular discussion thread. 

1. In the thread pane, right-click the thread you want to watch, then select the Ignore Thread 
command.

You see the Stop icon in the status column of articles belonging to threads you want to ignore.

2. To view and change the list of threads being ignored, choose the Ignore List command from the 
View menu.    You see the Ignore List dialog box, where you can set options for ignoring threads.

NOTE: You can change the actions of the Ignore Thread rule.    For example, you may want to use the Discard 
action instead of the Mark as Read action.

 “User-Specified Word in Subject” Rule

Use the User-Specified Word in Subject rule to highlight articles that contain a word in their subject 
lines.    When you first install Gravity, this rule is disabled (i.e., it does not automatically apply to 
incoming articles).    Enable the rule to search for a user-specified word in article subjects and mark 
found articles as Important. 

When you run the rule manually (through the rule dialog bar or through the manual rule dialog box), 
enter the word you want to look for, then Gravity searches for the word in the subjects of articles in the 
current newsgroup.

Ignore the Spam! Rule



Use the Ignore the Spam! rule to mark highly-cross-posted articles as Read.    When you first install 
Gravity, this rule is disabled (i.e., it does not automatically apply to incoming articles).    Use this rule to 
search for articles that are cross-posted to more than five newsgroups and mark them as Read.

Tips

· The Watch Thread rule and Ignore Thread rule appear automatically when you first add threads to 
the Watch or Ignore list.

· Gravity generates the User-Specified Word in Subject rule and Ignore the Spam! rule when you 
first run Gravity.    If you accidentally remove one of these rules or have upgraded from a previous 
version of the program and do not see them, you can re-generate these rules by deleting all your 
rules then re-starting Gravity.    If you want to save your current rules, you can export them before 
deleting them, restart Gravity to re-generate them, then restore your previous rules by importing 
them from the exported file.



Manually Applying Rules

Manually apply rules in the following circumstances: 

· Let’s say you retrieve some articles, then think of a rule that you would like to apply to them.    
Create the rule and then apply it manually to the article headers you retrieved.    If you enable the 
rule, it applies to all subsequent incoming articles.

· You may want to apply certain rules selectively.    For example, you may occasionally want to get 
rid of small articles.    Create the rule with the condition “not (lines > 100),” then disable the rule.    
The rule is not automatically applied to any incoming articles, but you can apply it manually when 
you like. 

To Manually Apply a Rule

1. From the Tools menu, select the Apply a Rule Manually command. You can also right-click in the 
newsgroup pane, then choose the Apply a Rule Manually command from the pop-up menu.

2. Select the rule that you want to apply.

3. Select the newsgroup to which you want to apply the rule.

4. Click the Start button to begin applying the rule.    Depending on the group and the rule being 
applied, the rule may take a while to complete.

· Click the Stop button if you want to interrupt the rule.

· Click the Reset button to prepare the rule you want to re-apply.

5. Click the Close button when you’re finished.

To Apply a Rule Manually Using the Rule Dialog Bar

1. If necessary, choose the Rule Bar command from the View menu to see the Rule dialog bar.

2. Double-click the name of the newsgroup you want to apply the rule to.    You see the newsgroup’s 
headers in the thread pane.    If you want the rule to apply to selected headers only, select the 
headers you want.

3. In the Rule Bar, select the rule you want to run.

4. Click the Run button on the Rule Bar.    The rule is applied to all displayed headers unless you’ve 
selected more than one header in the thread pane.    Then the rule applies only to the selected 
headers.



Composing New Rules

1. Choose the Rules command from the Tools menu or click the Rules toolbar button.

You see a list of defined rules. 

2. Click the Add button.

3. Enter the name of the new rule.    Type a descriptive name, such as “Everything From Bob Is 
Important”.

You see a property with tabs for choosing which newsgroup the rule applies to, the condition that 
must be met and any actions to be taken.

4. Choose the “Rule applies to all newsgroups” radio button to examine articles from all subscribed 
newsgroups.    Choose the “Wildcard group specification” radio button if you want to create a rule 
that will be applied to groups that have a name that match a pattern (for example, alt.binaries.* for 
all binary pictures).    Choose the “Rule applies to specific newsgroups” radio button to select 
individual newsgroups you want.    You can double-click items to move them from one column to 
the other, or use the arrow buttons.

5. Use the Conditions and Actions tabs to select conditions and actions for the rule. 

See Also:

Working With Rule Conditions 

Controlling Rule Actions 



Working with Rule Conditions

1. Choose the Rules command from the Tools menu or click the Rules toolbar button.

2. Select the rule you want to modify and click the Edit button.

3. Choose the Rule Conditions tab.

4. Choose a phrase to look for. Choose the Article is in reply to my message radio button to target 
follow-ups to your articles and to specify related conditions.

5. You can control the condition phrase by combining choices from the two drop-down lists with a 
phrase that you enter.    For example, you can construct “Subject does not contain eggs” by 
skipping the first list, clicking the second one and selecting “does not,” and entering the phrase 
“eggs” in the edit box.

6. Click the Add Condition button to add the phrase to your list of conditions.

7. Use the AND, OR, NOT, “(“ and “)” buttons to build more complex conditions from the simple 
ones.    Using this technique, you can build phrases like:

(

In reply to my message

OR

Subject contains phrase “Windows”

)

AND 

NOT

(

FROM does contain phrase “Gates”

AND

FROM does contain phrase “Bill”

)

In other words, the message is a reply to my article or is about Windows and does not contain both 
“Bill” and “Gates.”    As you can see, extremely complex conditions can be constructed.

or perhaps

(

NOT

Lines > 100

)

Articles with less than 100 lines.

7. Use the Move Up, Move Down, and Delete buttons to order the lines within the condition and to 
remove unwanted lines.

When your condition is complete, it must be “well formed.”    This means that it must make sense to 
Gravity to apply the condition to articles.    For example, if you forgot the second opening parenthesis in 



the example above, you see the error message, “Bad condition expression.” You must correct such 
problems before leaving the dialog.

Tips

· When entering phrases to search for, your text can contain regular expressions.    See Working 
with Regular Expressions    for an overview of how to use regular expressions.

· When using the “Cross-posted to more than X groups” condition, make sure you enable the 
retrieval of cross-posting information.    From the Server menu, choose the Properties command, 
then the Operation tab.    Select the Include cross-post data when retrieving headers check box.

· Click the condition text to edit it directly.    Remember that the condition’s text must follow certain 
syntax rules, so this is usually only useful when you want to change an existing line without having 
to remove it and add it again.



Controlling Rule Actions

1. Choose the Rules command from the Tools menu or click the Rules toolbar button.

2. Select the rule you want to modify and click the Edit button.

3. Choose the Rule Actions tab.

4. Choose options to control the rule’s actions:

· Play a sound: Play a sound when an article matches the rule.    Check this box, then choose a 
sound from the drop-down list, or choose the Directory button to select a directory where 
other wave files are stored.    You can test the sound by clicking the Test button.

· Show Alert: Display an alert message when the conditions match the article.    Check this box, 
then enter the text of the alert.    For example, if you’re looking for pictures of cheetahs, your 
alert might say “New Cheetah Picture!!”

· Append to file: Automatically append the article to a file for archiving.    Click this option, then 
enter the name of the file to append the article to.    You can choose a file name from a list by 
clicking the Browse button.

· Forward To: Automatically forward the article to someone via e-mail.    Check this box, then 
enter an e-mail address for the recipient.    For example, if you have a friend who needs to buy 
a used Volkswagen camper, you could forward all items containing “for sale”, “Volkswagen” 
and “camper” to your friend.

· Mark article: Mark the article as Read, Unread, Important, Normal, Protected, or Deletable.

· Decode article, save in directory: Decode the article automatically.    Select this option, then 
select a destination directory for the decoded result.    The article is decoded even if it is part of 
a multi-part encoding that spans multiple articles.

· Add XX to article’s score: Adjust the score for the article either up or down (by entering 
negative numbers).

· Tag for body retrieval: Select this option to tag the article for retrieval.

· Retrieve body: Select this option to retrieve the article’s body and store it locally.

· Discard: Delete the article.

· Watch/Ignore: Add the article’s thread to the Watch or Ignore lists.

· Add Author to Bozo Bin: Add the article’s author to the Bozo Bin.



Exporting and Importing Rules

To Export

Export rules so you can back them up or send them to a friend, for example. 

1. From the Tools menu, choose the Rules command.

2. In the Rules dialog box, click the Export button.

3. Enter the name of the file to export rules to.

Gravity exports all your rules to the file you specified and writes them in text format.

To Import

Import rules to restore your backed-up rules or add additional rules that a friend has sent to you.

1. From the Tools menu, choose the Rules command.

2. In the Rules dialog box, click the Import button.

3. Enter the name of the file to import rules from.

Gravity imports the file you chose.    If you are importing a rule has the same name as an existing 
rule, Gravity adds a number to its name.





Overview of Configuring Gravity            

  
 
You can set up Gravity to work according to your preferences. Select settings specific to a newsgroup 
by selecting Properties from the Newsgroup menu. Configure settings that pertain to a specific news 
server by choosing Properties from the Server menu.    You can set most other options by selecting the 
Global Options command from the View menu.

NOTE:    Whenever you need to change a setting, you should first try clicking your right mouse button on the 
selected item. For example, if you want to give a newsgroup a nickname, you can right-click a newsgroup and 
select the Properties command to see the Newsgroup property sheet. To change the formatting of news articles, 
right-click the article pane and choose the Properties command from the pop-up menu.

See Also:

Changing Your News Server ID Settings 

Overview of Article Layout and Formatting 

Changing Your News Server Connection Settings 

Setting Decoding Options 

Setting Display Options 

Configuring the Date/Time Display 

Setting Encoding Options 

Setting Fonts and Backgrounds - Thread and Newsgroup Panes 

Changing Your Automatic Retrieval and Group Settings 

Setting Article Posting Options 

Setting Preferences 

Choosing Global Purge Settings 

Setting Reply Options 

Setting a Subscribe Password 

Signatures - Personalizing Your Posted Articles 

Setting Spell-Checking Options 

Setting Global Storage Options 
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Setting Up Non-Registry URL Associations
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Newsgroup Specific Overrides 

Startup Options 

Controlling Window Layout 



Changing Your News Server Identification Settings (Setup Tab)

1. From the Server menu, choose the Properties command.

2. Choose the Setup tab.

3. Enter or select the following settings:

News server 
nickname

You can give the news server a nickname, for example 
“Microsoft” as opposed to “msnews.microsoft.com.”    In 
addition to being easier to read, this allows you to break 
your groups up into pseudo servers such as 
“SuperNews    - Non-Binary Groups” and “Supernews – 
Binary Groups.”    This allows you to use different 
settings and manage the disparate groups as if they 
were located on different servers.

Note: The news server nickname is mapped directly 
onto a Windows folder (directory), so each nickname 
that you choose must be unique.    If you omit the news 
server address, Gravity will try to connect using the 
nickname.

News server address The Internet address for the news server Gravity 
connects to when retrieving and posting articles. You 
can enter the address as a domain address (such as 
microplanet.com) or as a dot-separated IP address 
(such as 123.456.789.123).    If you omit the server 
address Gravity will try to connect using the nickname.

Mail server (SMTP) The SMTP mail host Gravity uses to send outgoing e-
mail (for example, when you reply to the author directly 
or submit a suggestion for a new feature). Like the 
NNTP server, the address can be a DNS name or an IP 
address.

Full Name Enter your full name if you want other people reading 
your posted articles to see it instead of your e-mail 
address. This field is optional but highly recommended. 
Some people use cute aliases that mask their identity, 
but that isn’t a recommended practice.

Organization Enter the name of your organization to help other 
USENET readers identify who you are. This field is 
optional.

e-mail address When you post articles or reply by e-mail directly to the 
author of a post, Gravity uses sets the From field to this 
address so that others can reply directly to you.

Reply address for 
posts

You can specify a different reply address that is inserted 
into the `From’ header field when you post articles.    
This is useful for blocking spam to your real e-mail 
address.    If you leave this field blank, your regular e-
mail address will be used when you post articles (from 
the above e-mail address field).



No password 
required

Most news servers do not require password 
authentication.    Check this radio button if your server 
does not require a password.

Logon Name If your server requires a password, click on the “Log on 
using” radio button and enter the account name in this 
field.

Logon Password If your server requires a password, click on the “Log on 
using” radio button and enter the password in this field.

Log on using Secure 
Password 
Authentication

If you are using The Microsoft Network (MSN) or 
another server that uses SPA, then click on this radio 
button.    When Gravity connects to the server, a Secure 
Password Authentication dialog box will pop up to 
prompt for your name and password.

NNTP port The TCP/IP port used to connect to the news server in 
your organization.

SMTP port The TCP/IP port used to talk to the SMTP mail daemon 
within your organization.

NOTE:    It is rare that you have to modify these settings in order to make Gravity work.    In the event that you do, 
consult your network administrator for the appropriate settings.



Overview of Article Layout and Formatting            

  
 
Gravity gives you precise control over how articles are presented on the screen. You can select which 
fields to display and in what order, control the font and color for each of the fields, control whether all 
headers are downloaded from the news server, select the background color for the article pane, and 
control how Gravity sorts the threads in the thread pane.

See Also:

Selecting Which Fields are Included in the Article View 

Changing the Font or Color of an Article Field 

Changing the Color of Quoted Text 

Setting the Background Color for Displayed Articles 

Changing the Field Display Order Within an Article

Showing HTML Source Material 

Muting Quoted Text 



Selecting Which Fields are Included in the Article View

1. From the View menu, choose the Global Options command, then select the Article Layout tab.    
You can also right-click the article pane and select the Properties command.

2. In the list on the left, double-click the fields you want to display.    You can also highlight a field and 
click on the Add button to select fields.    This adds the field to the list on the right which contains 
the items you want to display.

3. Remove items you don’t want to see by double-clicking items in the right-hand list or clicking on 
the Remove button after you have selected an item.

NOTE:    You can insert multiple blank lines by clicking Blank Line to space the items in your display.



Changing the Font or Color of an Article Field

1. From the View menu, choose the Global Options command, then select the Article Layout tab.    
You can also right-click in the article display and select the Properties command.

2. Click the field that you want to change, such as Subject.

3. Click the Font/Color button, then choose a font or color.

NOTE:    If you use a fixed width font for the body, such as Courier New, you have a better chance that the article 
will look exactly like it did to the person who composed it.



Changing the Color of Quoted Text

1. From the View menu, choose the Global Options command, then select the Article Layout tab. You 
can also right-click the article pane and select the Properties command.

2. Click the Font/Color button in the Quoted text section to choose a font and color.



Setting the Background Color for Displayed Articles

1. From the View menu, choose the Global Options command, then select the Article Layout tab.    
You can also right-click the article pane and select the Properties command.

2. Click the Background button.

3. Click a color in the color grid, then click the OK button.

Notes

1. Some colors will not work as backgrounds.    Experiment to find a color that works for you.

2. You can choose a color that makes some of your fields disappear.    For example, if you choose a 
blue background and your current color for the article body is blue, then the body will become 
invisible.    The list on the right of the property page shows the how the fields will look against the 
background color you choose.



Changing the Field Display Order Within an Article

1. From the View menu, choose the Global Options command, then select the Article Layout tab.    
You can also right-click the article pane and select the Properties command.

2. Click a current field from the right-hand column.

3. Click the Move Up and Move Down buttons to move items up and down in the list.



Showing HTML Source Material

Some newsreaders (e.g. Microsoft Outlook Express and Netscape) allow articles to be composed in 
HTML.    When these articles are posted, they are sent in two parts – one plain text and one HTML.

When the Don’t Show HTML Source checkbox is selected, you will only see the text part.    This feature 
dramatically reduces the amount of clutter that you would otherwise see due to the tags in the HTML 
part.

To Suppress HTML Content

1. Select the Options command from the View menu.

2. Choose the Article Layout tab.

3. Select the Don’t Show HTML Source checkbox.

4. When you are finished, click on the OK button.



Muting Quoted Text

The Article menu command, Mute Quoted Text, toggles the display of quoted text within an article on 
and off.    You can display how many lines in each quote are displayed by adjusting the “When muting 
quoted text, show the last XX lines” setting.



Changing Your News Server Connection Settings

1. From the Server menu, choose the Properties command.

2. Choose the Connect tab.

3. Enter or select the following settings:

Connect at 
startup

Check this box if you want Gravity to automatically 
connect to your news server at startup and check for new 
articles.    Clear this box if you want Gravity to wait until 
you manually connect before trying to download articles.

Send keep alive 
messages every 
XX minutes

Check this box if you want Gravity to keep the connection 
to the news server open.    Some news servers terminate 
a connection if Gravity has been idle for a while.

Disconnect after 
XX minutes of 
idle time

Check this box if you want Gravity to disconnect from the 
news server after a certain amount of idle time.

Retry XX Times 
before failing

If a connection attempt fails, Gravity will retry a specified 
number of times before giving up.    You can control how 
many times it retries with this setting.

Pause XX 
Seconds before 
retrying

If a connection attempt fails, Gravity will wait the specified 
number of seconds before making another attempt to 
connect to the server.

Setting Decoding Options

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Decoding tab.

3. Accept the default decode directory for saving images or enter the name of a different one. You 
can also press the Browse button to select the decode directory from a list.    You can override this 
value for each group that you subscribe to.

4. Decide how you want to handle duplicate file names.      There are four choices:

stop and ask If you choose this option, Gravity will prompt you with the following 
three choices.

automatically skip 
the file

If the file name already exists, then just move to the next one in the 
decode queue and don’t attempt to save this one.

automatically 
overwrite the file

Replace the existing file with the new one.

automatically use an 
alternate name

Give the new file a new name.

5. To make Gravity pause if disk space runs low, enable Pause decoding if free disk space is less 
than XX Megabytes.

6. Click the Resume decoding after connection is established check box to automatically resume 
decoding when a connection is established and there are articles in the decode queue (as though 



you hit the Resume button in the Image Factory).

7. To mark decoded or viewed items as Read, check the Mark article as Read after decoding/viewing 
option.

8. Select the Delete decoded files on exit check box to automatically remove decoded images when 
you exit Gravity.    This is useful if you do not want to keep all the images you have viewed.

9. Many viewers support special description files for displaying images.    Select the Add descriptions 
to 4DOS-compatible descript.ion file check box to write to these files when decoding images.    If 
this option is selected, Gravity adds a line to the file named “descript.ion” (it is normally a hidden 
file), which viewers read from, so the viewer can display the subject line of the article (e.g., as in 
ACDSee 32).

10. Choose the Launch viewer when article is manually decoded check box to automatically launch a 
viewer to display the image.

11. Select the Launch viewer when article has been decoded by a rule check box to automatically 
launch a viewer when an article was decoded by a rule.

12. Specify how binaries are processed, using either the Image Gallery (the default) or Registry 
association.    Alternately, you can specify a viewer by checking the Use an alternate viewer radio 
button and specifying a viewer to use.



Setting Dial-Up Options

To use Gravity with the built-in dial-up networking capabilities of Windows 95 and Windows NT, set the 
dial-up options.

To Set Dial-Up Options

1. From the Server menu, choose the Properties command.

2. Choose the Dial-Up tab.

3. To have Gravity start a dial-up session when it goes on-line, select the Force dial-up connection 
before going on-line check box.

4. If you want Gravity to prompt you before starting a dial-up session, select the Prompt before 
connecting check box.    You may want to do this to give you a chance to turn on the modem.

5. You can have Gravity use an existing network connection by selecting the Use existing connection 
whenever possible check box.

6. To have Gravity close the dial-up session when it disconnects from the news server, select the 
Close dial-up connection after going off-line check box.

7. If you want Gravity to prompt you before closing a dial-up session, select the Prompt before 
disconnecting check box.    You may want to do this to give you a chance to close other programs 
that are using the dial-up networking session.

8. You can tell Gravity to close the dial-up session only if it has created the session itself by selecting 
the Only if we created the connection check box.

9. You may select from among your dial-up connections if you have more than one connection 
defined.    Select the connection from the Connection drop-down menu.    You may also configure 
its properties by clicking the Properties command.



Setting Display Options

Use the Display options tab to set the appearance of the thread pane.

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Display tab.

3. Use the checkboxes to enable or disable specific columns in the thread pane.

4. Use the Up and Down buttons to reorder the columns in the thread pane.

5. Choose to sort threads either by Date, Subject, or Score.

6. Click the Threads begin collapsed check box button to show a condensed display initially, with 
each thread in a collapsed tree.

7. Use pure threading (by message-id only) or include messages with the same subject in threads 
even if the message-id does not match.

8. Choose a Time Format for displaying the times articles were posted. See Configuring the 
Date/Time Display for the formatting codes.

9. You can set the color for articles that have already been read by clicking the Read Article Color 
button. When articles have been read, they will change to this color (the default is gray). The color 
of unread messages can be configured in the thread pane’s property sheet (right-click on the 
thread pane, and select the Properties command).



Configuring the Date/Time Display

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Display tab.

3. Change the Time Format according to the codes listed below.    To show the Day-Month-Year 
format enter %d-%m-%y. 

%a Abbreviated weekday name

%A Full weekday name

%b Abbreviated month name

%B Full month name

%c Date and time representation for your locale

%d Day of month as a decimal number (01-31)

%H Hour in 24-hour format (00-23)

%I Hour in 12-hour format (01-12)

%j Day of year as decimal number (001-366)

%m Month as decimal number (01-12)

%M Minute as decimal number (00-59)

%p Current locale’s A.M./P.M. indicator for 12-hour clock

%S Second as decimal number (00-59)

%U Week of year as decimal number, with Sunday as first day of week (00-51)

%w Weekday as decimal number (0-6; Sunday is 0)

%W Week of year as decimal number, with Monday as first day of week (00-51)

%x Date representation for current locale

%X Time representation for current locale

%y Year without century, as decimal number (00-99)

%Y Year with century, as decimal number

%z,%Z Time-zone name or abbreviation; no characters if time zone is unknown

%% Percent sign

NOTE:    You can suppress the display of leading zeroes by using the # character.    Examples are: %#d, %#H, 
%#I, %#j, %#m, %#M, %#S, %#U, %#w, %#W, %#y, %#Y.



Setting Encoding Options

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Encoding tab.

3. To control how articles are split when you post them, choose an attachment size from the “Split 
articles at” field. For example, if you routinely post large images (like .jpg files) and want to limit the 
size of any individual article to 32K, then use this field to set that limitation.    If you do not want 
your articles split, use “Unlimited.”

4. If you want to post a file or image in multiple parts where the first articles describes the post and 
the second article starts the actual image, then select the Start attachments in a separate article 
check box.

5. You can control the subject template of posted articles by adjusting the Subject template field. 
When you post files to a newsgroup, Gravity can break them up according to criteria you provide. 
Suppose you want to post a picture of your golden retriever in several parts. The default subject 
template would result in something like this:

The default template %s—%f[%p/%t] yields:

My Golden Retriever—goldrtrv.jpg[0/4]

My Golden Retriever—goldrtrv.jpg[1/4]

My Golden Retriever—goldrtrv.jpg[2/4]

My Golden Retriever—goldrtrv.jpg[3/4]

My Golden Retriever—goldrtrv.jpg[4/4]

Changing the template to <%s> -> %f (%p-%t) would result in:

<My Golden Retriever> -> goldrtrv.jpg (0/4)

<My Golden Retriever> -> goldrtrv.jpg (1/4)

<My Golden Retriever> -> goldrtrv.jpg (2/4)

<My Golden Retriever> -> goldrtrv.jpg (3/4)

<My Golden Retriever> -> goldrtrv.jpg (4/4)

6. Choose the way you want to encode items by clicking on the UUENCODE (default) or MIME 
encoding types.

7. If you choose MIME, you can also define the Content type and Content encoding.



Setting Fonts and Backgrounds - Thread and Newsgroup Panes

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Fonts tab.

3. Select new fonts for each view by clicking on the Font/Color button in the appropriate group box.

4. Return to the default font definition for the view by clicking the Use Default button.

5. You can select background colors for the newsgroup and thread panes by clicking the Background 
buttons.

To configure these settings for the article pane, see Overview of Article Layout and Formatting.

NOTE:    An even easier way to configure these settings is right-clicking the appropriate pane and selecting the 
Properties command from the pop-up menu.



Changing your Automatic Retrieval and Group Settings 
(Operation tab)

1. From the Server menu, choose the Properties command.

2. Choose the Operation tab.

3. Enter or select the following settings:

Retrieve 
headers for all 
subscribed 
groups upon 
connecting

Check this box if you want Gravity to retrieve articles 
from subscribed groups when it starts up.    In addition, 
Gravity cycles through each of the groups and 
retrieves new articles.    You can set the frequency of 
this cycle (for example, every 30 minutes).

Update every 
XX minutes

Tell Gravity how often to retrieve headers for all 
subscribed groups.    This option is enabled only if the 
above checkbox is checked.

Retrieve tagged 
articles upon 
connecting

Check this box to retrieve bodies for tagged headers 
after connecting to the news server.

Retrieve 
headers for 
group 
automatically 
after subscribe

Enable this option if you want Gravity to immediately 
retrieve headers for each newly subscribed group.

Limit Headers You can set a server limit for the maximum number of 
headers to be retrieved for any group at one time.    
This limit can be overridden on a per-group basis.

Include cross-
post data when 
retrieving 
headers

Check this option to include extra cross-posting 
information when retrieving headers.    This slows 
retrieval, but allows Gravity to mark all copies of an 
article as Read when you read any one of them (or 
delete any one of them). If left unchecked, the copies 
of an article cross-posted to other newsgroups are only 
marked Read when you actually view them.

Verify local 
headers when 
retrieving new 
headers

When this option is enabled, Gravity will ask the news 
server for a list of all of the article numbers available in 
the group at the end of each header retrieval phase.    
Turning this option off can speed the retrieval process 
quite a bit, particularly in cases where there are only a 
few of the articles at the server are new.    If you elect 
to disable this option, you may need to do one of two 
things: 1) change your purge options so that unread 
articles are removed more frequently (for example, for 
groups that you rarely read), or 2) use the Verify Local 
Headers command on the Newsgroup menu from time 
to time when it is evident that there are many expired 
articles in the header list.

Server creates 
messages out 

The option can be used with news servers that are part 
of server farms. Enabling the option causes Gravity to 



of order keep requesting articles that appear to be missing.



Setting Article Posting Options

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Posting tab.

3. You can control how text is pasted into your follow-up by setting the indent string.    Gravity inserts 
the indent string in front of each line from the article you are responding to, then shows you the 
follow-up or reply window.

4. You can set the wrap width for articles adjusting the Line wrap width option.    In general, you 
should not set this value above 78 characters.

5. You can control the font for creating articles by clicking the Choose Font button and selecting an 
appropriate font.    Your recipients do not see the text as you typed it unless you are both using a 
fixed width font (e.g., Courier or Fixedsys).

6. You can control how much database space Gravity uses for tracking sent items by adjusting the 
“Number of posted article IDs to keep.” Gravity uses this field with the rule condition “Article is in 
reply to my message” which allows you to flag articles in response to your posts as important and 
so on. The amount of space taken by each posted ID is fairly minimal, so you may want to boost 
this value.

7. You can specify a default distribution for all of your articles by including one in the Distribution box. 
The possible values are “Local” and “Global.”

The Local setting restricts the article's distribution to the local institution (e.g., university).

The Global setting transmits the article to the whole world, which is most common.

8. You can add default custom headers (such as X-No-Archive) by typing them in the “Custom 
headers” edit box.    Note that these fields are transmitted “as is” just after the normal headers 
Gravity generates and before the body.



Setting Preferences

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Preferences tab.

3. Using the proper check box, specify whether or not you want Gravity to be your default news 
reader, meaning Gravity is launched whenever the news: protocol is encountered.

NOTE:    If Gravity is not the news: handler, you will be asked if you want to make it the default.

4. Select the Open newsgroup with a single-click check box to open a newsgroup by clicking its 
name.

5. If you want Gravity to put input focus in the article pane when you open an article, then enable 
When opening an article, put focus in the article pane.

6. Select the Display articles with a single-click check box to show an article by clicking its header 
line.

7. You can configure choose how you want Gravity to behave when you try to open large articles on 
this tab.

8. You can control how newsgroups handle catch-up.    When you catch-up a newsgroup, you are 
marking all the articles read. 

· You can mark only the local (retrieved) articles or both local and unretrieved articles on the 
server. 

· Sometimes an article is cross-posted to more than one newsgroup.    You can mark the article 
as Read in these cross-posted newsgroups as part of the catch-up.    See “Include cross-
posting information” in the Operation section.

· You can tell Gravity to mark all local headers as Read before retrieving headers.    Some users 
prefer this so that they can distinguish new articles from old ones (the new ones will have the 
default color, and the old ones will have the read-article color).

· You can tell Gravity to open the next newsgroup after performing a catch-up operation.

· You can tell Gravity not to mark tagged articles as read when performing a catch-up operation.



Choosing Global Purge Settings

You can control how long articles are kept around after you have read them by adjusting the purge 
settings.    You can set a global setting that applies to all newsgroups, then override that setting for 
individual newsgroups. 

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Purging tab.

3. Gravity lets you specify what to purge from its database.    You can purge read and unread articles 
and set how old an article must be before it is purged.    The “age” of an article depends on the 
date in the article header.

4. Gravity lets you specify when to perform purging operations.    Enter the number of days you want 
Gravity to wait to purge when retrieving headers.    If you specify 0 for the number of days, Gravity 
will purge every time it retrieves headers.

5. Use File-Compaction to compact the Gravity database files after you have purged some 
information from those files.    Gravity allows you to specify whether and how often to compact its 
database files.

6. You can skip compacting groups where savings would not be significant by using the “Compact 
group if savings is at least X k or X percent” option.    The default minimum savings amount is 5 
kilobytes and the default minimum percentage is 10 percent.    The principle benefit of this option is 
faster shutdown with less disk IO.    Occasionally you may want to set a value to zero to insure full 
compaction of all groups.    This setting cannot be overridden on a group by group basis.



Setting Reply Options

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Replying tab.

3. Select the Paste original article into reply check box to automatically paste the article you are 
replying to via e-mail into your response.

4. Select the Paste original article into follow up check box to automatically paste the article you are 
following up to into your follow up submission.

5. Select the Limit quotes check box and set the number of lines you want Gravity to insert into 
replies and follow-ups.

6. Control the introductory text to the quoted materials in your replies and follow-ups by setting the 
Follow up introduction and/or the Reply introduction.    You can use the indicated macros to 
automatically include fields from the article you are replying to.

7. You can modify the CC to author introduction field if desired.    This is text that is inserted at the top 
of a follow-up article when you choose to CC a copy to the author.



Setting a Subscribe Password

Set a password to control who subscribes to new groups.    After you set a password, each time 
someone tries to subscribe to a new newsgroup, he or she must first enter the correct password.    
Remember your password, though.    If you forget it, we can’t help you. 

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Security tab.

3. Click the Set Password button.    Enter a password and then re-type it in case you made a 
mistake.

4. To change a password, click the Change Password button and enter your new password.

5. To clear an existing password, click the Change Password button, enter the old password, and do 
not type in a new password.

NOTE:    Your password is case sensitive, so Pass is a different password from pass.



Signatures - Personalizing Your Posted Articles

Use signatures to include identifying text at the bottom of your newly created articles.    Many people 
put amusing text, disclaimers, deep philosophical rumblings, or tricky ASCII art in their signatures.    
The possibilities are endless.    However, most signatures are four lines or less.

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Signature tab.

3. Click the New Signature button to define a new signature.

4. Enter a name for the signature.    You will use this name later to recall or select a signature.

5. Enter the text of the signature.

6. If you want to use an external text file as the source of your signature, click the Use a File button 
to browse for a file name.

7. To make the currently selected signature your default one, click the Set As Default button.

8. Remove signatures you no longer use by selecting them from the Current list, then clicking the 
Remove button.



Setting Spell-Checking Options

You can set several spell-checking-related options.

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Spelling tab.

3. If you want to spell check before you send a post or e-mail message, select the Run spell-checker 
before sending an article or e-mail message check box.

4. You can set each of the following spelling options by checking the appropriate box:

· Ignore capitalized words (e.g., Canada).

· Ignore all-caps words (e.g., ASAP).

· Ignore words with numbers (e.g., Win95).

· Ignore words with mixed case (e.g., SuperBase).

· Report doubled-words (e.g., the the).

· Case sensitive.

· Always suggest.

· Phonetic suggestions.

· Typographical suggestions.

· Suggest split words.

· Match case in replacements.

5. You can edit the spell-checker’s list of words to ignore by using the fields in the Ignore list.

6. Click the Advanced button to see the Dictionaries dialog box where you can edit the ignore list 
(uignore.tlx), the exclude list (uexclude.tlx), the auto-change list (uchange.tlx) and the conditional-
change list (usuggest.tlx).

· The ignore list includes words considered correctly spelled.

· The exclude list includes words considered incorrectly spelled, even if they appear in a 
dictionary file.    Here, you may want to put words that you use but don’t want to appear in your 
writing.

· The auto-change list includes words and their replacements.    The replacements are 
automatically substituted for the words.

· The conditional-change list includes words and their replacements.    The replacements are 
presented to you as candidates for replacing the original words.



Setting Global Storage Options

The global storage settings allow you to control what parts of articles are stored locally for easy 
access. You can override the global settings for individual newsgroups (see the topic Selecting 
Newsgroup Storage Options for how to do this).

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Storage tab.

3. Gravity only stores article headers unless you specifically instruct it to store bodies as well.    To 
have Gravity default to storing bodies for newly subscribed newsgroups, enable the Retrieve and 
store article bodies option.

4. If you are not storing bodies for a group but you want Gravity to save those articles that you have 
fetched from the server for reading, then enable the Store all bodies retrieved for reading option.



Overview of Storage Options            

  
 
Gravity has two automatic storage modes:    store article headers locally, or store article headers and 
bodies locally.

Using the Store Article Headers Option

You can use this option to read the group in an “off-line” fashion, using the following sequence:

1. Connect and retrieve article headers.

2. Disconnect and tag headers for articles you want to read.

3. Re-connect and retrieve bodies for tagged headers.

4. Disconnect and read the fetched article bodies at your leisure.

You can also use this option for on-line news reading when you’re interested in saving the disk space it 
would take to store article bodies.

Advantages of Store Article Headers

· Can reduce connection time.

· Uses only enough disk space to store article headers.

Disadvantages Of Store Article Headers

· Manual retrieval of the bodies is necessary.

Using The Retrieve and Store Article Bodies Option

You can use this option when you’re not interested in conserving disk space, and you want to look at 
all articles’ bodies. Bodies for all articles are retrieved and stored locally.

Advantages of Retrieve and Store Article Bodies

· All article bodies are local, so they are accessible if the server becomes unavailable.

Disadvantages of Retrieve and Store Article Bodies

· Uses more disk space the other two modes.



Checking for Software Updates

The Updates tab of the Global Options allows you to configure Gravity to automatically check for 
software updates on a periodic basis.    If a newer version of Gravity is available on MicroPlanet’s web 
site, a notification dialog pops up with the name of the update and a description to help you determine 
if you need it.    You can click on the “Get It” button of the notification dialog to go directly to the Gravity 
web site to read more about the update or download it.

The update mechanism uses a standard web connection (http: port 80) to access the MicroPlanet web 
site.    If for some reason it is inaccessible, Gravity will try the next time it connects to a news server to 
access our site.    If the update check repeatedly fails (e.g. you are behind a firewall), you can disable 
the checking altogether.



URL Hotlinks - Integrating with Other Internet Applications

Gravity automatically highlights Uniform Resource Locators (URLs) to allow you to jump directly to web 
pages, retrieve files via File Transfer Protocol, search Gopher databases, and send e-mail or telnet to 
another host.    All you have to do is click a URL and Gravity works with an application associated with 
that type of URL.

Gravity has direct registry and shell support for URLs under Windows 95 and Windows NT 4.0.    This 
means that you can tell Windows 95 to use Netscape or another browser to view web pages and 
actually type web addresses on the command line (e.g. start http://www.microplanet.com), create 
shortcuts on the desktop, and so forth.    You can control these registry associations by opening 
Explorer, selecting the View menu, choosing the Global Options command, and clicking the File Types 
tab.    Scroll down until you see entries for URL:File Transfer Protocol and so on.

Under Windows NT version 3.51, there is no direct registry and shell support for URLs.    However, 
Gravity allows you to set up URL associations under Windows NT that work that same way they would 
under Windows 95.    See Configuring URL Hotlink Associations for details.

NOTE:    Highlighting very large articles can take quite a long time.    For that reason, Gravity tracks how long it has 
spent highlighting URLs within an article, and if a period of three seconds has elapsed, Gravity discontinues the 
highlighting within the article.    If you see some articles that have highlighted URLs at the top but not toward the 
bottom, that is what happened.    If you feel strongly that you want to increase the maximum time to more than 
three seconds you can edit the registry to adjust the 
HKEY_CURRENT_USER\Software\MicroPlanet\Gravity\UI\MaxHiliteSeconds value.    Even if a URL is not 
highlighted, you can still launch it by clicking on it.



Configuring URL Hotlink Associations

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the URL Hotlinks tab.

3. Click the Color button to choose the color Gravity uses to highlight your links.

4. Click the Underline checkbox if you want URLs links to be underlined.    A sample of the color and 
underline appears to the right.

5. If you are using Windows 95 or Windows NT 4.0, you can choose the Use registry association 
radio button for each of the different URL types.    This means that Gravity will be consistent with 
any other applications you have that are registry aware.    In other words, you can set your 
associations once and all applications should recognize them.

6. If you choose the Use registry association radio button for an item, you can configure its setting by 
opening Explorer, choosing the Global Options command from the View menu, and clicking the File 
Types tab.    Scroll down until you see items such as URL:File Transfer Protocol.    Click the Edit 
button to change the association.

7. If you are using Windows NT 3.51 or do not want to use the registry associations for Uniform 
Resource Locators, see Setting Up Non-Registry URL Associations.



Setting Up Non-Registry URL Associations

If you are using Windows NT 3.51 or if you want to use URL associations other than those in the 
registry under Windows 95 or Windows NT 4.0, you can follow the following instructions.

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the URL Hotlinks tab.

3. If you want to use Gravity’s built-in e-mail capabilities when you click an e-mail address, choose 
the Use Gravity mail capability radio button.

4. For the other four URL types (World Wide Web, FTP, Gopher and Telnet), clear the Use registry 
association check boxes. 

5. Click the Custom Association button to see the dialog to configure the URL.

You can configure an association in two ways.    You must know how the helper application works to set 
it up properly.    If the application takes a command line to open the URL, you can enter the path in the 
Application field (use the Browse button to pick from a list) along with a %1 to indicate the URL.    For 
example:

Application: c:\fancyftp\fancyftp.exe %1

This tells Gravity to launch the fancyftp.exe application and pass the URL as a command line argument 
to it.

Another way to configure the association is through the use of DDE (dynamic data exchange).    This 
requires some knowledge about the commands that the application supports.    However, we will give 
an example below for two of the most common browsers.

1. Check the “Use DDE” box to enable the DDE-related fields.

2. Enter the DDE service name for the application (usually the service name is the same name as the 
application, e.g. Netscape).

3. Enter the DDE topic (something like WWW_OpenURL).

4. Select the DDE transaction type by clicking the Execute, Poke or Request buttons.

5. Enter the item information to pass to the DDE server (this is optional for some applications).

6. Enter the data information to pass to the DDE server (this is optional for some applications).

If you have Netscape Navigator, your entry should look like this:

Service : Netscape

Topic : WWW_OpenURL

Transaction : Request

Item : %1,,-1,,,,,

Data :

This tells Netscape that you want to execute a DDE request with a topic of WWW_OpenURL and pass 
%1,,-1,,,,, as parameters to this request (all of the commas are place holders for default arguments). 
The %1 is the substituted URL, and the -1 for the third parameter tells Netscape not to open up a new 
window if it is already loaded in order to display the URL.

Similarly, if you are using Microsoft’s Internet Explorer, your entry would look something like:

Service : IExplore



Topic : WWW_OpenURL

Transaction : Request

Item : %1,,-1,,,,,

Data :

For other applications, you need to consult the application’s documentation to find out what DDE 
commands it accepts.



Enabling and Disabling Warnings

When you first install Gravity, asks for confirmation when you execute certain commands.    This 
prevents you from doing something you might regret.    When the warning box appears, you can check 
the “Don’t display this warning next time” box to disable the warning.

To Enable/Disable Warnings All At Once

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Warnings tab.

3. Check the boxes for the warnings you want to display, and clear the boxes for those you don’t. 

Warnings for file extensions

Both Gravity and the Image Gallery share a warning system for launching files types.    When you 
attempt to launch files with a given extension, Gravity will ask if you want to launch it and you will also 
be given an opportunity to approve the file extension.    The Global Options/Warning tab allows you to 
view and edit the list of approved extensions.



Newsgroup Specific Overrides

You can override certain global settings for any given newsgroup, including the storage options, 
purging options and the oldest article to retrieve in a group.    To configure these options, see 
Specifying Newsgroup Overrides.



Controlling Window Layout

Gravity lets you view news in three panes: the newsgroup pane, the thread pane and the article pane. 
The thread pane displays all threads within the newsgroup ordered by the date of the oldest article in 
the thread.    Within each thread, the articles are ordered by date and relationship to their siblings.

To Set Up the Window Layout

1. From the View menu, choose the Global Options command.

2. On the Global Options properties sheet, choose the Window Layout tab.

3. Select a layout by clicking an example.

4. Choose which pane corresponds to which view by dragging and dropping the list of panes in the 
windows on the right side of the dialog.    For example, you could make the thread pane the second 
window by clicking on number 3, the thread pane, and while holding the mouse button down drag it 
up between numbers 1 and 2 and release the mouse button.    This reorders the list to make the 
thread pane the second window and the article pane the third window.    You can also move the 
items by using the up and down buttons to reorder the window panes.

5. Play around with it until you find a window configuration you like.



Startup Options

Gravity has the following optional command line arguments.

/NOLOGO

Runs Gravity without showing the startup screen.

/SAFESTART

Gravity treats certain database entries as corrupt and re-creates them.

/SOCKET

If you start Gravity with the /Socket option, Gravity will create trace files of its interaction with the news 
server.    These files are created in the Gravity program folder and have a .TRC extension.

/VCRFILE:

You can specify the name of a VCR file to automatically launch when you run the program.    Gravity 
will load the VCR definition and start executing it.    For example:

gravity /vcrfile:test.vcr

Would cause Gravity to load the test.vcr file and process all of the servers and/or newsgroups that are 
defined in it.    You define and save VCR files from within the VCR tool itself.





Navigation Settings

The Global Options Navigation tab allows you to control how Gravity navigates.    The Navigate tab 
contains two tabs – one for online operation and the other for offline operation.

The following navigation options are available for different conditions:

Do not move After the command is completed, Gravity should not move 
selection.

Move selection down Move to the next visible header in the thread pane.

Skip to the next unread 
article in the thread

Move to the next unread article in the thread, but do not open it 
for viewing.

Skip to the next unread 
article

Move to the next unread article (whether or not it is in the current 
thread), but do not open it for viewing.

Skip to the next unread 
local article

Skip to the next unread article that is stored in Gravity’s article 
database.

View next article Move to the next article and open it in the article pane.

View next unread 
article

Move to the next unread article and open it in the article pane.

View next unread 
article in thread

Move to the next unread article in the current thread and then 
display the article in the article pane

View next unread local 
article

Move to the next unread local article and display it in the article 
pane.

The above navigation choices can be made for online and offline operation for the situations:

After tag – threaded Controls navigation after the tag command (T) is applied in a 
threaded view.

After tag – sorted Controls navigation after the tag command (T) is applied in a 
non-threaded view.

After ignore – threaded Controls navigation after the Ignore Thread command (I) is used 
in a threaded view.

After ignore – sorted Controls navigation after the Ignore Thread command (I) is used 
in a non-threaded view.

After watch – threaded Controls navigation after the Ignore Thread command (I) is used 
in a threaded view.

After watch – sorted Controls navigation after the Ignore Thread command (I) is used 
in a non-threaded view.

After kill thread – 
threaded

Controls navigation after the Kill Thread command (ctrl-k) is used 
in a threaded view.

After kill thread – 
sorted

Controls navigation after the Kill Thread command (ctrl-k) is used 
in a non-threaded view.

After mark article as 
read – threaded

Controls navigation after the Mark article as read (k) command is 
used in a threaded view.



After mark article as 
read – sorted

Controls navigation after the Mark article as read (k) command is 
used in a non-threaded view.

After single-key-read – 
threaded

Controls navigation once the end of an article is reached and the 
single-key-read (space) command is used in a threaded view.

After single-key-read - 
sorted

Controls navigation once the end of an article is reached and the 
single-key-read (space) command is used in a non-threaded 
view.

You can make the middle button on your mouse behave like the space bar (single-key-read) by 
enabling Middle mouse button performs single-key-read on the Navigation tab.



Overview of Working with URLs            

  
 
Uniform Resource Locators (URLs) are pointers to Internet resources such as World Wide Web pages 
or files accessible via File Transfer Protocol.    You access these resources by clicking their URLs.    
Whenever Gravity spots a URL for the World Wide Web, File Transfer Protocol, Internet e-mail, gopher, 
or Telnet, it highlights the URL. When you click the URL, Gravity passes it to an application that 
processes the URL for you.

See Also:

URL Support Under Windows 95 and NT 4.0 

URL Support Under Windows NT 

Configuring URL Hotlink Associations 



URL Support Under Windows 95 and NT 4.0

Windows 95 contains special support for Uniform Resource Locators in the registry and the shell.    The 
intention is to provide consistent treatment of Internet resources across all applications. 

URL associations are maintained in the registry just like associations for other file types.    To modify 
the associations, launch Explorer, choose the Global Options command from the View menu, then click 
the File Types tab.    URL entries have a URL: prefix to distinguish them from other files types.    The 
built-in URL awareness in Windows 95 confers the following benefits:

· You can create shortcuts to Internet resources and place them on your desktop.    For example, 
some applications allow you to drag a URL onto the desktop.    You can then double-click the 
shortcut to jump directly to the resource.

· You can type Uniform Resource Locators in the DOS shell and Windows 95 will launch the 
appropriate application to handle the resource.    As an example, you can type “start 
www.microplanet.com” at the DOS prompt and Windows 95 will launch the web browser 
associated with web pages to load the home page.

· Applications should honor the registry associations you have chosen to give you consistent 
operation throughout the system.    You should not have to configure “helper application” support 
within each application that you use.

See Configuring URL Hotlink Associations for more information on configuring URLs within Gravity.



URL Support Under Windows NT

Unlike Windows 95, Windows NT 3.51 contains no special support for Uniform Resource Locators.    If 
you are using that version of Windows NT, you can accomplish the same thing by using Gravity URL 
association support.    For information about how to configure your URL settings, see Configuring URL 
Hotlink Associations.





Image Gallery            

  

The Image Gallery is a great tool for viewing images or launching songs that you download from 
newsgroups.    You can view images, create a slideshow, set an image as your Windows wallpaper, and 
much more.

To Open the Image Gallery

In the main program, open the Image Gallery by clicking the Image Gallery button or by pressing Ctrl-
G.    The Image Gallery list of images will appear.    Of course, this list will be empty until you download 
some images from a newsgroup.    For more information on downloading images, see Viewing and 
Decoding Images from the Main Program.

See Also:

Viewing Images in the Image Gallery 

Deleting Images 

Sorting Images 

Reducing/Enlarging Images 

Moving Through Images 

Creating an Image Slideshow 

Setting an Image as Wallpaper 

Spawning an Image 

Refreshing the Image List 

Viewing Image Properties 

Setting Image Gallery Options 



Viewing and Decoding Images from the Main Program

When it comes to viewing image files that are attached to a post, you can either decode the item, 
which will download the image but not display it, or decode and view the image.

Decoding images is useful if you want to retrieve a lot of images, then go back and review them at a 
later time.

Viewing an image gives you the opportunity to see the image immediately.

To Decode and View Images

Select the articles you want to decode (or view).    For multi-part images, you only need to select one 
part before decoding the entire image.

1. Decode one or more articles by selecting the articles, then clicking the Decode button on the 
toolbar, selecting the Decode command from the Article menu, right-clicking in the thread pane and 
selecting the Decode command from the pop-up menu, or pressing Ctrl+D.

2. To decode and view one or more articles, select the articles, then click the View Image toolbar 
button, select the View command from the Article menu, right-click in the thread pane and select 
the View command from the pop-up menu, or press the V key.



Viewing Images

You can view decoded images at any time.

To View Decoded Images

1. In the main program, open the Image Gallery by clicking the Image Gallery button or by pressing 
Ctrl-G.

2. Double-click the image you want to view or select the image files, then click on the View Image 
button.

If you want to view the images in thumbnail form (small representations of the images that let you 
browse multiple images on one screen), click on the Toggle Thumbnails button.    If you have a lot 
of images, the thumbnail option may help you sort through them.

NOTE:    You can view individual images in the thumbnail view by double-clicking on an image or selecting one, 
then clicking on the View Image button.

See Also:

Refreshing the Image List 



Changing Folders

The Image Gallery shows you the contents of one folder (directory) at a time.    To change the current 
folder, select Choose Directory from the View menu.

You can also use the Directory Bar to change folders.    The directory bar is a toolbar with a drop-down 
menu that lets you select a new folder to view, and shows the current folder’s name.    To enable the 
directory bar, choose Directory Bar from the View menu (the directory bar is enabled by default).    
The directory bar shows the list of recently visited folders in an MRU (most-recently-used) fashion, with 
the most recently visited at the top of the list.



Moving Images

You can move images from one folder to another in several different ways. The easiest way is to use 
the Move toolbar button.

To Move Images Using the Move Toolbar Button

The Move toolbar button brings up a menu of folders that you have recently moved images into. The 
folders that you most recently moved images into appear at the top. To move an image into a different 
folder, select the image and then select the new folder from the Move toolbar button.

To Move Images Using the Move Command

You can use the Move command from the Image menu to move an image to a different folder. Select 
the image you want to move, then select the Move command from the Image menu, and select the 
new folder from the folder tree that appears.

To Move Images Using Drag-and-Drop

You can drag images from the Image Gallery onto other programs, or vice versa.    For example, to 
move an image to the desktop or to Windows Explorer, drag the image from the Image Gallery to the 
desktop or to Windows Explorer.    You can also move an image from Windows Explorer to the Image 
Gallery by dragging it.

WARNING:    When you drag an image from Image Gallery to another program, the Image Gallery loses the 
image’s associated properties (i.e., the original article’s newsgroup name and subject).    If you want to move the 
image to a different folder but you still want to keep track of it within the Image Gallery, you should use one of the 
other two methods above.



Deleting Images

You can delete decoded images at any time.

To Delete a decoded image

1. In the main program, open the Image Gallery by clicking the Image Gallery button or by pressing 
Ctrl-G.

2. Click the image you want to delete, then click on the Delete button.

If you are in the thumbnail view (small representations of the images that let you browse multiple 
images on one screen), click on the image, then select the Delete button.

3. In the Delete prompt, click on the Yes button.

There is a Don’t Warn Me Again check box.    If you do not want to be bothered by the Delete 
dialog in the future, select this check box.



Protecting Images From Deletion

You can protect images from accidental deletion.

To Protect Images from Deletion

1. In the main program, open the Image Gallery by clicking the Image Gallery button or by pressing 
Ctrl-G.

2. Click the image you want to protect, then select Protect from the Image menu.    A blue shield icon 
will appear next to the image.    You can also use the Ctrl-L key combination (which also means 
`protect’ in Gravity).

To un-protect an image, select it and use the Ctrl-L key combination again.



Sorting Images

As you accumulate images, you may have to start sorting through them to find the ones you want.    
Gravity’s Image Gallery comes with a set of sorting tools to help.

To Sort Images

1. In the main program, open the Image Gallery by clicking the Image Gallery button or by pressing 
Ctrl-G.

2. In the Image Gallery list, click on one of the column-head buttons to sort the image files.    You can 
sort by file name, file size, newsgroup, subject, or decode date.    You can also use the Sort By 
command in the View menu, then choose one of the sort parameters: file name, file size, 
newsgroup, subject, or decode date.



Reducing/Enlarging Images

Depending on the original size of an image, you may have to reduce or enlarge an image for better 
viewing.

To Reduce/Enlarge Images

1. In the main program, open the Image Gallery by clicking the Image Gallery button or by pressing 
Ctrl-G.

2. Double-click the image you want to view or select the image files, then click on the View Image 
button.

3. Click on the Reduce button to zoom out on the image.    You can also select the Reduce command 
from the Image menu.

Click on the Enlarge button to zoom in on the image.    You can also select the Enlarge command 
from the Image menu.



Moving Through Images

It is easy to move from one image to another in the Image Gallery.

To Move Through Images

1. In the main program, open the Image Gallery by clicking the Image Gallery button or by pressing 
Ctrl-G.

2. Double-click the image you want to view or select the image files, then click on the View Image 
button.

3. Click on the Next Image button to display the next image.    You can also select the Next command 
from the Image menu.

Click on the Previous Image button to display the previous image.    You can also select the 
Previous command from the Image menu.

4. You can also move to the first or last image in the Image Gallery list by selecting the First or Last 
commands in the Image menu, respectively.



Creating an Image Slideshow

You can create a slideshow based on the images that are listed in the Image Gallery.    Your slideshow 
can display specific slides that you tag or show all the images.

To Display a Tagged Slideshow

1. In the main program, open the Image Gallery by clicking the Image Gallery button or by pressing 
Ctrl-G.

2. On the Image Gallery list, highlight an image or group of images, then click on the Tag button.    
You can also use the Tag command in the Slideshow menu.    A green bullet appears next to the 
image.

To un-tag an image, highlight it and select the Tag command again.    The green bullet disappears.

3. When you are finished selecting images for the slideshow, click on the Slideshow Tagged toolbar 
button to start the slideshow.    You can also use the Slideshow Tagged command in the Slideshow 
menu.

4. To change slideshow options such as the interval between slides and looping, access the 
Slideshow Options under the Options command in the Gallery menu.

5. Press the Esc (Escape) key to stop the slideshow.

To Display All Images in a Slideshow

1. In the main program, open the Image Gallery by clicking the Image Gallery button or by pressing 
Ctrl-G.

2. Highlight the image where you want the slideshow to start, then click on the Slideshow All button 
to begin.    You can also use the Slideshow All command in the Slideshow menu.

3. To change slideshow options such as the interval between slides and looping, access the 
Slideshow Options under the Options command in the Gallery menu.

4. Press the Esc (Escape) key to stop the slideshow.



Setting an Image as Wallpaper

You can choose an image to be the wallpaper on your Windows desktop.

To Set an Image as Wallpaper

1. In the main program, open the Image Gallery by clicking the Image Gallery button or by pressing 
Ctrl-G.

2. Highlight the image that you want as wallpaper, then click on the Set Wallpaper button.    You can 
also use the Set Wallpaper command in the Image menu.

3. To remove the image as your wallpaper, you can insert another image from the Image Gallery or 
go to the Display setting in Windows Control panel (found under the Settings command in the 
Windows Start menu).



Spawning an Image

Spawning a new window means opening a new window that shows the current image.    Since you 
cannot have multiple instances of the Image Gallery running at the same time, this feature lets you 
view multiple images at the same time.

To Spawn an Image

1. In the Image Gallery, view an image.    For more information, see Viewing Images.

2. Click on the Spawn Window button.    A new window opens with the current image displayed in it.



Refreshing the Image List

The Image Gallery shows you the contents of a folder, including any files that were not decoded by 
Gravity.    You can tell the Image Gallery to refresh this list of files in case any files have been deleted 
(outside of the Image Gallery).    In other words, if you delete an image file in Windows Explorer, it will 
not be reflected in the Image Gallery list until you refresh it.

To Refresh the Image Gallery List

Select the Refresh Image List command from the Gallery menu or press the F5 key.



Viewing Image Properties

You can view details about an image such as its path (location) on your computer, the newsgroup that 
it came from, and subject of the post that it came from.

To View Image Properties

1. In the main program, open the Image Gallery by clicking the Image Gallery button or by pressing 
Ctrl-G.

2. Locate the image whose properties you want to check, highlight it, then click on the Properties 
button.    You can also use the Properties command in the Image menu.

3. When you are finished, click on the OK button.



Setting Image Gallery Options

The Image Gallery has an options screen that lets you set general and slideshow parameters.

Setting General Options

1. Choose the Options command from the Gallery menu, then choose the General tab.

2. Turn off the Auto-display when Gravity launches an image option if you don’t want the current 
image replaced by the new one when the user tries to use Gravity to view an image. This option is 
on by default.

3. Select the Launch External Viewer check box to open images in the default viewer (as specified 
in Windows) rather than the Image Gallery.

4. Using the Show Full Path check box, specify whether or not you want the full pathname of the 
image - as opposed to just the filename - displayed in the Image Gallery list.

5. Use the Ask before deleting checkbox to specify whether or not you want a delete confirmation 
before you get rid of an image.    For safety sake, we recommend that you leave this option 
selected (as it is by default).

6. Use the Ask before moving checkbox to specify whether or not you want a confirmation dialog 
box to appear before you move an image.

7. Choose whether to set the default image rendering to halftone.    Without the halftone mode 
activated, an image that has been reduced in size may be displayed with a lot of graininess.

Also, if your decoded images appear too light, deactivate the halftone setting (if it is already 
selected).

8. Turn off the Save thumbnails on disk option if you don’t want thumbnail files (*.thu) files to be left 
on your hard disk.    This option is on by default.    Turning this option off saves disk space but 
causes thumbnail display in Image Gallery to be slower.

9. Use Shrink image to fit window if you want the gallery to reduce images that are larger than the 
window size so that they fit the window.

10. Use Enlarge image to fit window if you want the gallery to enlarge small images so that they 
completely fill the current window size.

11. Set the width and height of the images for thumbnail mode.    Unless you have a good reason for 
changing the default settings, we recommend leaving the 64-pixel setting for both fields.

12. When you are finished, click on the OK button.

Setting Slideshow Options

1. Choose the Options command from the Gallery menu, then choose the Slideshow tab.

2. If you want your slideshows to be displayed in full-screen mode, then select the Use Full Screen 
for Slideshow check box.

3. Using the Continuous Loop check box, tell the Image Gallery whether or not to keep looping 
(repeating continuously) a slideshow.    With this option selected, when you run a slideshow, it will 
continue running until you press the Esc (Escape) key.

NOTE:    This feature is very useful for trade show presentations and other events where you want 
the same images repeated over and over.

4. Set the number of seconds that an image is displayed during a slideshow.    For example, if you set 



this value to five seconds and run a slideshow, each image will be displayed for five seconds 
before being replaced by the next image.

5. When you are finished, click on the OK button.



Miscellaneous Features

Here are some miscellaneous features provided by the Image Gallery:

1. If Gravity is running, you can bring up its Image Factory window by selecting the Show Gravity’s 
Image Factory command from the View menu.    The Image Factory window allows you to view 
and control Gravity’s decode queue.

2. You can customize the Image Gallery’s toolbar and even add new toolbars selecting the 
Customize Toolbar command from the Gallery menu.

3. You can view only images decoded during the last session of Gravity by selecting the This 
Session Only command from the View menu.



Overview of the Image Factory

The Image Factory lets you work with images that you want to decode.    It is especially useful when 
you are decoding a large batch of images that are attached to a group of articles.    As images are 
being decoded, you can manage the order in which they are decoded, delete ones you do not want, 
and access the Image Gallery to view them.

See Also:

Selecting Images to Decode 

Viewing Decoded Images

Deleting Viewed Images

Changing the Order that the Images Are Being Decoded

Canceling Decoding for Images That You No Longer Want



Selecting Images to Decode

When it comes to viewing image files that are attached to a post, you can either decode the item, 
which will download the image and decode it but not display it, or decode and view the image.

Decoding images is useful if you want to retrieve a lot of images, then go back and review them at a 
later time.

Viewing an image gives you the opportunity to see the image immediately.

To Decode Images

1. Select the article(s) you want to decode.    For multi-part images, you only need to select one part 
before decoding the entire image.

2. Clicking the Decode button on the toolbar, selecting the Decode command from the Article menu, 
or right-clicking in the thread pane and selecting the Decode command from the pop-up menu.



Viewing Decoded Images

Once you start decoding articles, open the Image Factory to monitor the progress, view images, and 
remove unwanted images.

To View Decoded Images

1. Open the Image Factory by clicking the Image Factory toolbar button or by pressing Ctrl-I. 

2. Select a successfully decoded article.    Decoded articles include an OK in the status column.

3. Double-click the image you want to view or click the View button.

NOTE:    You can also view decoded articles from the pop-up menu of the thread pane.    Select an article, right-
click in the thread pane, then select the View command.



Deleting Viewed Images

1. Open the Image Factory by clicking the Image Factory toolbar button or by pressing Ctrl-I. 

2. Select the image you want to delete.

3. Click the Delete from Disk button to remove the decoded image from your hard disk.



Changing the Decoding Order

1. Open the Image Factory by clicking the Image Factory toolbar button or by pressing Ctrl-I. 

2. Click an article in the Queued Jobs column, then use the Move Up, Move Down, and Move To Top 
buttons to move it.



Canceling Image Decoding

1. Open the Image Factory by clicking the Image Factory toolbar button or by pressing Ctrl-I. 

2. Click an article in the Queued Jobs column, and then click the Delete button. 





Importing NEWSRC Files

You can import standard NNTP newsrc files.

A newsrc file is a text file that contains the names of newsgroups, along with information about each 
one, such as whether you subscribe to it, and which articles in that newsgroup were read by you.    
Some newsreader programs use the file as the main database (i.e., to remember what newsgroups 
you subscribe to).

Gravity lets you read and write the newsrc files so that you can transport database information 
between machines (e.g., if you use Gravity on your home and work computers).    Also, you can use the 
import-newsrc feature to switch to Gravity from another newsreader program without having to 
subscribe to your favorite newsgroups individually.

To Import NEWSRC Files

1. Select the Import NEWSRC File from the File menu.

2. Enter the name of the newsrc file.    Use the Browse button to locate the file, if necessary.

3. Click on the OK button.



Exporting NEWSRC Files

You can export standard NNTP newsrc files.

A newsrc file is a text file that contains the names of newsgroups, along with information about each 
one, such as whether you subscribe to it, and which articles in that newsgroup were read by you.    
Some newsreader programs use the file as the main database (i.e., to remember what newsgroups 
you subscribe to).

Gravity lets you export the newsrc files so that you can transport database information between 
machines (e.g., if you use Gravity on your home and work computers).

To Import NEWSRC Files

1. Select the Export NEWSRC File from the File menu.

2. Enter the name of the newsrc file.    Use the Browse button to locate the file, if necessary.

3. If you only want to export information pertaining to the newsgroups that you are subscribed to, 
select the Export subscribed groups only check box.    Selecting this option reduces the size of the 
exported database information.

4. Click on the OK button.



Setting NEWSRC Options

The Newsrc options let you automatically import or export newsrc files.    This automatic feature can be 
especially timesaving if you are used to transporting newsrc files between two computers.

To Set NEWSRC Options

1. Select the Properties command from the Server menu.

2. Choose the Newsrc tab.

3. If you want to automatically open a newsrc file when starting Gravity, select the Import newsrc file 
on startup check box, then provide the name of the file in the Import file from field.    Use the 
Browse button to locate the file, if necessary.

4. If you want to automatically export a newsrc file when exiting Gravity, select the Export newsrc file 
on shutdown check box, then provide the name of the file in the Export to file field.    Use the 
Browse button to locate the file, if necessary.

5. If you only want to export information pertaining to the newsgroups that you are subscribed to, 
select the Export subscribed groups only check box.    Selecting this option reduces the size of the 
exported database information.

6. When you are finished, click on the OK button.



Customizing Toolbars

You can customize Gravity’s toolbars any way you like it, letting you put the most commonly used 
features at your fingertips.

Toolbars help you interact with Gravity.    For greater flexibility, you can customize the toolbars, allowing 
you to create your own work environment.

To Create a Custom Toolbar

1. Select the Toolbar command from the View menu.

2. On the Toolbars tab, click on the New button.

3. Type in the name of the toolbar in the Toolbar Name field.

4. Click on the OK button.

5. A floating toolbar with the name you gave it appears on your desktop.

6. Go to the Commands tab.

7. Choose a category of features – Main, File, Edit, Search, Server, Newsgroup, Thread, Article, View, 
or Tools.    As you select and de-select the various categories, the buttons that belong to them 
appear in the Commands list.

8. Drag a command (button) to the floating toolbar that you created.    The command is added to the 
toolbar in the form of a button.

9. Add as many commands (buttons) to your new toolbar as you want.

10. If you want to place a separator between one or more buttons, drag the button where you want the 
separator slightly to the right.

Separator can be removed by dragging the button back to the left.

11. When you are finished, click on the OK button.

12. To dock your floating toolbar at the top of the Gravity window, drag it toward the menu bar until it 
docks.    You may have to play with the placement a bit to get it right.

To Reset the Original Contents of a Toolbar That You Created

1. Select the Toolbar command from the View menu.

2. On the Toolbars tab, click on the toolbar that you want to reset.

3. Click on the Reset button.

4. When you are finished, click on the OK button.

To Rename a Toolbar That You Created

1. Select the Toolbar command from the View menu.

2. On the Toolbars tab, click on the toolbar that you want to rename.

3. Type in the new name in the Toolbar name field.

4. Click on the OK button.

To Delete a Toolbar That You Created



1. Select the Toolbar command from the View menu.

2. On the Toolbars tab, click on the toolbar that you want to delete.

3. Click on the Delete button.

4. When you are finished, click on the OK button.



Changing What's Displayed on the Main Screen

You can customize the interface of Gravity’s main screen any way you like it using the commands 
under the View menu.

To Change What Is Displayed

1. Open the View menu.    Listed are four items that you can switch on and off – the status bar, rule bar, 
outbox bar, and filter bar.    As defaults, all four commands are active.    A checkmark next the 
command name signifies whether or not the item is displayed.    If you find the screen too cluttered 
for your taste, you can selectively cause certain items not to appear.

2. To make the any of the four items disappear, select the proper command (e.g. select the Status Bar 
command to get rid of the status bar).    To make it re-appear, select the command again.    
Remember that all commands are still available from the pull-down menus.

We recommend leaving all four items displayed.



Difference between Windows 95 and Windows NT 

Gravity is written to the Windows 32-bit API, which for the most part is identical under both 32-bit 
environments.    Windows 95 currently supports a few features that have not yet been migrated to 
Windows NT.    The following constitutes the only known difference between the operation of the 
program in the two environments:

Windows NT 3.51 does not contain shell support for Uniform Resource Locators.    This effectively 
means that the Use Registry Association radio button in the URL Hotlinks tab is disabled and you have 
to define your own Internet helper applications under Windows NT (See URL Hotlinks  —  Integrating with   
web browsers and other Internet applications for how you can configure the hotlinks using DDE).    If 
you have version 4.0 of NT the URL registry associations should be enabled and work properly.





Gravity and the Windows Registry            

  
 
The Windows registry is a database used by Windows 95 and Windows NT to store configuration 
information about hardware and software in your system.    Gravity uses the registry to store many of 
your configuration settings.    The settings that Gravity uses are located under:

\HKEY_CURRENT_USER\Software\MicroPlanet\Gravity

NOTE:    This information is supplied for completeness.    All settings that Gravity stores in the registry are 
configurable directly from within Gravity.    You should never have to edit the registry directly to change your 
configuration.





Glossary 

Connection In Gravity, a connection between Gravity 
and your news server (NNTP). 

Follow-Up A follow-up article is a response to 
another article.    Gravity sends follow-ups 
to everyone in the article’s newsgroup 
and potentially to any cross-posted 
groups.

News Server A news server, also called a NNTP 
server, is a software process that runs on 
a computer somewhere in your 
organization or at your Internet service 
provider.    News servers contain the 
news that Gravity accesses for you to 
read.

Newsfeed If your organization or service provider 
has a USENET news server (NNTP), 
then receives a newsfeed.    In other 
words, it receives the latest articles from 
another news server.    To use Gravity, 
you must have access to a server with 
one of these feeds.

NNTP NNTP stands for Network News 
Transport Protocol.    It lets USENET 
news servers talk to each other to 
distribute articles around the world.    
Newsreaders such as Gravity also use it 
to communicate with your news server.

Post When you post an article, you are 
submitting a new article for one or more 
newsgroups.

Reply In Gravity, you reply directly via e-mail to 
an article’s author, instead of following up 
to the entire newsgroup.

Thread In Gravity, a thread is a collection of 
related items that branch off of an original 
article.    For example, you submit an 
article and someone replies to it.    At that 
point, the article and the reply comprise 
one thread.    The reply to the article will 
be indented just below the original article 
in the thread pane.    The result of these 
discussions or conversations is frequently 
a large tree rooted at the original article.

A thread also involves Gravity’s multi-
tasking architecture.    In the Windows 32-
bit environment, a single process can 
have several “threads” of execution.    



These threads are sub-processes that 
appear to run at the same time.    Gravity 
makes extensive use of threads to allow 
you to do many things at once.





Copyrights And Trademarks

Windows 95, Windows 98 and Windows NT are registered trademarks of Microsoft Corporation.

Gravity and MicroPlanet are trademarks or registered trademarks of MicroPlanet, Inc.

Gravity, Copyright 1996-1999, MicroPlanet, Inc.





Getting Help            

  
 

MicroPlanet provides the following support options for resolving any questions you may have about 
Gravity:

Help File
Many common procedures are covered in this help file.    The tutorial is particularly useful to first time 
users.    Be sure to acquaint yourself with the Help Index and Find tabs.    The Index tab contains a list 
of terms that MicroPlanet added to the help index, but the Find tab allows full text searching of the 
entire help file.    If you cannot find what you are looking for using the Index tab, be sure to try the Find 
tab.

Gravity Quick Start Guide
The Quick Start Guide is a single web page that covers most basic questions and is worth reviewing.    
It is available at http://www.microplanet.com/gravity/faq/quickstart.htm .

Frequently Asked Questions
Various Gravity related FAQs are available at http://www.microplanet.com/gravity/faq .Note that the 
FAQs are available in downloadable form so that you can browse them offline.

Newsgroups
Gravity issues are frequently discussed by knowledgeable users in two USENET groups:

alt.usenet.offline-reader 

news.software.readers 

Email Support
Since we are making Gravity available for free, support is no longer available via email.    If the above 
information sources do not help, in the most extreme case you can un-install using the Control Panel 
and then re-install the product.





Overview of Scoring            

  

Gravity’s scoring system gives you a simple but effective way of identifying articles that are interesting 
to you.    In a nutshell, scoring allows you to assign values to words and phrases.    You can then 
configure Gravity to sort the threads in the thread display by the maximum non-zero score within each 
thread, thereby forcing relevant articles to the top of the display and irrelevant ones to the bottom.    
You can also color-code ranges of scores using score coloring.    For example, suppose you are a 
classical music fan and regularly read rec.music.classical.    Suppose you love reading about Mozart 
and Mahler, think that Beethoven is okay, but hate Copland.    Here is one possibility for assigning 
scores:

Phrase Score
Mozart 1000
Mahler 1000
Beethoven 500
Copland -1000

Processing Order

When Gravity retrieves headers, processing takes place as follows:
1. The headers are downloaded from your news server.
2. Gravity checks to see if scoring needs to be applied to this newsgroup, and if so, applies the 

values.    It does this by examining all of the groups (possibly wildcard expressions) in the list of 
groups to be scored, and if the newsgroup matches, then the scores are evaluated.    Any scores 
that have expired are also removed during this phase.

3. Gravity then runs any rules that are enabled for the newsgroup.    Note that rules can operate on 
the score by examining, adding to, or subtracting from it.

4. When you display the articles, they are threaded according to the setting you have chosen under 
Global Options/Display.    If you have chosen to thread by scoring, then Gravity will sort the threads 
by the score value.

5. If you have created Score Color ranges, the background color for the various ranges is set.

Wildcard Groups

You can use wildcards instead of a newsgroup name to have Gravity score certain phrases across 
similar groups.    For example, if you want the word “exception” to get a score for all computer 
language related newsgroups, then you could specify comp.lang.* as the group in the main scoring 
dialog.    The image under “The Main Scoring Dialog” below illustrates this concept with the wildcard 
*golf.

Adding a Score Entry

To add a score entry for the currently open newsgroup, all you have to do is use the Add Scoring Entry 
(S) command on the Tools menu.    This will bring up the following dialog:



1. Enter the phrase you want scored.
2. Type in a score for the phrase, or select a recently used score from the combo box (scores can be 

positive or negative).
3. Decide whether the phrase or word should be a whole word, or can be included in another word.
4. Decide which type of expression you want to use.    Plain text matches the exact characters you type 

in.    Wildcards allow you to match expressions such as *.jpg.    You can use more complex regular 
expressions, which use the same syntax as those used in rules.

5. Decide whether you want to examine the subject, the From header, the body, or all three.
6. Decide if you want the scoring entry to expire after inactivity, and if so set the number of days that 

must elapse between sightings before the entry is removed.
7. By default, the current group is automatically re-scored after adding an entry.
8. You can bring up the main scoring dialog by clicking on the Main Scoring Dialog button.

The Main Scoring Dialog

The main scoring dialog is available under Tools/Scoring (Ctrl+Shift+G).    Normally, you will add most 
of your scoring entries by using the Add Scoring Entry (S) command from the Tools Menu.    However, 
you can edit work with multiple groups or phrases from the main scoring dialog.    Click on the image 
below to get a description of the various items on the scoring dialog.



 

Using Score Colors

You can assign background colors to ranges of scores.    This allows you to quickly identify interesting 
threads by color.    Note that in order for this to be affective, you will need to define custom colors.    The 
Score Color dialog is used to define the score color ranges.    Click on a field in the dialog box to get a 
description:

Re-scoring a Group After Assigning New Score Values

As you are working with a newsgroup, you generally refine your relevance rankings by adding new 
phrases until most of the topics you are interested in within a group have a phrase to assign a score.    
The Re-Score Current Group command on the Tools menu allows you to completely re-score the 
currently open newsgroup.    Note that the Add Scoring Entry dialog allows you to automatically re-
score the current group after adding a new entry.

Rules and Scoring

The rules system allows you to interact with scores in two ways.    First, scores can be used in 
conditions by using the Article Score is More Than condition.    Note that you can use a less than 



condition by negating the condition: “not Score > X”.    Second, you can add to and subtract from the 
score for an article by using the action Add XX To The Article’s Score (note that XX can be negative).



Score Range Enable

Use the checkbox to enable and disable a range definition.



Score Range Definition

Enter a range to that you want the color to map to.    Note that the range should be ascending.



Score Color Definition

Click on the color button to define a color.    Use custom colors to achieve the best results.



Scoring Group

You can specify scoring phrases for individual newsgroups.    The phrases are indented beneath the 
newsgroup they pertain to.



Scoring Group with Wildcards

You can use wildcards to specify which newsgroups a group of phrases applies to.    In this case, all 
opera groups would be matched. The legal wildcard characters are * and ?, which behave just like the 
command line wildcards in DOS or MS Windows.



Scoring Phrase

A scoring phrase is a phrase (one or more words) that has an associated value.    The values can be 
negative or positive, and reflect    your interest in the phrase.



Add New Group

Click on the Add New Group button to add a new group or wildcard specification for a group of scoring 
phrases.



Add New Phrase

Click the Add New Phrase button to add a new phrase to the currently selected newsgroup or wildcard 
group specification.



Delete Score Or Phrase

Click on the Delete button to remove the selected group or phrase.



Edit Score Or Phrase

Click on Edit to rename a group, change a wildcard group specification, or change a phrase and its 
associated score.



Score Value

The score value indicates the relative importance of the phrase.    Score values can be positive or 
negative, and the thread pane can be sorted by score.



Score Whole Word

The scoring system can be instructed to search for whole word phrases.



Score Type

Score phrases can be plain text, wildcard expressions, or regular expressions.



Score Location

You can instruct the scoring system to examine the From, Subject, Body, or all three when looking for a 
given phrase.



Score Expiration

You can cause the score entry to be removed automatically after a certain number of days of inactivity 
by setting an entry to expire.



The Free Gravity FAQ

What is does it mean that Gravity is free?

It means just that, that you don’t have to register or pay for Gravity to use it.    You can use it however 
you please, you can re-distribute it, you just cannot sell it.

Why is MicroPlanet making it available for free?

The basic answer to this is so that we can feed our families.    There are numerous market factors (free 
alternatives – including those bundled with Windows itself, widespread piracy, etc…) that make it 
impossible to make money on a USENET newsreader.    Even though Gravity still generated some 
income, it was not enough to develop and support it.    It was an agonizing decision to make.    We are 
trying to be as fair as possible to our users.    For example, we have never had a revenue upgrade at 
MicroPlanet (Anawave did for version 2.0 when they owned the product) – all features we added were 
free to our customers.

What are the policies regarding current customers?

· No one who bought Gravity on or after November 1, 2000 has been or will be charged for 
Gravity.    We were in the process of deciding what to do and did not process any of the 
transactions.    Users were added to the registration database, however.

· We will try to do what we can help corporate customers, including helping them find a 
migration path or another solution.    Corporate customers please contact us via 
sales@microplanet.com.    Messages to support@microplanet.com will just get an auto-
responder message.

· If major improvements (such as version 3) are ever released and we begin charging for Gravity 
again, registered users will receive a major discount.    All others would have to pay full price.

·  Email and phone support is no longer available for Gravity.

Is email support available?

We can no longer provide email support (corporate licensees, see the policies section of this FAQ).    In 
fact, because of outside obligations, we were unable to provide an adequate level of support in Q4 of 
2000.    We sincerely apologize for that.

Why did MicroPlanet decide not to use an Ad-generated income model for 
Gravity ?

First and foremost, we do not like ad-ware.    Second, if we continued to accept money for Gravity, we 
would be obligated to support it.    We do not believe that there would be sufficient income to provide 
support and ongoing product improvements.

I lost my registration key.    Can you send me another?

You don’t need a registration key for Gravity.    Download version 2.5 or after – it is free for everyone.




